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1 Introduction

Le guide des Options avancées de IiyX que vous étes en train de lire est avant tout
la deuxieme partie du Guide de I’Utilisateur. La raison de la division en deux du do-
cument est tres simple : le Guide de I’Utilisateur est déja énorme et il contient toutes
les fonctions de base qu’il faut connaitre pour préparer la plupart des documents.
Cependant, 'Equipe de LyX a pour but a long terme de rendre LyX extensible par
différents fichiers de configuration et paquetages externes. Cela signifie que si vous
voulez utiliser le paquetage WTEX Fizzwizzle, vous pouvez créer un fichier de format
qui lui soit dédié sans modifier LyX lui-méme. Nous avons déja regu ainsi plusieurs
contributions, et certaines sont documentées ici. Il y a aussi quelques fonctionnalités
plus « avancées », comme les méthodes de présentation de bibliographies et la gestion
des documents éclatés en plusieurs fichiers, qui ne sont pas couverts par le Guide de
l'utilisateur et sont décrites ici.

Ce manuel décrit aussi quelques fonctions spéciales, comme la gestion d’un fax, le
contrdle de version et le support de SGML, qui nécessitent des logiciels supplémen-
taires pour fonctionner convenablement. Il y a également un chapitre consacré a IyX
et HTML. Et enfin, il y a un chapitre sur les trucs et astuces KTEX, qui servent a
améliorer vos documents grace a la puissance de HTEX. Apres tout, Iy X est seule-
ment WYSIWYM !, et ne sera jamais qu'une interface a certaines des fonctions de
ETEX.

Si vous n’avez pas encore lu I’ Introduction, il est stir que vous n’étes pas au bon
endroit. L’ Introduction est la premiere chose a consulter, car elle décrit les notations
et les formats de tous les manuels. Vous devez aussi étre a l'aise avec le Guide de I’Uti-
lisateur et avec toutes les fonctions de base de LyX.

Comme tous les sujets couverts par ce manuel dépendent étroitement de l'interac-
tion de LyX avec KTEX, le premier chapitre traite du fonctionnement interne de IyX
et explique comment LyX peut générer exactement le code IXTEX que vous désirez.
Il est évidemment destiné a des utilisateurs aguerris de LyX.

1. « What You See Is What You Mean » : « Vous voyez ce que vous voulez dire ».






2 LyX et IATEX

2.1 Comment LyX utilise BTEX

Ce chapitre est a la fois pour les TEX-niciens et les curieux de KTEX. Nous allons
y expliquer comment [xX et IXTEX fonctionnent ensemble pour produire une sortie
imprimable. C’est le seul endroit de tous ces manuels ol nous présumons que vous
connaissez quelque chose a XTEX.

A un moment, nous avions coutume d’appeler LyX une « interface WYSIWYM
pour BTEX », mais ce n’est plus vrai désormais. Des interfaces pour BTEX existent.
Ce sont basiquement des éditeurs avec la possibilité de faire tourner ETEX et de
marquer les erreurs dans le fichier que vous éditez. Bien que LyX soit un éditeur, et
qu’il fasse tourner WIEX, et qu’il marque aussi les erreurs dans le fichier, il fait aussi
beaucoup, beaucoup d’autres choses. Grace au concept WYSIWYM, vous n’avez pas
besoin de connaitre IXTEX pour utiliser [y X efficacement. Iy X a aussi ajouté quelques
extensions a KTEX. Essayez un jour ceci : faites Fichier>Exporter>LaTeX, (ou bien
Affichage > Afficher le code LaTeX) puis regardez le préambule du fichier .tex obtenu.
Vous remarquerez une variété de nouvelles macros définies spécialement par LyX.
Ces macros sont définies automatiquement, en fonction de ce que vous utilisez dans
le document.

Il y a plusieurs commandes qui invoquent ETEX automatiquement. Ce sont :

— Document > Format

— Document > Mise a jour> Format
Elles n’invoqueront IXTEX que si le fichier a changé depuis la derniere fois que KTEX
I’a traité.

Quand vous faites tourner KTEX sur le fichier que vous éditez, Ly X réalise les étapes

suivantes :

1. I convertit le document en I¥TEX et I'enregistre dans un fichier avec I'extension
.tex au lieu de .1lyx.

2. Il fait tourner IXTEX sur le fichier .tex (peut-étre plusieurs fois) et exécute toute
autre commande (comme bibtex ou makeindex) nécessaire a la compilation du

fichier KTEX.
3. S’il y a des erreurs, il affiche le journal d’erreurs.

Si vous avez lancé BKIEX avec Affichage>DVI, [yX exécute alors xdvi sur le fichier
DVI. Si vous avez utilisé Affichage > PostScript ou Fichier>Imprimer, IxX réalise deux
étapes supplémentaires :
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— il fait tourner dvips pour convertir le fichier DVI en PostScript ;

— il exécute une visonneuse PostScript, comme ghostview, pour afficher le résul-
tat.

Lyx procede de maniere similaire pour afficher ou exporter d’autres formats.

2.2 Traduire des fichiers BETEX en LyX

Vous pouvez importer un fichier KTEX dans LyX en utilisant le menu Fichier >
Importer>LaTeX de LyX. Cela va appeler un programme nommé tex2lyx, qui va
créer un fichier toto.lyx a partir du fichier toto.tex. LyX va ensuite ouvrir ce
fichier.

tex21yx peut traduire la plupart des constructions KTEX légales, mais pas toutes.
Ce qu’il ne parviendra pas a comprendre, il le laissera mode TEX, ce qui fait qu’apres
avoir traduit un fichier avec tex2lyx, vous pouvez rechercher les portions en code TEX
et les corriger manuellement.

Si vous ignorez ce qu’est le code TEX, lisez le paragraphe suivant.

2.3 Insérer du code BTEX dans des documents LyX

Vous pouvez faire en [y X tout ce que vous faites en IXTEX, pour une raison tres
simple : vous pouvez toujours insérer du code KTEX dans un document IxX. [yX
ne peut tout simplement pas, et ne pourra probablement jamais, afficher toutes les
structures KTEX possibles. Si vous avez besoin d’insérer des commandes KTEX dans
votre document [yX, vous pouvez utiliser la boite de code T, que vous pouvez
mettre dans votre document avec Insertion>Code TeX.

Voici un exemple d’insertion de commandes KTEX dans un document LyX. Le code
ressemble a ceci :

\begin{tabular}{11}

\begin{minipage}{5cm}

Un exemple d’environnement minipage. Vous pouvez
mettre presque tout dedans, m\~eme des figures
et des tableaux (non flottants).
\end{minipage}

&

\begin{minipage}{5cm}

\begin{verbatim}

\begin{minipage}{5cm}

Un exemple ...

\end{minipage}

\end{verbatim}

\end{minipage}

\end{tabular}



2.4 LyX et le préambule E'TEX

La boite de code TX contenant ce texte est juste apres ce paragraphe. Ceux d’entre
vous qui lisent le manuel en ligne verront seulement un paquet de texte en rouge.

Ceux qui lisent une version imprimée du manuel verront le résultat final :
Un exemple d’environne-

ment minipage. Vous pou-
vez mettre presque tout
dedans, méme des figures
et des tableaux (non flot-
tants).

En plus de I'utilisation du code TgX, vous pouvez aussi créer un fichier séparé conte-
nant une structure IXTEX complexe. Vous pouvez alors utiliser Insertion> Fichier>
Sous-document pour inclure votre fichier (vous devez choisir le type Incorporé (in-
put)). Nous vous recommandons de ne faire cela que si vous avez un fichier .tex dont
vous savez déja qu’il marche. Sinon, vous allez avoir du mal a partir a la chasse aux
erreurs...

\begin{minipage}{5cm}
Un exemple ...
\end{minipage}

Encore quelques notes pour insister :

— au sein de IyX, le code IXTEX apparait en rouge;
— Iy X ne vérifie pas si votre code KIEX est correct ;
— attention a ne pas réinventer la roue.

Sur ce dernier point, [y X dispose déja de pas mal de possibilités, et encore plus sont
en préparation. Assurez-vous de vérifier dans les manuels que Iy X n’a pas déja telle
ou telle fonction avant de vous lancer joyeusement dans 1’écriture de code IKTEX. De
plus, il existe beaucoup de paquetages IXTEX pour faire toutes sortes de choses, des
étiquettes et enveloppes aux tableaux sur plusieurs pages. Voyez un site du CTAN
pour plus de détails.

Si vous avez effectivement besoin de faire quelque chose de bizarre avec votre docu-
ment, référez-vous a un bon livre sur ETEX pour avoir de I'aide. Un certain nombre
sont cités dans la bibliographie du Guide de [’Utilisateur.

2.4 LyX et le préambule BPTEX

2.4.1 A propos du préambule BTEX

Si vous connaissez déja BIEX, il n’y a pas besoin d’expliquer ici a quoi sert le
préambule. Si vous ne le connaissez pas, ce qui suit vous en donnera une idée — nous
vous recommandons encore de consulter un livre sur KTEX pour plus d’information.
Dans tous les cas, il vaut mieux lire les points ci-dessous, parce qu’ils expliquent ce
que vous pouvez faire et ce que vous n’avez pas besoin de faire dans le préambule
KETEX d’un document LyX.

Le préambule IXTEX vient au tout début d’'un document, avant le texte. Il sert a :

— déclarer la classe de document. Iy X I'a déja fait a votre place.
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Si vous étes un IXTEX-nicien expérimenté, et que vous avez une classe de do-
cument particuliere dont vous voulez vous servir, voyez le manuel de Person-
nalisation pour savoir comment la faire reconnaitre par IyX. Puis soumettez
le fruit de vos efforts a I’équipe LyX pour que cela paraisse dans de prochaines
versions !

— déclarer les paquetages utilisés. Les paquetages KIEX fournissent des com-
mandes spéciales, qui sont disponibles dans un document seulement si le paque-
tage a été déclaré dans le préambule. Par exemple, le paquetage indentfirst
force I'indentation de tous les paragraphes. Il y a d’autres paquetages pour des
étiquettes, des enveloppes, des marges, etc.

— fixer les compteurs, variables, longueurs et largeurs. Il y a plusieurs compteurs
et variables IXTEX qui doivent étre fixés globalement depuis le préambule afin
d’avoir Deffet désiré. (Il y a aussi d’autres variables que vous pouvez ajuster
dans le document.) Les marges sont un bon exemple de ce qui doit étre fixé
dans le préambule. Un autre exemple est le type de marqueur pour les listes.
Vous pouvez en fait régler cela n’importe ou, mais il est préférable de le faire
une seule fois, dans le préambule.

— déclarer les commandes définies par 1'utilisateur (avec \newcommand ou \renewcommand),
pour la plupart ce sont des abréviations pour des commandes I¥TEX qui appa-
raissent tres souvent dans le document. Bien que le préambule soit un bon
endroit pour déclarer de telles commandes, elles peuvent étre définies n’importe
ou ailleurs (mais avant d’étre utilisées pour la premiére fois, bien siir...). Ce
peut étre utile s’il y a beaucoup de code IXTEX brut dans votre document, ce
qui normalement ne devrait pas étre le cas.

LyX ajoute son propre lot de définitions au préambule du fichier .tex qu’il engendre.
Ceci rend les fichiers KTEX générés par LyX portables.

2.4.2 Changer le préambule

Les commandes que IyX ajoute au préambule d'un fichier ETEX sont détermi-
nées ; vous ne pouvez pas les changer sans modifier les sources de IyyX. Vous pouvez
toutefois ajouter vos propres commandes au préambule en sélectionnant Document >
Parametres > Préambule IATEX. Ly X ajoute tout ce qu’il y a dans la fenétre Préam-
bule BTEX & son propre préambule. Avant d’ajouter vos propres déclarations, vous
devriez vous assurer que LyX ne fait pas déja ce que vous voulez faire (rappelez-
vous ce que nous avons dit : ne réinventez pas la roue!). Assurez-vous aussi que
votre préambule est correct. IiyX ne le vérifie pas. S’il y a une erreur, vous risquez de
voir apparaltre un message d’erreur comme « Missing \begin{document} ». Si vous
voyez ce message, vérifiez votre préambule.
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2.4.3 Exemples

Voici quelques exemples de ce que vous pouvez ajouter au préambule, et de 'effet
produit :

2.4.3.1 Exemple 1 : Décalages

Il y a deux variables dans XTEX qui controlent la position de la page : \hoffset
et \voffset, c’est-a-dire décalage horizontal et décalage vertical. Ces variables sont
utiles si vous pensez par exemple a l'impression d’étiquettes. Parfois, la taille d’un
médium d’impression et 'aire effectivement imprimable ne sont pas les mémes. C’est
la qu’interviennent \hoffset et \voffset.

Les valeurs par défaut de \hoffset et \voffset sont toutes deux de 0 pt, c’est-a-
dire que la page n’est pas décalée.

Malheureusement, quelques pilotes DVI semblent toujours décaler la page. Nous
ne savons pas pourquoi, ni pourquoi ’administrateur systéme n’a pas corrigé un tel
comportement. Si vous utilisez IyX sur un systeme que vous n’entretenez pas vous-
méme, et si votre administrateur systéme est un paresseux !, \hoffset et \voffset
peuvent sauver la mise. Supposez que vos marges du haut et de gauche soient toujours
0,5 pouce trop grandes. Vous pouvez ajouter ceci au préambule :

\setlength{\hoffset}{-0.5 in}
\setlength{\voffset}{-0.5 in}

...et vos marges devraient désormais étre correctes.

2.4.3.2 Exemple 2 : Etiquettes

Supposez que vous vouliez imprimer un paquet d’étiquettes d’adresse. Il y a un pa-
quetage plutét sympathique, disponible a votre archive CTAN la plus proche, pour
imprimer des feuilles d’étiquettes, appelé labels.sty. Il est possible que votre sys-
téme n’ait pas ce paquetage installé par défaut. Nous vous laissons le vérifier. Il vous
faut aussi lire sa documentation ; nous n’allons pas le faire a votre place. Toutefois,
comme c’est un exemple, nous allons vous montrer comment il marche.

D’abord, assurez-vous que vous utilisez la classe de document article. Ensuite, vous
devez ajouter ce qui suit dans votre préambule :

\usepackage{labels}
\LabelCols=3
\LabelRows=7
\LeftBorder=8mm
\RightBorder=8mm
\TopBorder=9mm
\BottomBorder=2mm

1. NdT : Traduction vraisemblable de « your sysadmin is a doofus ».
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Ceci est la configuration pour des feuilles d’étiquette Avery, référence #5360. Vous
étes maintenant prét a imprimer des étiquettes, mais si vous devez insérer du code
KTEX, placez les commandes \begin{labels} et \end{labels} autour de chaque
étiquette. C’est expliqué dans la documentation du paquetage, ainsi que d’autres
fonctions de celui-ci.

Un jour, quelqu’un écrira peut-étre une fonction de [yX pour supporter directement
ce paquetage. Peut-étre méme que ce sera vous.

2.4.3.3 Exemple 3 : Indentation de paragraphe

Les Américains ont I’habitude d’indenter la premiere ligne de chaque paragraphe.
Comme avec toutes leurs autres moeeurs étranges, la plupart des Américains vont
se plaindre et récriminer jusqu’a ce qu’ils aient ce qu’ils veulent, et qu’ils puissent
indenter la premiere ligne de chaque paragraphe.

Bien siir, cette habitude n’est pas typographiquement correcte. Dans des livres,
vous n’indentez en général la premiere ligne d’un paragraphe que s’il en suit un
autre. L’idée derriere l'indentation de la premiere ligne est de pouvoir distinguer
deux paragraphes consécutifs. S’il y a pas de paragraphe précédent, par exemple s’il
suit une figure, ou si c’est le premier paragraphe d’une section, alors il n’y a pas
d’indentation spéciale.

Si vous étes un Américain typique 2, cependant, vous ne vous occupez pas de choses
aussi ésotériques ; vous voulez votre indentation! Ajoutez ceci au préambule :

\usepackage{indentfirst}

Si votre distribution TEX n’est pas un vieux coucou, vous avez ce paquetage, et tous
vos paragraphes auront l'indentation que vous pensez qu’ils méritent.

2.4.3.4 Exemple 4 : Ce document

Vous pouvez aussi aller voir le préambule de ce document pour avoir une idée de
certaines possibilités avancées. La fenétre Préambule IKTEX risque de ne pas étre visible
en une fois, méme en plein écran.

2.5 LyX et les erreurs BTEX

Quand IxX invoque KETEX, il lui dit d’ignorer toute erreur et de continuer. Il se
sert ensuite du fichier log de IXTEX pour en faire 'autopsie. S’il y a une erreur quelque
part, IyX ouvre une boite avec un listing d’erreurs. Cliquer sur 'une d’elles déplace
le curseur a I'emplacement approprié dans le document 3.

Quelques-uns préferent regarder le fichier journal directement, il est accessible par
Document > Fichier log LaTeX. Il y a quelques erreurs et avertissements assez fréquents.

2. NdT : Ce qui m’étonnerait, mais on ne sait jamais!
3. LyX fera occasionnellement des déductions fausses sur I’emplacement de l’erreur. Ca arrivera
surtout dans les tableaux, les figures, les math et le préambule.
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Nous allons les traiter ici. Vous devriez vous reporter a un bon livre sur KTEX pour
une liste complete.

— « LaTeX Warning »

Tout ce qui commence par ces mots est un message d’avertissement destiné a
« déboguer » le code IXTEX lui-méme. Vous aurez des messages de ce type si vous
avez ajouté ou changé des références croisées ou des entrées de bibliographie,
auquel cas BTEX essaye de vous dire que vous devez l'exécuter une nouvelle
fois.

Vous pouvez en général les ignorer.

— « LaTeX Font Warning »

Un autre message d’avertissement, cette fois au sujet de polices que KIEX n’a
pas trouvées. Le reste du message indiquera souvent la police de substitution
que KTEX a choisi.

Vous pouvez les ignorer sans crainte.

— « Overfull \hbox »

KETEX adore cracher ce genre de messages. Il engendre apparemment au moins
un message de ce type pour n’importe quel document que vous écrivez. Ces
messages vous préviennent que les lignes sont trop longues et débordent sur
la marge de droite. Ceci se produit si WTEX ne trouve pas comment couper
les lignes de maniere raisonnablement correcte (notoirement avec une police a
chasse fixe, du fait que cette police ne permet pas trouver les points de cé-
sure automatiquement). Dans de nombreux cas, c¢’est impossible & déceler dans
le rendu final (ce peut étre un point ou deux). Parfois cependant, les lignes
débordent visiblement dans la marge, et c¢’est quelque chose que vous ne sou-
haiterez pas voir dans votre impression finale.

Il y a plusieurs solutions pour minimiser ’effet de ces débordements. Cocher Ac-
tiver les fonctionnalités micro-typographiques dans Document > Paramétres > Polices
peut déja améliorer significativement les choses. Par ailleurs, un code KTEX tel
que celui qui suit, inséré dans Document > Paramétres > Préambule réduit d’ha-
bitude massivement les débordements de ligne (ce code est inséré dans le pré-
ambule du présent document) :

\tolerance 1414
\hbadness 1414
\emergencystretch 1.5em
\hfuzz 0.3pt

Dans certains, cependant, vous devrez finalement réécrire le texte pour obtenir
des césures correctes?.

Dans tous les cas, il faut vérifier les lignes concernées, au plus tard avant ’édition
de la version finale du document. Vos yeux vous diront s’il y a un probleme avec

4. Pour les détails , voir http://www.tex.ac.uk/FAQ-overfull .html
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un espacement trop grand®.

— « Underfull \hbox »
Pas aussi courant que son cousin. Ceci de produit si IXTEX ne trouve pas de
point de césure raisonnable et par conséquent crée des lignes trop aérées. Comme
précédemment, vérifiez si cela se voit.

— « Overfull \vbox » et « Underfull \vbox »

Des avertissements sur des problemes de saut de page. A nouveau, vous n’avez
qu’a regarder ce qui sort. Vous verrez bien si quelque chose ne va pas.

— « LaTeX Error: File ’Xxxx’ not found »

Le fichier « Xxxx » n’est pas présent sur ce systeme. Ceci apparait habituel-
lement parce qu'un paquetage nécessaire a votre document n’est pas installé.
Si vous n’avez pas touché au préambule ou si vous n’avez pas utilisé la com-
mande \usepackage{}, alors un des paquetages que LyX a essayé de charger
est manquant. Faites Aider> Configuration KTEX pour voir la liste des paquetages
dont LyX a entendu parler. Ce fichier est mis a jour a chaque fois que vous
reconfigurez LyX (avec Outils>Reconfigurer) et vous dit quels paquetages ont
été détectés et a quoi ils servent.

Si vous avez utilisé la commande \usepackage{}, et que le paquetage en ques-
tion n’est pas installé, vous devez l'installer vous-méme.

— « LaTeX Error: Unknown option »
Les messages d’erreur commencant ainsi essayent de vous dire que vous avez
spécifié une option impossible ou inexistante dans un paquetage. Vérifiez dans
sa documentation.

— « Undefined control sequence »
Si vous avez inséré du code IXTEX dans votre document, et fait une faute de
frappe, vous aurez un de ceux-la. Vous pouvez aussi avoir oublié de charger un
paquetage. Dans tous les cas, d’habitude ce message d’erreur veut dire que vous
avez utilisé une commande inconnue.

Il y a d’autres messages d’erreur et d’avertissement. Quelques-uns sont explicites©.
Ce sont souvent des messages I TEX. D’autres sont carrément incompréhensibles. Ce
sont en fait des messages d’erreur TEX, et nous n’avons vraiment aucune idée de ce
qu’ils signifient ou de comment les déchiffrer. Personne ne le sait.

Voici une liste de vérifications a effectuer si vous étes confronté a des messages
d’erreur :

1. cherchez d’éventuelles fautes de frappe dans le code KTEX que vous avez inséré ;

2. s’il n’y a pas de fautes de frappe, vérifiez que vous avez utilisé les commandes
correctement ;

5. Vous pouvez aussi activer I'option « draft » dans les options de classe via DOCUMENT >
PARAMETRES > CLASSE DE DOCUMENT : IATEX tracera une barre noire dans la marge des lignes qui
débordent.

6. NdT : Pour un anglophone...
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3. si vous avez un paquet de boites d’erreur entassées tout en haut du document
— et surtout si vous voyez « Missing \begin{document} », ¢a veut dire qu’il
y a des erreurs dans le préambule. Commencez par corriger votre préambule ;

4. si vous n’avez rien ajouté au préambule et si vous n’avez pas ajouté de code
KETEX au document, le suspect numéro un est votre distribution KTEX elle-
méme. Vérifiez s’il manque des paquetages et rajoutez-les;

5. tres bien, il ne manque aucun paquetage. Avez-vous utilisé une des options de
réglage fin de Iy X ? Plus précisément, avez-vous mal utilisé 'une d’entre elles,
en essayant par exemple d’insérer manuellement des tas de Blancs Insécables,
de sauts de paragraphe ou de sauts de page? Avez-vous essayé de bricoler
quelque chose avec tout ¢a au lieu d’utiliser les environnements de paragraphe
appropriés 7

6. d’accord, vous n’avez utilisé aucune des options de réglage fin, vous avez joué
dans les regles. Avez-vous essayé une manceuvre bizarre ? Avez-vous fait quelque

chose de pas net dans un tableau ou une équation, comme insérer un graphique
dans une case de tableau?

7. Avez-vous de longues portions de texte dans lesquelles I TEX ne peut pas trouver
d’endroit ou passer a la ligne 7 Par défaut, KTEX est assez strict avec la quantité
d’espace entre les mots qu’il va ajouter pour passer a la ligne. Il est alors
préférable que vous retravailliez le paragraphe pour éviter le probleme.

8. avez-vous exagéré avec 'imbrication? Iy X (actuellement) ne vérifie pas que
vous restez dans les limites de 'imbrication d’environnements. Si vous avez
imbriqué un tas d’environnements jusqu’au 17¢ niveau, le probléme est 1a;

9. vous n’avez obtenu aucun message d’erreur, mais votre rendu ne ressemble pas
a grand chose. Si vous avez un tableau ou une figure qui est trop large ou trop
haute pour la page, vous devez :

a) mettre la figure a 1’échelle pour qu’elle tienne.
b) rétrécir le tableau pour qu’il tienne.

10. Si quelque chose d’autre ne va pas avec le rendu, et que vous n’avez rien essayé
de bizarre ni bricolé avec les réglages fins, nous ne savons pas trop ce qui cloche.

Si vous n’étes pas plus avancé avec tout ceci — et bien, peut-étre que vous avez trouvé
une erreur dans IyX. ..
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3 Outils supplémentaires

3.1 Personnaliser une bibliographie avec BibTgX or
Biblatex

L’essentiel des bases de 1'utilisation de BibTEX ou Biblatex sont décrites dans le
paragraphe Les bases de données bibliographiques du Guide de ['utilisateur. Les pa-
ragraphes qui suivent détaillent les fonctionnalités bibliographiques particulieres qui
sont accessibles depuis LyX.

3.1.1 Autres styles de citation

Le style standard de BibTEX utilise des nombres (par exemple « [12] ») pour
faire référence a un ouvrage cité. Cependant, dans de nombreuses disciplines scienti-
fiques, on utilise d’autres styles de citations. Le plus courant et le style auteur-année
(par exemple « Knuth 1984a »). LyX gere trois paquetages qui fournissent ce style,
biblatex, natbib et jurabib. Chacun de ces paquetages a ses avantages et ses in-
convénients qui ne peuvent étre listés ici en détail. Si vous voulez seulement avoir un
simple style auteur-année (ou auteur-nombre) ou si vous voulez utiliser un des innom-
brables fichiers de styles pour natbib, alors vous choisirez probablement le paquetage
natbib qui est réputé. Si vous cherchez des styles de citation adaptés aux documents
juridiques, vous pouvez envisager d’utiliser le paquetage plus récent jurabib. Si vous
voulez contréler complétement la mise en forme ou si vous cherches des fonctionnalités
sophistiquées comme ibidem, citations en notes de bas de page, citations plein titre,
formats de dates évolués (comme 400 AC) ou une internationalisation complete dans
d’autres langues que ’anglais, vous devriez vraiment utiliser biblatex, qui surpasse
tous les autres paquetages en termes de fonctionnalités, mais qui est également assez
lourd et consommateur de ressources.

L’utilisation de ces paquetages avec LyX est sensiblement la méme. Allez dans le
menu Document > Parameétres et choisissez dans la rubrique Bibliographie le FORMAT
DU STYLE BASIQUE (BIBTEX), BIBLATEX, BIBLATEX (MODE NATBIB), NATBIB
(BIBTEX) or JURABIB (BIBTEX) (voir la section 6.5.3 du Guide de ['utilisateur
pour les détails au sujet de ces choix). Avec ces tous ces paquetages, vous aurez
des options supplémentaires dans le dialogue Citation et vous pourrez choisir le style
de la référence (« Knuth 1984 », « Knuth (1984), « Knuth, 1984 », « 1984 » etc.).
Notez que chaque paquetage nécessite des fichiers de style spécifiques (ils sont tous
fournis avec leur propres fichiers, mais on peut trouver beaucoup de fichiers de style
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supplémentaires et méme un programme interactif pour construire des fichiers de
style! pour natbib).

3.1.2 Bibliographies subdivisées

Parfois vous avez besoin de diviser votre bibliographie en plusieurs sections. Si par
exemple, vous étes un historien, la possibilité de séparer les sources et les travaux
scientifiques est vraisemblablement une possibilité « indispensable ». Malheureuse-
ment, BibTEX ne vous permet pas lui-méme de faire cela. La bonne nouvelle : Avec
I'aide de quelques paquetages EIEX, on peut étendre BibTEX pour satisfaire vos
besoins historiques.

LyX fournit un support natif d'un de ces paquetages, bibtopic?. L’avantage de
ce paquetage (comparé a d’autres comme multibib) est que n’avez pas besoin de
définir de nouvelles commandes de citation. A la place, vous aurez a préparer des
bases de données bibliographiques différentes pour les différentes sections de votre
bibliographie. Par exemple, si vous voulez diviser votre bibliographie en deux sec-
tions « sources » et « travaux scientifiques », vous devez d’abord créer deux bases de
données, par exemple sources.bib et scientifique.bib.

Dans IyX, allez dans le menu Document > Parametres dans la rubrique Bibliographie.
Activez 'option Bibliographie subdivisée. Vous pouvez maintenant insérer plusieurs
bibliographies BibTEX, une par section de votre bibliographie. Pour revenir a notre
exemple : insérez une bibliographie BibTEX pour la base de donnée sources.bib et
une deuxieme pour la base de données scientifique.bib. Vous étes libres d’utiliser
le méme style ou un style différent pour chaque section. En plus, vous pouvez choisir
que votre section bibliographique contienne « toutes les références citées » de la base
de données utilisée (ce qui est le comportement implicite), « toutes les références non
citées » ou encore « toutes les références ». Ceci put étre utile si vous voulez séparer
votre bibliographie en trois sections : « Sources citées », « Sources non citées » et
« Travaux scientifiques ». Les titres des sections peuvent étre ajoutés comme des
entétes de section ou de sous-section ordinaires. Puisque bibtopic supprime le titre
de la bibliographie, vous devez aussi le remettre manuellement ( comme un chapitre*
ou une section®, par exemple).

Avec Biblatex, la procédure est un peu différente. Puisque bibtopic ne fonctionne
pas avec Biblatex, 'option BBIBLIOGRAPHIE SUBDIVISEE est désactivée si vous uti-
lisez Biblatex. Cependant, Biblatex inclut ses moyens propres pour créer des biblio-
graphies subdivisées. Vous pouvez : soit ajouter des mots-clés aux entrées bibliogra-
phiques a l'aide de 'entrée keywords, puis filtrer les sections bibliographiques par
mot-clé (en ajoutant keyword=monMotClé au champ OPTIONS de la fenétre de dia-
logue qui apparait si vous faites un clic gauche sur le bouton BIBLIOGRAPHIE BIBLA-
TEX) ; soit filtrer par type d’entrée (comme book ou article) en saisissant par exemple
type=book ou nottype=collection au champ OPTIONS mentionné ci-dessus; soit

1. Voyez ftp://ctan.tug.org/tex-archive/macros/latex/contrib/custom-bib/
2. Disponible sur ftp://ctan.tug.org/tex-archive/macros/latex/contrib/bibtopic/
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créer des « catégories bibliographiques » auxquelles vous pouvez affecter des entrées
bibliographiques individuelles. Voyez le manuel Biblatex, subsection Subdivided Bi-
bliographies de la section Usage Notes, pour les détails.

3.1.3 Bibliographies multiples

Les bibliographies multiples, par exemple une bibliographie pour chaque partie,
chapitre, section, sous-section or sous-document du document, sont également pos-
sibles avec LyX. Pour les activer, allez 8 DOCUMENT > PARAMETRES > BIBLIOGRAPHIE
et sélectionnez le sectionnement requis (e.g. « par section ») dans le sous-menu BI-
BLIOGRAPHIES MULTIPLES. Puis ajoutez une bibliographie Bib(la)TEX a chaque élé-
ment (e.g., section) de votre document. Dans le résultat imprimable, une bibliogra-
phie séparée ne contenant que les références du sectionnement considéré sera créée.

Si vous utilisez BibTEX, Le paquetage chapterbib ou le paquetage bibtopic est
utilisé pour créer des bibliographies multiples. Le premier est utilisé si vous sélection-
nez « par sous-document » et si vous ne sélectionnez pas BIBLIOGRAPHIE SUBDIVISEE.
Dans tous les autres cas, c’est bibtopic qui est utilisé® . Avec bibtopic, [yX encap-
sule les entités spécifiées entre les commandes \begin{btUnit} et \end{btUnit} pour
créer les bibliographies. Notez que cette approche a quelques limitations. D’abord,
chaque référence de citation doit se trouver dans une btUnit. Les citations en-dehors
d’une entité défini (par exemple, avant la premiere section si vous utilisez « par
section ») apparaitront comme «?77? ». Vous pouvez cependant créer vos propres
entités en saisissant \begin{btUnit} et \end{btUnit} en code TEX (par exemple
pour contourner la présente limitation). Notez bien que les btUnits ne peuvent in-
clure d’autres btUnits. Une seconde limitation vient du fait que bibtopic parcourt
toujours toutes les références d’une base bibliographique, méme celles qui ne sont pas
citées. Ceci peut créer des citations bizarres (e.g. « Martin 2014b » si deux ceuvres
de cet auteur publiées en 2014 sont dans la base, alors qu'une seule est citée).

Si vous utilisez Biblatex, 'option refsection est utilisée a la place du choix dé-
roulant. Si vous avez besoin d’entités spécifiques, vous pouvez insérer au début
\newrefsection ou \newrefsegment respectivement, en codeTEX. Si vous voulez
aussi préciser la fin de l'entité, utilisez I'environnement \begin{refsection} ...
\end{refsection} a la place. Notez cependant que les refsections ne peuvent
contenir d’autres refsections. En plus de la bibliographie individuelle de 'entité
considérée, Biblatex permet aussi d’émettre toutes le bibliographies, les unes apres les
autres, a un endroit particulier (e.g., a la fin du document). Sélectionnez « toutes les
entités de références » dans le menu déroulant Contenu de la fenétre de dialogue de
Iinsert de bibliographie pour obtenir ceci.

3. Une autre approche, si vous étes prét a utiliser un peu de CopE TEX (voir section 2.3),
consiste a utiliser le paquetage bibunits.
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3.2 Documents en plusieurs fichiers

3.2.1 Généralités

Quand on travaille sur un gros fichier avec de nombreux chapitres, il est souvent
pratique de diviser le document en plusieurs fichiers; par ailleurs, il arrive qu’un
élément comme un tableau soit susceptible de modifications ultérieures, alors que le
reste du texte ne changera plus. Dans ces cas-la, il est judicieux d’utiliser les pos-
sibilités de segmentation de documents. Ainsi, les communications scientifiques ont
souvent cinq chapitres principaux : introduction, observations, résultats, discussion,
conclusion. Chacun d’entre eux peut constituer un fichier IyX séparé, avec un fichier
« maitre » qui contient le titre, les auteurs, le résumé, les références, etc. Il convient de
noter que chacun des fichiers est un fichier IyX en lui-méme, qui peut aussi bien étre
mis en page et imprimé seul, qu’étre inclus dans le document maitre. Tous ces fichiers
doivent cependant avoir la méme classe de document — n’essayez pas de mélanger la
classe book avec la classe article. Il est également possible d’inclure des fichiers IXTEX :
cependant, ces fichiers doivent alors étre sans leur préambule (c¢’est-a-dire sans la par-
tie jusqu’a la ligne \begin{document} incluse, et sans la ligne \end{document}) pour
éviter des erreurs a la création du fichier DVI.

Ly X permet 'inclusion de fichiers en sélectionnant Insertion > Fichier > Sous-document,
ce qui positionne une balise a I’endroit du curseur. Un clic sur cette balise ouvre une
fenétre qui permet de saisir le nom du fichier et la méthode d’inclusion.

Les trois méthodes d’inclusion sont « inclus (include) », « incorporé (input) », et
« Verbatim ». Les méthodes « inclus (include) » et « incorporé (input) » se ressemblent
sur de nombreux points, mais different notablement sur d’autres :

1. les fichiers « inclus » commenceront sur une nouvelle page, alors que ceux « in-
corporés » commenceront sur la page en cours.

2. les fichiers « inclus (include) » ne peuvent pas eux-mémes « inclure » d’autre
fichiers (sous-sous-documents). Avec « incorporé (input) », en revanche, la sous
incorporation est illimitée.

3. «inclus (include) » permet I'’émettre la sortie imprimable d'un sous-ensemble de
fichiers « inclus » tout en conservant la valeur correcte des compteurs (pagina-
tion et autres) et des références (voyez la section Sous-documents du manuel
des Objets insérés pour les détails).

De ce fait, « inclus (include) » est la méthode appropriée pour des chapitres rédigés a
part comme des sous-documents, alors que « incorporé (input) » convient mieux pour
un héritage de fichiers arbitraires.

Un fichier inclus en « verbatim » vous permet d’insérer un texte mis en forme
exactement comme il apparait dans le fichier d’origine. Normalement, les espaces
dans ce fichier sont invisibles, cependant, deux espaces consécutives sont conservées, a
contrario des regles habituelles de [y X. Cependant, cocher I'option Marquer les espaces
résout toute incertitude en matérialisant chaque espace par un symbole.
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D’une maniere générale, le fichier maitre est converti en un seul fichier I TEX avant
la typographie, alors que les fichiers inclus sont convertis en fichiers IXTEX dépourvus
de préambule.

3.2.2 Références croisées entre fichiers

Ce paragraphe est quelque peu obsolete. Il faudrait décrire les documents maitres
implicites et comment les sous-documents s’ouvrent en méme temps que le docu-
ment maitre. [[AFAIRE]]|

11

est possible de faire des références croisées entre différents fichiers. D’abord, il faut
ouvrir tous les fichiers concernés : appelons-les A et B pour un exemple avec deux
fichiers, avec B inclus dans A. Supposons que nous ayons inséré une étiquette dans
A, a laquelle nous voulons faire référence dans B. Il faut ouvrir la fenétre de référence
croisée a partir de B, et il est alors possible de choisir le « tampon » a utiliser.

3.2.3 Listes bibliographiques dans tous les sous-documents

Lorsque vous travaillez avec un sous-document, vous pouvez préférer avoir une
seule bibliographie principale a la fin, tout en conservant la possibilité d’avoir une
bibliographie sélectionnée pour le sous-document si vous affichez la sortie de ce sous-
document seul. Voici comment procéder.

Dans le document maitre, vous insérez simplement un insert bibliographique la ou
la bibliographie principale doit apparaitre, que ce soit dan sle document maitre ou
dans un sous-document. Si la bibliographie est dans le document maitre, les références
seront héritées par tous les sous-documents : elles sont donc disponibles dans la fenétre
de dialogue des citations dans chacun d’entre eux.

Pour le bibliographies particulieres aux sous-documents, saisir des inserts bibliogra-
phiques la ou la bibliographie doit apparaitre quand le sous-document est compilé a
part. Cependant, 1’astuce consiste & la saisir dans une branche (Insertion>Branche>
Insérer une nouvelle branche), appelée par exemple « SousDocSeul ». Dans le sous-
document, activer la branche (Document > Paramétres> Branches). Dans le document
maitre, désactiver la branche (Document>Paramétres>Branches). La bibliographie
du sous-document sera alors ignorée dans le document maitre, mais présente dans le
sous-document.

S’il vous faut des bibliographies multiples (une par sous-document dans le document
maitre, par exemple), voyez la section 3.1.3.

3.3 Archives LyX

Les utilisateurs ont parfois besoin de « relier » un fichier IyX avec toutes les images
(et d’autres fichiers dont il dépend, soit pour I'envoyer a un éditeur, soit pour le par-
tager avec un co-auteur. IyX inclut un script Python (1yxpak.py) qui automatise le
processus. Pour l'utiliser, il faut que I'un des modules Python zipfile ou tarfile
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soit installé sur votre systeme. Implicitement, le script préfere I’archive tar compres-
sée par gzip sur les systemes Unix et le format zip sur Windows.

La procédure de configuration de IxX positionne le script pour qu’il exporte une
« Archive LyX », et ce format sera disponible via Fichier>Exporter.

Indépendamment du systeéme d’exploitation, la création d’un format d’archive par-
ticulier peut étre imposée en ajoutant soit l'option -t (pour le format tar ) soit
l'option -z (pour le format zip) au convertisseur IyX >Archive IyX dans Outilsp
Préférences>Gestion des fichiers>Convertisseurs (veillez bien a ajouter 1’op-
tion apres le nom du script, pas avant).

3.4 En-tétes et pieds de page sur mesure

Le format de page implicite est assez banal : pour un document avec la classe
article, tout ce que vous obtenez se limite au numéro de page en bas de la feuille.
Ce document-ci est de la classe « book (KOMA script) » (livre), donc il est un peu
plus fourni, mais pour réellement en mettre plein la vue, il faut choisir le style d’en-
tétes « sophistiqué », comme 'explique le Guide de I’Utilisateur. Cette section dé-
crit les codes IXTEX qu’il vous faudra insérer dans votre préambule ETEX ou dans
le texte pour obtenir les effets désirés. Pour plus d’information sur les en-tétes so-
phistiqués, voir la documentation du paquetage fancyhdr (https://www.ctan.org/
tex-archive/help/Catalogue/entries/fancyhdr.html).

L’en-téte est divisé en trois champs, appelés logiquement « gauche », « centre » et
« droit ». Le bas de page aussi a ces trois divisions. Les commandes IXTEX pour éditer
ces champs de la maniere la plus simple sont \1head, \chead, \rhead, \1foot, etc. Si
vous voulez mettre votre nom dans le coin en haut a gauche de chaque page, insérez
simplement cette commande dans le préambule :

\lhead{Jean D. Rédacteur}

Vous verrez désormais votre nom dans le coin supérieur gauche. Si un champ a une
entrée par défaut que vous souhaitez supprimer (comme le numéro de page apparais-
sant en bas, centré), insérez simplement une commande avec un parametre vide, par
exemple :

\cfoot{}

Maintenant, plus dur : mettons le mot « Section » et le numéro de la section en
cours (par exemple Section 3) dans le coin supérieur gauche, le numéro de page en
haut a droite, votre nom en bas a gauche et la date en bas a droite. Les commandes
suivantes doivent donc apparaitre dans votre préambule :

\lhead{Section \thesection}

\chead{}

\rhead{Page \thepage}

\1foot{Jean D. Rédacteur}

\cfoot{}

\rfoot{\today}
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3.5 Choix de puces dans ListePuces

Les codes \thesection et \thepage permettent d’accéder aux compteurs IXTEX
de section et de page, et d’afficher ainsi les numéros de la section et de la page en
cours. \today affiche simplement la date d’aujourd’hui.

L’épaisseur de la barre horizontale dessinée au dessous de 'en-téte et au dessus du
pied de page peut elle aussi étre modifiée. Si vous n’en voulez pas, mettez sa largeur
a 0. Par défaut, la barre d’en-téte a une épaisseur de 0,4 pt, et celle de pied de page
une épaisseur de 0. Pour régler I'épaisseur, utilisez les commandes \renewcommand-
{\headrulewidth}{0.4pt} et \renewcommand{\footrulewidth}{0.4pt}.

Vous pouvez activer ou désactiver les parametres d’en-téte et de pied de page pour
une page donnée avec, par exemple : \thispagestyle{empty}, \thispagestyle-
{plain}, et \thispagestyle{fancy}. Insérez simplement ces commandes dans le
texte de la page que vous voulez modifier, et mettez-les en mode TEX. En fait, par
défaut, si vous utilisez le style global « fancy », les pages de titre sont en « plain »,
alors que les autres sont en « fancy ».

Il existe des commandes plus complexes qui vous permettent d’introduire des choses
dans le coin gauche des pages impaires, etc., mais nous vous renvoyons a la documen-
tation du paquetage fancyhdr pour plus de précisions. (https://www.ctan.org/
tex-archive/help/Catalogue/entries/fancyhdr.html)

Enfin, il est possible d’insérer une image dans ’en-téte ou le pied de page. Si vous
voulez insérer un logo dans le coin supérieur gauche, vous pouvez essayer quelque
chose comme :

\lhead{\resizebox{lin}{!}{\includegraphics{logo.eps}}}

(il vous faudra peut-étre pré-ajouter \usepackage{graphics} avant si aucun autre
fichier EPS n’est inséré dans votre document).

3.5 Choix de puces dans ListePuces

par ALLAN RAE

3.5.1 Introduction

LyX fournit 216 motifs de puces qui sont accessibles par une simple fenétre. Vous
pouvez facilement y sélectionner la puce souhaitée pour chaque niveau de profondeur
dans I'environnement ListePuces. Ces choix sont valables pour tout le document, donc
vous ne pouvez pas spécifier différents types de puces pour différents paragraphes*.

3.5.2 A quoi elles ressemblent

Allez dans la rubrique Puces de la fenétre Document > Parametres.

La fenétre vous présente un tableau avec des formes de puces. A gauche du tableau,
une colonne de boutons vous donne acces aux six panneaux possibles. La rangée
de boutons du haut sert a choisir le niveau de profondeur sur lequel vous agissez.

4. En fait, c’est possible mais il faut le faire a la main.
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3 Outils supplémentaires

Une boite de texte sous le tableau affiche I'équivalent KTEX de la forme de puce
actuellement sélectionnée, et ce champ peut étre édité. Si vous modifiez le texte vous
devrez aussi spécifier a la main dans le préambule IXTEX les paquetages requis.

Les six panneaux sont répartis selon les paquetages qu’ils nécessitent. Le tableau
suivant vous montre la correspondance entre le nom des boutons et les paquetages

BTEX.

’ Bouton \ Paquetages Requis ‘

Standard ETEX de base
Maths amssymb. sty
Dingl pifont.sty
Ding2 pifont.sty
Ding3 pifont.sty
Ding4 pifont.sty

IyX ne vous empéche pas d’utiliser les puces correspondant a des paquetages que
vous n’avez pas. Si vous obtenez des erreurs KTEX lorsque vous essayez de visionner
ou d'imprimer le fichier, c’est stirement qu’il vous manque un paquetage. LyX ne vous
empéche pas d’agir car vous pourriez vouloir éditer quelque part et imprimer avec un
autre systeme.

3.5.3 Comment s’en servir

Sélectionnez le niveau de profondeur sur lequel vous voulez agir, puis le motif de
puce et la taille. Les changements ne seront pas visibles dans LyX, mais seulement
lors du visionnement..

Vous pouvez remettre une puce a sa valeur par défaut, en cliquant avec le bouton
droit de la souris sur la profondeur de la puce en question®.

5. Si vous voulez réellement avoir des paragraphes avec des puces différentes dans chacun d’eux,
vous devez mettre les mains dans le cambouis. La fenétre dont nous venons de parler est cependant
utile car elle montre en méme temps l'aspect de la puce et son code KTEX, ceci pour un grand
nombre de puces. Pour personnaliser vos paragraphes, vous avez le choix :

§ Utilisez la commande WTEX \renewcommand{}{} pour spécifier un nouveau format de puce
pour une profondeur donnée. Vous aurez aussi besoin d’enregistrer le format actuel pour le
restaurer plus tard. Dans cette liste a puces, le code BTEX suivant a été utilisé pour changer
les puces de profondeur 1 :

\let\savelabelitemi=\labelitemi

\renewcommand\labelitemi[0]{\small\(\sharp\)}

Remarquez que la profondeur de puce est donnée en chiffres romains comme partie intégrante
de la commande \labelitem.

* Agissez sur chaque entrée individuellement en écrivant le motif de la puce dans un insert
« Elément paramétrable » (accessible via Insertion>Elément paramétrable) et en code TEX.
Par exemple, cet élément a commencé par \ (\star\).

Vous aurez besoin de remettre le labelitem & sa valeur d’origine pour que les autres puces
retrouvent les réglages globaux. Nous avons donc ici :
\renewcommand\labelitemi[0]{\savelabelitemi}
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4 LyX et le Web

LyX inclut depuis longtemps l'exportation de documents vers divers formats ap-
propriés au monde du Web, comme HTML. Avant la version 2.0, le format HTML
était obtenu par l'utilisation de convertisseurs externes !. Ceux-ci se divisent en deux
groupes principaux : certains convertisseurs utilisent KTEX comme format intermé-
diaire, comme htlatex, html2latex, et plastex, en créant le code IXTEX a partir de
LyX; et il existe un convertisseur qui travaille directement sur le code LyX, elyXer.
Chacun d’eux présente des avantages et des inconvénients.

Les convertisseurs fondés sur IXTEX présentent 1’avantage qu’il connaissent (en prin-
cipe) les mémes informations que BKTEX concernant le document exporté. Il ne sont
pas concernés par le fait qu'un morceau de code soit créé par LyX ou par un insert de
code TEX. Ils comprennent les fichiers aux, les compteurs et les références, et peuvent
souvent tirer parti des fichiers bbl engendrés par BibTEX. En contrepartie, KTEX est
un langage vraiment difficile a analyser — on dit souvent que seul TEX comprend
TEX — et les convertisseurs fondés sur IXTEX échouent souvent sur des construc-
tions apparemment simples; des constructions compliqués peuvent les faire avorter
totalement, et actuellement par exemple, le manuel des Objets insérés ne s’exporte
pas via htlatex, bien que les autres le fassent. L’autre préoccupation provient de la
maniere dont les formules mathématiques sont traitées : ces convertisseurs traduisent
habituellement les formules en petites images qui sont liées dans le document HTML.
Puisque celles-ci sont créées par IXTEX, la typographie est précise. mais elles ne se
mettent pas a 1’échelle facilement, et la tache de les faires s’insérer harmonieusement
dans le document comme si elles en faisaient partie nativement — avec des polices
de taille similaire — peut étre a elle seule un défi.

Le logiciel elyXer (http://pinchito.es/elyxer/) créé par Alex Fernandez résout cer-
taines de ces problemes. En particulier, les formules produites se mettent parfai-
tement a 1’échelle, car il traduit les mathématiques en utilisant une combinaison de
HTML et CSS plutét que de convertir les formules en images. mais méme les formules
modérément compliquées sont moins bien rendues qu’avec htlatex : ceci révele les
limitations de HTML 2. Plus important (du moins pour la version 1.1.1), elyXer ne
comprend pas bien les macros mathématiques et pas du tout les styles de paragraphes
définis par I'utilisateur et les styles de caracteres. Ces limitations rendent elyXer peu
approprié pour de nombreux documents créés par les utilisateurs de LyX. En prin-
cipe, ces problemes peuvent bien siir étre résolus, mais les développeurs de Lyx ont

1. Pour les détails sur 'utilisation des convertisseurs externes depuis LyX, voir la section Conver-
tisseurs de manuel de Personnalisation.

2. Ceci dit, elyXer peut également utiliser JSSMATH et MATHJAX pour les équations, mais ce
réglage ne peut étre que global et nécessite 'accés a un serveur qui exécute le code de conversion.
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choisi une autre voie et ont rendu IyX lui-méme capable d’écrire en XHTML, de la
méme fagon qu’il peut écrire en KTEX, en DocBoook ou en texte brut.

A T'heure actuelle, 'exportation XHTML est encore en développement et doit pro-
bablement étre considérée comme « expérimentale ».2 Cependant, les développeurs
ont chois cette approche car elle posséde plusieurs avantages potentiels sur les deux
autres.

Les avantages sont dus principalement au fait que les fonctions d’exportation en
XHTML, comme elles font partie de Lyx, connaissent du document considéré les
mémes choses que LyX.? Elles connaissent donc la table des matieres (telle qu’affi-
chée dans le plan), les compteurs associés aux différents styles de paragraphes stan-
dard et aux styles de paragraphe définis par I'utilisateur. Les fonctions d’exportation
XHTML connaissent les mémes choses que LyX du point de vue de I'internationali-
sation également, et elles traduiront « Chapter 1 » ou « Kapitel 1 » en fonction de la
langue définie localement.

D’un maniere générale, les fonctions d’exportation connaissent le format du docu-
ment, c’est-a-dire la maniere d’afficher le document a I’écran : cette information est
exploitée pour 'exportation en XHTML. En particulier, yX engendre automatique-
ment les informations CSS correspondant aux informations de format utilisées pour
I’affichage a 1’écran : si les en-tétes de section sont supposées étres sans empattement
et gras dans [yX, ils seront implicitement sans empattement et gras dans un naviga-
teur Web. Et ceci est vrai non seulement pour les styles prédéfinis, comme Section,
mais pour tout style, y compris défini par I'utilisateur, puisque dans tous les cas, tout
ce que connait IyX se trouve dans les fichiers de format. Ceci s’applique également
aux inserts textuels comme les notes de bas de page et divers inserts personnalisés.

De ce fait, le résultat XHTML peut étre adapté et étendu exactement de la méme
facon que le résultat IHTEX : au moyen des fichiers de format et des modules; voir le
chapitre 5 du manuel de Personnalisation pour les détails.

Le reste de ce chapitre décrit plus en détail 'exportation XHTML, ses limitations
et les moyens de contourner celles-ci.

4.1 Formules mathématiques en XHTML

IyX propose quatre méthodes d’affichages des formules mathématiques, qui ont
divers avantages et inconvénients :

— MathML
MathML est in dialecte de XML développé spécifiquement pour afficher les

3. Le fichier development/HTML/HTML.notes, qui se trouve dans l'arborescence des sources LyX
ou qui peut étre consultée en ligne (en anglais), contient normalement des informations & jour sur
I’état de développement de I’exportation XHTML. Voir également la liste des bogues sur le suivi de
bogues.

4. Un autre avantage réside dans le fait que, puisque ces fonctions sont internes a Lyx, elle sont
insensibles aux changements de format des fichiers LyX, ou aux modifications de la sémantique des
inserts existants.
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4.1 Formules mathématiques en XHTML

formules mathématiques sur le web, et il offre un excellent rendu dans les na-
vigateurs qui le reconnaissent. L’inconvénient est que tous les navigateurs ne
reconnaissent pas MathML, et que le support est incomplet méme dans les na-
vigateurs fondés sur Gecko comme Firefox.

Si Iy X ne sait pas afficher un formule en MathML — par exemple, la formule
utilise le paquetage xymatrix ou du code TEX — il affichera la formule sous la
forme d’une image.

— HTML

Comme on l'a vu plus haut, elyxer exporte les formules mathématiques en
HTML, mis en forme par CSS®. Pour des formules simples, ceci fonctionne
correctement, mais a tendance a échouer pour des formules plus compliquées.
Cette méthode a cependant I'avantage d’étre largement reconnue et peut donc
étre utilisée pour des documents contenant peu de formules, et qui soient suffi-
samment simples.

Si Lyx ne sait pas afficher un formule en HTML — par exemple, la formule
utilise le paquetage xymatrix ou du code TEX — il affichera la formule sous la
forme d’une image.

— Images
Comme htlatex,[yX exportera les formules comme des images, les mémes
images en fait que celles utilisées par la fonction d’apercu sur le vif®.
Comme indiqué plus haut, I'avantage de cette méthode réside dans la
grande précision des images puisqu’elles sont engendrées par IXTEX. En
contrepartie, ces images ne sont pas vectorielles, et par conséquent elles
ne se mettent pas bien a 1’échelle, elles ne peuvent pas étre copiées, etc.
La taille des images peut étre réglée via le parametre MISE A L'ECHELLE
DES IMAGES MATHEMATIQUES dans le menu DOCUMENT > PARAMETRES >
FORMATS 7.
Si IyX ne peut créer un image d’une formule pour une raison ou une autre
(e.g., si un paquetage KTEX requis n’est pas installé), alors il émettra le
code latex brut de la formule.

— BTEX
Enfin, [yX peut heureusement émettre les formules en KTEX. Bien que l'on ait
recours a cette méthode qu’en dernier ressort, elle peut étre utilisée avec des
outils externes comme jsMath, qui utilise JavaScript pour afficher le code IXTEX
inclus dans les documents HTML. LyX encapsule le code IXTEX soit dans un
insert de type span (pour les formules en ligne) soit dans un insert de type div

(pour les formules hors ligne) marqué par class=’math’, comme requis par
jsMath.

5. LyX a emprunté a elyxer quelques unes des feuilles de style CSS utilisées dans son exportation
HTML.
6. L’apercu sur le vif n’a pas besoin d’étre actif pour que les images soient créées, cependant.

7. Pour ceux que cela intéresse, la résolution est définie en points par pouce et vaut implicitement
75 dpi.
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Une des ces méthodes d’affichage doit étre sélectionnée dans la fenétre DOCUMENT >
PARAMETRES > FORMATS. Implicitement, IyX émet en MathML. Ceci est un réglage
global pour le document.

LyX offre également le choix d'une méthode différente pour un insert particulier,
s’il est par exemple mal affiché via MathML. 3

4.2 Bibliographie et citations

L’exportation XHTML traduit parfaitement les bibliographies et les citations.

Les étiquettes de citation sont créées par le méme mécanisme qui produit le éti-
quettes apparaissant dans ’écran Ly X : les citations se présenteront donc aussi bien
que dans LyX si ce n’est mieux. Si vous utilisez des citations numériques, [y X émettra
des étiquettes numériques, comme [1] ou [17], plutdt que d’afficher simplement la clé
de la citation comme a I’écran. Si vous utilisez des citations auteur-année, [y’X ajou-
tera des lettres en bas de casse a 'année, comme le fait BibTEX, s’il trouve plus d'une
citation du méme auteur dans le méme année. Les étiquettes seront imprimées avec
les entrées bibliographiques. Notez cependant qu’il n’est pas actuellement possible de
modifier 'apparence des étiquettes, en choisissant par exemple entre parentheses et
crochets.

L’affichage de la bibliographie est régie par le méme mécanisme que celui qui gere
le présentation des références dans la fenétre de dialogue des citations, vous verrez
donc dans le résultat XHTML a peu pres les mémes choses que ce que vous voyez
en consultant un entrée dans cette fenétre. La présentation peut étre personnalisée
dans le fichier de format, ou de préférence dans un module, voyez le manuel de
Personnalisation pour les détails.

Le plus gros défaut actuel réside dans I'affichage des informations croisées dans
chaque entrée a laquelle elles sont associées, vous pouvez donc voir ceci :

Jason Stanley, “Context and Logical Form”, in Language in Context: Se-
lected Essays (Oxford: Oxford University Press, 2007), pp. 30-68.

Jason Stanley, “Semantics in Context”, in Language in Context: Selected
FEssays (Oxford: Oxford University Press, 2007), pp. 201-30.

Ceci devrait étre corrigé rapidement.
Il n’y a actuellement aucun support pour les les bibliographies par sections. Si vous
avez des bibliographies multiples, Iy X exportera la méme bibliographie partout.

4.3 Index

LyX exporte heureusement les index ne XHTML, avec quelques limitations pour
le moment.

8. Ceci dit, puisque LyX se rabat sur les images quand la formule contient du code TEX, il est
possible de forcer 'affichage par une image en insérant un code TEX innocent, par exemple a = b.
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4.4 Nomenclatures et glossaires

L’exportation des index sera fiable si vous n’essayez pas d’utiliser les constructions
sophistiquées décrites dans le paragraphe consacré aux index dans le Guide de [’uti-
lisateur.® Nous décrivons ici comment elles sont gérées en utilisant les en-tétes de
sous-section de cette section.

4.4

Rassembler les entrées d’index (c’est-a-dire, sous-entrées) : Iy X essaye de les
traduire, mais les entrées doivent étre séparées par « ! », il doit y avoir des
espaces autour du point d’exclamation. Ceci est dii au fait qu’il est difficile au-
trement de les différencier des points d’exclamation affectés d’un échappement,
de ceux des expressions mathématiques, etc.

Ensembles de pages consécutives : il n’y a aucune traduction possible pour ces
ensembles, puisqu’ils n’ont aucun sens en XHTML. A la place, vous obtiendrez
deux entrées d’index, une a chaque extrémité.

Références croisées : les références croisées ne sont APA traduites. Si LyX trouve
une entrées contenant « [see. .. », il 'ignore cette indication, et le reste est traité
comme une entrée ordinaire.

Ordre des entrées d’index : LiyX essaie de gérer 'ordre de tri. Il prend ce qui
est avant le premier « @ » qu’il trouve et I'utilise pour trier, en considérant ce
qui est apres le premier « @ » comme 'entrée effective. Pour le moment, IxX
ne vérifie pas si « @ » fait 'objet d’un échappement, n’essayez donc pas de trier
des adresses électroniques.

Format des entrées d’index : vous pouvez mettre les entrées en forme en utilisant
la fenétre de choix des styles de caracteres, ou par une autre méthode proposée
par IxyX. Les constructions telles que « entrée|textbf » ne sont pas traduites.
En fait, si IyX trouve un caractére tube (« | ») dans une entrée, il I'ignore ainsi
que tout ce qui le suit.

Index multiples : les index multiples ne sont pas traduits, toutes les entrées
d’index seront considérées comme un seul grand index. Pour éviter d’exporter
plusieurs versions du méme index, [;yX n’exporte que 'index principal, assurez-
vous d’en créer un.

Nomenclatures et glossaires

Il n’y a actuellement pas d’exportation des glossaires. Il serait trivial de les ajouter,
et ce serait bienvenu.

9. Le principal probleme ici vient du fait que LiyX ne gere pas vraiment ces entrées d’index, il se
contente de vous laisser saisir le code ETEX.
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5 Le Serveur LyX

5.1 Introduction

Le « serveur IyX » est une méthode implantée dans IiyX qui permet a d’autres
programmes de dialoguer avec LyX, d’invoquer des commandes Iy X et d’obtenir de
I'information a propos de son état interne. Tout ceci n’est destiné qu’aux utilisateurs
avancés, qui devraient le trouver utile. C’est grace au serveur Iy X, par exemple, que
des gestionnaires de bibliographies comme JabRef peuvent permettre de « pousser »
des citations dans LyX.

5.2 Démarrer le Serveur LyX

Le serveur IyX fonctionne par l'intermédiaire d’une paire de tubes. IlIs sont ha-
bituellement disposés dans votre répertoire utilisateur MonRép (sauf sur Windows,
ou des tubes nominatifs locauz sont des objets spéciaux localisés dans \\.\pipe) et
portent les noms « .lyxpipe.in » et « .lyxpipe.out ». Les programmes externes
écrivent dans .lyxpipe.in et lisent les données dans .lyxpipe.out. La racine de ces
deux noms peut étre définie dans la fenétre Edition > Préférences > Entrées > Répertoires,
par exemple « /home/mon_home/.lyxpipe », ou « \\.\pipe\lyxpipe » avec Win-
dows (ou n’importe quel chemin admissible peut étre utilisé a la place de lyxpipe, par
exemple "\\.\pipe\my\lyx\pipe" fonctionnerait également). Vous devez configurer
ceci manuellement pour que le serveur puisse démarrer.

LyX ajoutera les suffixes « .in » et « .out » pour créer les tubes. Si l'un des ces
tubes existe déja, [y X supposera qu'un autre processus [y X est déja en route et ne
démarrera pas le serveur. Sur les systémes POSIX (similaires a Unix), si pour d’autres
raisons un tube inutilisé et « dormant » existe a la fermeture de LyX, LyX essaiera
de le supprimer. Si ceci échoue pour une raison ou une autre, vous devrez supprimer
les tubes a la main et redémarrer LyX. Sur Windows, les tubes sont supprimés par le
systéme a la fermeture du programme ou apres un crash, ainsi les tubes « dormants »
ne peuvent exister.

Pour faire tourner plusieurs processus [yX avec des serveurs en méme temps, vous
devez utiliser différentes configurations, peut-étre en utilisant des répertoires utilisa-
teurs différents, avec leurs propres préférences, pour chaque processus.

Si vous développez un programme client, il vous sera peut-étre utile d’activer les in-
formations de déboguage du serveur Iy X. Pour cela, démarrez Iy X avec la commande
lyx -dbg 8192.
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Vous pouvez trouver un exemple complet de client écrit en C++ dans la distribution
source sous le nom development/server_monitor.cpp.

Un autre outil utile est un client en ligne de commande que vous trouverez dans
src/client/lyxclient.

5.3 Communication normale

Pour émettre un appel LyX, le client écrit une ligne de texte ASCII dans le tube
d’entrée, selon le format suivant :

LYXCMD:nom_client : fonction : paramétre

nom_client est un nom que le client peut choisir arbitrairement. IyyX rappelle ce
nom s’il envoie une réponse — un client peut donc répartir les réponses aux
différentes requétes.

fonction est la fonction que vous voulez faire exécuter a LyX. C’est la commande
que vous auriez entrée dans le minibuffer.

paramétre est un parametre optionnel qui n’est utile que pour certaines fonctions
(par exemple, le LFUN « self-insert » qui insére le parameétre comme du texte
a la position du curseur).

La réponse de IyX arrive dans le tube de sortie sous la forme :
INFO:nom_client : fonction :données

ou nom_client et fonction sont les mémes que dans la requéte, tandis que données
contient des informations plus ou moins utiles selon la fagon avec laquelle la com-
mande s’est exécutée. Certaines commandes renvoient des informations a propos de
I’état interne de LyX, comme « font-state », tandis que d’autres ne renvoient rien. Ca
signifie alors que I'exécution s’est bien passée.

En cas d’erreurs, la réponse de LyX aura la forme :

ERROR:nom_client : fonction :message_d’erreur

ou le message_d’erreur doit expliquer pourquoi la commande a échoué.
Exemples :

echo "LYXCMD:test:beginning-of-buffer:" >~/.lyxpipe.in
echo "LYXCMD:test:get-xy:" >~/.lyxpipe.in

read a <~/.lyxpipe.out

echo $a

5.4 Notification

LyX peut notifier aux clients les événements qui se produisent de maniere asyn-
chrone. Pour l'instant il ne le fait que si I'utilisateur associe une séquence de touches
a la fonction « notify ». Voici le format de ce que IyX envoie :
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5.5 Le protocole serveur LyX

NOTIFY:séquence_touches

ol séquence_touches est la représentation imprimée de la séquence de touches
réellement tapée par 1'utilisateur.

Ce mécanisme peut servir pour étendre l’ensemble des commandes [yX et implé-
menter des macros : associez certaines séquences de touches a « notify », démarrez
un client qui écoute le tube de sortie, traite la commande selon la séquence et dé-
marre une fonction qui peut utiliser des appels et des requétes LyX pour envoyer une
commande ou une série de commandes a LyX.

5.5 Le protocole serveur LyX

LyX implémente un protocole simple qui peut servir a la gestion de session. Tous
les messages sont de la forme :

LYXSRV:nom_client : message_protocole

ol message_protocole peut étre « hello » ou « bye ». Si un client regoit « hello »,
c’est que Ly X l'informe qu’il écoute ses messages, s’il recoit « bye », c’est que LyX
est en train de s’arréter.

5.6 Recherche inversée DVI/PDF

Quelques visionneuses DVI/PDF ! assurent la fonction de recherche inversée. Ceci
signifie que vous pouvez demander a IyX de positionner le curseur sur une ligne
particuliére en cliquant sur la méme ligne dans le résultat imprimable DVI/PDF. Pour
que ceci soit possible, il faut que la visionneuse puisse communiquer avec LyX. C’est
la cas par le serveur LyX soit par un tube nommé (lyzpipe), soit par un connecteur
de domaine (lyzsocket) créé par ILyX dans son répertoire temporaire (c’est comme
ceci que le programme lyxclient communique avec IxyX). Dans certains cas, vous
aurez besoin d'un script auxiliaire qui interface la visionneuse et IyX, dans d’autres
cas, la visionneuse peut communiquer directement avec LyX : ceci dépend de la
visionneuse sélectionnée et de votre systeme d’exploitation. La méme considération
s’applique pour la configuration des visionneuses et pour le méthode d’implantation
de la recherche inversée. Dans ce qui suit, nous allons donc décrire comment configurer
la recherche inversée pour des visionneuses particulieres. mais auparavant, nous allons
expliquer d'une maniere générale ce qu’il faut faire pour activer la recherche inversée
depuis le résultat imprimable DVI/PDF.

5.6.1 Activation automatique

Le plus souvent, [yX démarrera le serveur pour vous en appuyant sur le bouton &
de la barre des outils. Une alternative consiste a activer la fonctionnalité en cochant

1. Les visionneuses suivantes proposent la fonction de recherche inversée en PDF : Okular sur
KDE/Linux, Qpdfview sur Unix, Skim sur Mac OSX et SumatraPDF sur Windows.
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Synchroniser avec la sortie imprimable dans DOCUMENT > PARAMETRES > FORMATS.
Dans ce cas, IyX insérera automatiquement la macro SyncTEX (pour PDF) ou charg-
era le paquetage srcltx (pour DVI). Cette option peut étre facilement atteinte depuis
la barre d’outils Visionner/Mettre & jour.

S’il vous faut un réglage différent, vous pouvez sélectionner ou saisir une macro per-
sonnalisée dans la liste déroulante située juste au-dessous de DOCUMENT > PARAMETRES >
SORTIE > SYNCHRONISER AVEC LA SORTIE IMPRIMABLE. Notez que la méthode
\synctex=1 active la compression gzip. Si votre visionneuse ne la supporte pas, vous
devez utiliser a la place\synctex=-1.

Notez également que la l'inclusion des paquetages srcltx ou src-specials a
quelquefois un impact imprévu sur la typographie. Vous devrez donc supprimer la
synchronisation avec la sortie imprimable pour la compilation finale du document si
vous utilisez srcltx ou src-specials.

Si vous avez besoin de réglages particuliers qui ne sont pas couverts par la réglage
automatique, lisez les paragraphes suivants consacrés a la synchronisation manuelle.
Si la configuration automatique vous convient, allez directement au paragraphe 5.6.3,
ou sont décrites les étapes de la configuration dans votre visionneuse, — que la mise
en ceuvre soit automatique ou manuelle.

5.6.2 Activation manuelle

KETEX fournit plusieurs méthodes pour la recherche inversée. Certaines sont in-
hérentes au programme latex/pdflatex, d’autres sont fournies par des paquetages
externes. Votre choix dépendra du fait que votre distribution BTEX fournisse déja
une méthode donnée (les méthodes inhérentes sont assez récentes) et du fait que votre
visionneuse puisse le gérer. Les méthodes disponibles dont décrites dans la suite.

Recherche inversée DVI inhérente via src-specials (DVI uniquement)

Cette méthode équipe le fichier DVI de I'information nécessaire pour la recherche
inversée. Elle est disponible en IXTEX depuis quelque temps (n’importe quelle dis-
tribution suffisamment récente devrait Uinclure) et elle est fiable. Pour l'activer,
modifier la commande dans le convertisseur LATEX (STANDARD)->DVT ou le con-
vertisseur LATEX (STANDARD)->DRAFTDVI dans PREFERENCES > GESTION DES
FICHIERS > CONVERTISSEURS comme ceci: latex -src-specials $$i. Si cela ne
fonctionne pas, vérifiez les options votre moteur TEX (la syntaxe peut différer dans
quelques distributions).

Paquetages externes (PDFSync et scritx)

Les paquetages pdfsync and scritx fournissent la fonctionnalité de recherche inver-
sée pour les sorties imprimables PDF (via pdflatex) et DVI, respectivement. Pour
l’activer, charger les paquetages dans le préambule LyX:

— \usepackage{pdfsync} pour la recherche inversée depuis le PDF
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5.6 Recherche inversée DVI/PDF

— \usepackage[active] {srcltx} pour la recherche inversée depuis le DVI.

Si vous souhaitez effectuer la recherche inversée depuis les deux formats, vous pouvez
saisir les lignes suivantes dans le préambule:

\usepackage{ifpdf}
\ifpdf
\usepackage{pdfsync}
\else
\usepackage [active] {srcltx}
\fi

De cette fagon, vous pourrez visionner les fichiers soit en DVI, soit en PDF (pdflatex)
et le paquetage adéquat sera chargé.

Notez bien que PDFSync peut affecter la mise en page du document, il vaut mieux
le désactiver lors des passes finales de compilation du document.

Recherche inversée DVI inhérente via SyncTgX (DVI et PDF)

Les versions récentes de (pdf)latex offrent un support inhérent pour la recherche
inversé en PDF et DVI. Cette fonctionnalité dénommée SyncTpX résulte a la base
de l'intégration du paquetage PDFSync dans le programme pdftex et de sa fusion
avec l'approche scr-specials. 11 vous faut au moins TEXLive 2008 ou une distribu-
tion MikTEX récente pour pouvoir 'utiliser. Notez également que seules quelques
visionneuses (comme Okular et Qpdfview sur Unix, Skim sur Mac, SumatraPDF sur
Windows; voir la section suivante pour les détails) supportent actuellement SyncTEX.

Pour activer SyncTEX pour le résultat imprimable DVI, modifier le convertisseur
LATEX (STANDARD) -> DVTI ou le convertisseur LATEX (STANDARD) -> DRAFT-
DVI dans PREFERENCES > GESTION DES FICHIERS> CONVERTISSEURS en latex
-synctex=1 $3$i, et pour le résultat imprimable PDF| modifier le convertisseur L A-
TeEX (PDFLATEX) -> PDF (PDFLATEX) en pdflatex -synctex=1 $$i. Si votre
visionneuse n’est pas décrite dans ce qui suit, ou en cas d’échec, vérifiez la documen-
tation de votre visionneuse pour ce qui concerne la configuration pour SyncTEX 2.

5.6.3 Configuration et utilisation de visionneuses particuliéres
Xdvi (toutes plate-formes)

Si vous utilisez xdvi, vous n’avez rien de plus a faire pour utiliser la recherche
inversée, puisque LyX fournit les ancres nécessaires pour l'utilisation automatisée
de lyxclient. Il vous suffit de paramétrer votre document comme indiqué plus
haut (la recherche inversée est déclenchée par Ctrl-clic ou Alt-clic sur Mac OSX,
respectivement).

2. L’option -synctex=1 active la compression gzip. Si votre visionneuse ne la comprend pas,
vous devez saisir a la place —synctex=-1.

31



5 Le Serveur LyX

Cependant, si pour quelque raison vous préférez utiliser le tube nommé au lieu du
connecteur pour la communication avec IyX, modifiez simplement la visionneuse
DVI dans PREFERENCES®> GESTION DES FICHIERS > CONVERTISSEURS en?® xdvi
-editor "lyxeditor.sh %f %1", ou lyxeditor.sh est un script approprié. Par
exemple, un script minimal est le suivant:

#!/bin/sh

LYXPIPE="/path/to/lyxpipe"
COMMAND="LYXCMD:revdvi:server-goto-file-row:$1 $2"
echo "$COMMAND" > "${LYXPIPE}".in || exit

read TMP < "${LYXPIPE}".out || exit

ou /path/to/lyxpipe est le chemin d’acces au tube LyXServer spécifié dans PREFERENCES >
PATHS.

MacDviX (Mac OSX)

A la fin du script /Applications/MacDviX_Folder/calleditor.script, ajoutez
les lignes suivantes:

/Applications/LyX.app/Contents/Mac0S/lyxeditor "$2" $1
exit 1

Adaptez ces lignes si vous installez [y X ailleurs que dans le répertoire Applications.
La recherche inversée est déclenchée par Alt-clic (OPTION-clic).

Skim (Mac OSX)

Saisir open -a Skim.app $$i dans le réglage de la visionneuse PREFERENCES >
GESTION DES FICHIERS > FORMATS DE FICHIERS > PDF (PDFLATEX), et sélection-
nez LyX dans SKIM > PREFERENCES > SYNC.

La recherche inversée est déclenchée par COMMAND-SHIFT-clic.

Evince (GNOME)

La recherche inversée ne fonctionne pas directement avec evince, mais elle peut étre
obtenue a l'aide de scripts auxiliaires externes: voir https://wiki.lyx.org/LyX/SyncTeX
pour les détails.

Okular (KDE)

Aller & CONFIGURATION > CONFIGURER OKULAR > EDITEUR et sélectionner LyX
en tant qu’éditeur. Ceci insere la commande appropriée (lyxclient -g %f %1).
La recherche inversée est déclenchée par SHIFT-clic.

3. Sur Mac OSX vous devez utiliser DISPLAY=:0.0 xdvi -editor "lyxeditor.sh %f %1"
4. Dans le répertoire development/tools de la distribution des sources LyX, vous trouverez un
script lyxeditor, capable de trouver le lyxzpipe de vos préférences.
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Qpdfview (Unix)

Qpdfview fonctionne avec SyncTEX depuis la version 0.3.5. Allez a MODIFIER >
PARAMETRES > COMPORTEMENT, cliquer dans le champ de I’Editeur de source et
ajoutez la commande lyxclient -g %1 %2.

La recherche inversée est activée par un clic double.

YAP (Windows)

Activer Yap, choisir le menu VIEW > OPTIONS et sélectionner 1'onglet “Recherche
inversée DVI”. Cliquer sur le bouton “New...” et, dans la fenétre qui s’ouvre, saisir
“ILyX Editor” (ou un autre nom de votre choix) dans le champ “Name:”. Main-
tenant cliquer sur le bouton identifié par “...” pour ouvrir une fenétre de choix de
fichier et aller jusqu’au répertoire contenant le fichier exécutable lyxeditor.bat (voir
ci-dessous). Sélectionner lyxeditor.bat et spécifier les arguments du programme
comme suit: %f %1. Le conteneur lyxeditor.bat est utilisé pour communiquer avec
Iy X via lyzpipe et se présente ainsi

Q@echo off
echo LYXCMD:revdvi:server-goto-file-row:%~1 %2> \\.\pipe\lyxpipe.in
type \\.\pipe\lyxpipe.out

Vérifier que le chemin d’acces au tube LyXServer spécifié dans IyX est bien \\. \pipe\lyxpipe,
sinon adapter le conteneur lyxeditor.bat.
Avec Yap, la recherche inversée est déclenchée par double-clic.

SumatraPDF (Windows)

Pour utiliser SumatraPDF en recherche inversée, saisir SumatraPDF -inverse-search
"lyxeditor.bat "%f" %1" dans les réglages de la visionneuse dans PREFERENCES >
GESTION DES FICHIERS > FORMATS DE FICHIERS > PDF (PDFLATEX), ou lyxeditor.bat
est le conteneur indiqué ci-dessus. Si SumatraPDF.exe ne figure pas dans la liste des
chemins des commandes, utiliser le nom complet.

La recherche inversée est déclenchée par double-clic.

YAP (Cygwin)

D’abord, vérifier que Yap est la visionneuse DVI implicite de ’environnement
Windows, puis le lancer, choisir le menu VIEW > OPTIONS et sélectionner 1'onglet
“Recherche DVI inversée”. Cliquer sur le bouton “New...” et, dans la fenétre qui
s'ouvre, saisir “Editeur LyX” (ou un autre nom de votre choix) dans le champ
“Name:”. Maintenant cliquer sur le bouton identifié par “...” pour ouvrir une
fenétre de choix de fichier et aller jusqu’au répertoire contenant le fichier exécutable
lyxeditor.exe (qui est implicitement installé dans Cygwin avec 1'exécutable IxX)
. Sélectionner lyxeditor.exe et spécifier les arguments du programme comme suit:
-g »f %1. De cette fagon, vous utiliserez le lyzsocket pour communiquer avec LyX.
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Si pour quelque raison, vous souhaitez utiliser lyzpipe, omettez 'option -g et spécifiez
le chemin d’acces au tube LyXServer dans les préférences.
Avec Yap, la recherche inversée est déclenchée par double-clic.

SumatraPDF (Cygwin)

Pour utiliser SumatraPDF en recherche inversée, saisir SumatraPDF.sh dans les
réglages de la visionneuse dans PREFERENCES > GESTION DES FICHIERS > FORMATS
DE FICHIERS > PDF (PDFLATEX), ouSumatraPDF.sh est le script suivant (a rendre
accessible dans le chemin d’acces aux commandes, /usr/local/bin étant le meilleur
choix):

#!/bin/bash
cd $(dirname $1)
SumatraPDF -inverse-search "lyxeditor -g %f %1" $(basename $1)

Ce conteneur et nécessaire parce que SumatraPDF est une application Windows
native et ne comprend pas les chemins POSIX utilisés par la version Cygwin de
LyX. Si SumatraPDF.exe n’est pas dans votre chemin d’acces, utiliser le chemin
complet dans le script ci-dessus. L’option -g active la communication via lyzsocket.
De nouveau, I'omettre —-g pour utiliser lyzpipe, et spécifier le chemin d’acces au tube
LyXServer dans les préférences LyX.

La recherche inversée est déclenchée par double-clic.

5.7 Recherche directe

La recherche directe est, comme son nom l'indique, “I’opposé” de la recherche in-
versée. Elle vous permet de positionner le curseur dans la visionneuse directement
depuis IxyX. Si le recherche inversé est active (comme décrit ci-apres), vous pouvez
positionner le curseur ot vous voulez dan le document Iy X, et sélectionner NAVIGA-
TION > RECHERCHE DIRECTE (ou sélectionner RECHERCHE DIRECTE dans le menu
contextuel par un clic droit), et la visionneuse sera positionnée au méme emplace-
ment. Ce suppose bien entendu que la visionneuse interprete cette fonctionnalité.

Pour rendre la recherche directe active, vous devez d’abord créer le fichier PDF/DVI
avec les informations supplémentaires concernant les source TEX: ceci peut étre fait
par les méthodes décrites dans la section 5.6.1.

De plus, vous devez configurer LyX pour utiliser les visionneuses dans OUTILS >
PREFERENCES > SORTIE > GENERAL. LyX fournit une série de configurations validées
pour quelques visionneuses, que vous pouvez sélectionner dans le menu déroulant. Si
aucune de ces configurations ne vous convient, vous devrez chercher et trouver une
configuration appropriée vous-méme. La syntaxe utilise les marqueurs suivants:

— $$n: numéro de ligne;

— $$t: nom du fichier .tex (temporairement) créé;
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— $$0: nom du fichier de sortie (soit dvi, soit pdf, en fonction de celui qui existe
dans le répertoire temporaire).

Notez que seules quelques visionneuses présentent une fonctionnalité de recherche
directe complete, parmi lesquelles YAP, XDVI, OKULAR®, QPDFVIEW et SUMATRA
PDF 5. d’autres, comme evince”, nécessitent des outils supplémentaires. Alors que
beaucoup des visionneuses PDF largement diffusées (parmi lesquelles on remarquera
Adobe Reader) ne comprennent pas du tout la recherche directe, d’autre visionneuses,
comme XPDF, permettent au moins de recharger le document et de sauter a une page
donnée: vous pouvez au moins naviguer a proximité du point visé. Cette derniere
fonctionnalité est activée par un appel externe a synctex (voir les configurations
prédéfinies).

La recherche directe fonctionne simultanément avec les sorties DVI et PDF. IyX
vérifie simplement quel format vous avez utilisé (c’est-a-dire, quel format est déja
résident dans le répertoire temporaire) et choisit la configuration adéquate.

5. Vous pouvez saisir okular --unique dans OUTILS> PREFERENCES> GESTION DES
FICHIERS > FORMATS DE FICHEIRS

6. SumatraPDF peut aussi utiliser les commandes DDE via le programme externe CMCDDE —
téléchargeable depuis http://www.istri.fr/spip/zip/CMCDDE.zip

7.

La recherche directe avec evince peut étre obtenue via des programmes externes auxiliaires. Voir
https://wiki.lyx.org/LyX/SyncTeX pour les détails.
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6 Classes de document spéciales

6.1 Article AASTEX

par MIKE RESSLER

6.1.1 Introduction

AASTEX est un ensemble de macros produit par I’American Astronomical Society
pour faciliter la soumission électronique de manuscrits aux trois journaux qu’elle pub-
lie : I’Astrophysical Journal (y compris les Letters et le Supplement), I’Astronomical
Journal, et les Publications of the Astronomical Society of the Pacific. LyX a be-
soin de la version 5.0 (de préférence 6.0, version décrite ici, ou plus récente) de ces
macros. Les versions antérieures a la 5.0 sont destinées a étre utilisées avec KTEX2.09
et sont fondamentalement incompatibles avec IyX. Le paquetage AASTEX peut étre
téléchargé depuis le site de 'AAS

https://aas.org/aastex/aastex-downloads

Un guide de l'utilisateur complet est compris dans ce paquetage et il vaut mieux
que vous vous familiarisiez sérieusement avec avant de vous embarquer a écrire un
papier en [yX. LyX ne va pas vous dispenser de comprendre toutes les commandes
AASTEX, il vous dispensera seulement de la corvée de toutes les taper. Il est de
votre responsabilité de vous assurer que le document final exporté en I¥TEX soit com-
pletement conforme aux recommandations du journal auquel vous soumettez votre
papier.

6.1.2 Commencer un nouveau papier

Je vous suggere vivement de commencer avec le fichier de modele AASTEX. Cliquez
sur Fichier>Nouveau avec Modeéle, entrez le nouveau nom de fichier, puis choisissez le
modele aastex6.1lyx. Il montrera les champs les plus courants dans un manuscrit.
Ecrivez par dessus le texte existant (y compris les crochets, <>) les informations
correctes. Beaucoup des commandes et environnements AASTEX peuvent étre im-
plémentés directement dans IiyX, mais certains ne peuvent pas. Pour des commandes
comme celles-1a, le code KTEX doit étre entré directement et signalé comme tel. De

telles commandes sont dénommées “code TEX”. J’essaye de minimiser la quantité de
code TEX nécessaire dans un document AASTEX.
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6.1.3 Finir votre papier

Quand le papier est fini, que vous en étes satisfaits et qu’il se visualise / s’imprime
correctement, il y a quelques opérations de “post-production” a effectuer avant de le
soumettre aux journaux.

1. Exportez votre papier en tant que fichier TEX (Fichier>Exporter > IATEX).
2. Editez le fichier .tex résultant avec votre éditeur de texte favori.
a) enlevez les lignes de commentaire avant la commande \documentclass.

b) enlevez la ligne \usepackage...{fontenc} si elle apparait (en général
juste aprés \documentclass) ; enlevez aussi la ligne \secnumdepth si elle
est présente.

c) enlevez tout entre les commandes \makeatletter et \makeatother com-
prises, sauf les commandes que vous avez volontairement mises dans le
préambule BTEX (qui devraient apparaitre immédiatement apres le com-
mentaire “User specified BTEX commands”! dans le fichier .tex).

3. Faites tourner KXTEX sur ce fichier apres modifications pour s’assurer qu’il peut
encore étre compilé correctement.

4. Relisez les spécifications du journal pour vous assurer que vos noms de fichier
et vos formats sont corrects.

5. Soumettez-le.

6.1.4 Commentaires sur des commandes particulieres

Je ne vais pas décrire 'emploi détaillé de chaque commande AASTEX : le Guide
de l'utilisateur ’AASTEX (aasguide.tex) en donne une bonne description. Il me
sera donc probablement plus facile de parcourir la liste telle qu’on la trouve dans le
guide et de la commenter si nécessaire. Allons-y...

6.1.4.1 Les choses qui fonctionnent comme prévu

Puisqu’elles fonctionnent comme prévu, j'en fais simplement la liste avec la sec-
tion dans laquelle elles se trouvent : \documentclass (2.1.1), \begin{document}
(2.2), \title (2.3), \author (2.3), \affil (2.3), \abstract (2.4), \keywords (2.5),
\section (2.7), \subsection (2.7), \subsubsection (2.7), \paragraph (2.7), \begin{displaymat
(2.11), \begin{equation} (2.11), \begin{eqnarray} (2.11), \begin{mathletters}
(2.11), \begin{thebibliography} (2.12.1), \bibitem (2.12.2), \begin{table} (2.14.4),
\begin{tabular} (2.14.4), \caption (2.14.4), \1label (2.14.4, entre autres), \tablerefs
(2.14.5), \tablecomments (2.14.5), \url (2.15.4), \end{document} (2.16).

Les options de style qui suivent marchent elles aussi correctement : preprint,
preprint2, eqsecnum, flushrt (3, 3.1, 3.2). Mettez-les simplement dans le champ
Options de Document > Paramétres rubrique Classe de document.

1. NdT : “Commandes ITEX spécifiées par I'utilisateur”
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6.1.4.2 Les choses qui fonctionnent, mais qui nécessitent un commentaire

Les éléments suivants fonctionnent, mais requiérent un petit commentaire :

— Ces éléments sont réservés a l'utilisation par les éditeurs du journal, mais vous
pouvez les mettre dans le préambule KTEX si vous vous sentez tenu de le faire
: \received, \revised, \accepted, \ccc, \cpright (tous a partir de 2.1.3)

— Ces éléments peuvent étre placés dans le préambule BTEX, et sont inclus comme

des blancs dans le fichier modele : \slugcomment (2.1.4), \shorttitle (2.1.5),
\shortauthors (2.1.5)

— \email (2.3) — peut seulement étre utilisé seul, pas au milieu d’un paragraphe.
Utilisez du Vilain Texte Rouge si vous devez l'insérer.

— \and (2.3) — aura un {} en trop apres. Ca ne devrait pas causer d’erreur.

— \notetoeditor (2.6) — peut seulement étre utilisé seul, pas au milieu d’un
paragraphe. Utilisez du Vilain Texte Rouge si vous devez l'insérer.

— \placetable (2.8) — ne peut pas insérer une marque de référence croisée, vous
devez la placer a la main

— \placefigure (2.8) — méme chose que pour \placetable

— \acknowledgements (2.9) — aura un {} en trop apres. Ca ne devrait pas causer
d’erreur.

— \appendix (2.10) —aura un {} en trop apres. Ca ne devrait pas causer d’erreur.

— \figcaption (2.13.2) — vous devrez éditer le parametre optionnel a la main
dans le fichier BTEX final.

6.1.4.3 Les choses qui ne sont pas implantées, utilisez du code TgX

\eqnum (2.11), \setcounter{equation} (2.11), \citet (2.12), \citep (2.12),
les abréviations des noms de journaux (2.12.4), \figurenum (2.13.1), \epsscale
(2.13.1), \plotone (2.13.1), \plottwo (2.13.1), \tablenum (2.14.4), \tableline
(2.14.4, insérez-le comme le premier élément dans la case la plus a gauche apres
I'endroit olt vous voulez le placer. N'utilisez pas les régles IyX dans le tableau?),
\tablenotemark (2.14.5), \tablenotetext (2.14.5), pratiquement tout dans Divers
(2.15, sauf \url et \email ; voir ci-dessus), \singlespace (3.1), \doublespace (3.1),
\onecolumn (3.2), \twocolumn (3.2)

6.1.4.4 Les choses qui ne peuvent pas étre implantées

...au moins d’une facon qui ait un sens, et que je suggere donc d’ignorer. Ce sont
I'environnement references (2.12.3) et 'environnement deluxetable (2.14). Sivous
avez vraiment, vraiment besoin d’utiliser deluxetable, je vous suggere de ’éditer
avec un éditeur de texte dans un fichier séparé, puis de faire Insertion > Fichier > Sous-
document pour l'inclure dans votre document [yX. Voyez le fichier aas_sample.lyx
pour voir un exemple de cela.

2. NdT : Traduction incertaine.
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6.1.5 FAQs, conseils, trucs et autres astuces
6.1.5.1 Faire coopérer LyX et AASTEX

Il peut étre un peu difficile de faire reconnaitre a LyX un nouveau format et une
nouvelle classe de document. Quand tout le reste échoue, faites ceci :

1. Assurez-vous que KTEX trouve AASTEX. Copiez sample.tex (et peut-étre
table.tex) de la distribution AASTEX vers un répertoire complétement in-
dépendant de IXTEX ou d’AASTEX et faites tourner IXTEX sur sample.tex.

2. Assurez-vous qu’aastex.layout apparait bien dans le répertoire de formats
(layout) de LyX.

3. Refaites Outils> Reconfigurer dans 15X, puis redémarrez celui-ci.

4. Ouvrez un nouveau fichier normal, pas avec un modele. AASTEX apparait-il
dans Document > Paramétrest> Classe de document 7

Si vous obtenez un avertissement provenant d’'un document AASTEX existant vous
disant qu’il n’arrive pas a trouver le format AASTEX ou un message du genre “You
should not mix title layouts with normal ones”?, c’est que les choses n’ont pas été
installées correctement.

6.1.5.2 Erreur BTEX lors du traitement d’un tableau

LyX, par défaut, tente de centrer la légende/titre du tableau. Ca semble produire
une interférence négative dans AASTEX. Vous devez donc cliquer quelque part dans
la légende/titre, puis faire Edition>Parametres de Paragraphe, et régler 1'Alignement
sur Bloc. Pour moi ¢a a résolu le probleme.

6.1.5.3 Références

Quelques petites choses :

1. J’ai remarqué quelques espacements bizarres avec les entrées de bibliographie.
Quand vous entrez les données de bibliographie, assurez-vous qu’il n’y a pas
d’espace entre le dernier auteur et la parenthese indiquant I’année ; par exemple
tapez Ressler (1992) et non Ressler (1992).

2. Je suis vraiment malheureux de ne pas pouvoir rendre \citet et \citep plus
automatiques, mais ¢a nécessiterait des changements au code source de LyX.
Pour le moment vous pouvez faire deux choses :

a) entrez toutes vos citations en utilisant le mécanisme prédéfini Insertion >
Citation ; au moins vous pourrez tirer avantage des insertions automa-
tiques. Puis éditez a la main le fichier KTEX exporté avant de le soumettre,
en changeant les entrées \cite en commandes \citet ou \citep appro-
priées (\cite est actuellement équivalent a \citet, donc vous n’avez pas
absolument besoin de changer ceux-1a).

3. NdT : “Il ne faut pas mélanger les formats de titre avec les formats normaux.”
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b) ou vous pouvez simplement entrer toutes vos citations en Vilain Texte
Rouge en utilisant la méme clef pour parametre que celle que vous avez
utilisée dans la fenétre de bibliographie, par exemple \citet{clef}.

Aucun des deux choix n’est plaisant, mais nous aurons a faire avec jusqu’a ce
b
que le mécanisme de citation de [yX ne comprenne natbib.

3. Rien qu’entrer les références n’est pas du tout évident. La fagon la plus facile
est de commencer a taper votre premiere référence a la fin du document, puis de
la marquer comme Citation. Ca mettra une petite boite grise devant ce que vous
venez de taper. Cliquez sur la boite pour remplir le reste. Pour de nouvelles
références, allez a la fin d’une référence existante et appuyez sur Entrée. Ca
créera une nouvelle ligne avec sa propre boite, etc.

6.1.5.4 Inclure des fichiers EPS

Avec tout le respect qui est di a Chris Biemesderfer et aux autres qui ont contribué
a écrire le paquetage AASTEX, le mécanisme de gestion des figures est vraiment mal
foutu. Vous pouvez insérer les commandes \plotone, etc. en Vilain Texte Rouge
dans une Figure Flottante, mais je n’ai jamais vraiment réussi a obtenir une ap-
parence correcte. Mon conseil serait d’éviter toute inclusion de fichier EPS dans le
manuscrit que vous soumettez au journal, mais d’utiliser le mécanisme d’inclusion
de fichier EPS standard de LyX quand vous voulez imprimer vos propres tirés a
part. IyX va insérer une commande \usepackage{graphics} dans le préambule
ETEX et gérer les figures de la fagon habituelle dans BTEX 2. Ceux qui essaieront
d’imprimer votre manuscrit AASTEX 5.0 doivent de toutes fagons avoir une instal-
lation de BTEX 2¢, donc pourquoi ne pas profiter du mécanisme infiniment meilleur
de gestion de graphiques 7 S’ils se plaignent du choix de IXTEX 2¢ ou du paquetage
graphics, faites valoir qu'’il apparait dans la deuxiéme édition de Lamport (1994),
et qu’il était temps de faire la mise a jour il y a bien longtemps.

6.1.5.5 Les choses qui auraient pu étre faites, mais qui ne I'ont pas été

Il y a quelques choses “sympathiques” que j’aurais pu implémenter, mais que j’ai
choisi de laisser de coté. Par exemple, je ne voyais pas 1'utilité d’afficher le texte en
double interligne dans la fenétre de LyX, méme s’il I'est dans le manuscrit imprimé.
J’ai aussi choisi de ne pas faire des formats séparés pour les styles preprint et
preprint2. Comme je suppose que vous passerez la plupart du temps en mode
manuscrit simple, j’ai décidé de ne pas bouffer plus d’espace disque avec tout ¢a. Si
vous pensez vraiment que je devrais écrire ces formats, je ne pourrai que suivre les
régles édictées par 1’Association de Lanceurs de Boomerangs de 'Etat du Wisconsin

“Les décisions des juges seront sans appel sauf si elles sont conspuées
par une majorité écrasante de ’assistance. Les réclamants ne doivent pas
faire usage d'un vocabulaire obsceéne et injurieux envers les membres du
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jury, ni les membres du jury envers les réclamants (sauf s’ils viennent
d’étre frappés par un boomerang).”

6.1.6 Touche finale

J’al maintenant eu des papiers publiés aussi bien dans Apj que dans AJ avec 98%
du travail fait avec IyX ; les 2% restants étant du post-traitement avec BTEX et un
peu de nettoyage. Je n’ai rencontré aucun probleme avec le processus de soumission,
et je suis stir que les journaux n’ont jamais eu conscience qu’il pouvait y avoir une
différence. Donc, allez-y et publiez !

6.2 Article A&A

par PETER SUTTERLIN

6.2.1 Introduction

Cette section décrit comment utiliser IyX pour écrire des articles a soumettre au
journal scientifique Astronomy and Astrophysics (https://www.aanda.org/), avec
la Version 5.01 de la classe de document aa.cls. Ce paquetage peut étre téléchargé
depuis le site ftp

ftp://ftp.edpsciences.org/pub/aa/readme.html

Un manuel est fourni avec ce paquetage, et ce texte n’est pas censé remplacer le
manuel d’origine mais est simplement un bref guide a la réalisation d’'un papier dans
un format correct.

Notez que I'éditeur de ce journal a changé le ler janvier 2001 : ce n’est plus Springer
mais EDP Sciences. Ce changement a aussi entrainé quelques légeres modifications
aux fichiers de style, notamment la suppression de la commande thesaurus. La classe
LyX aa supporte la derniere version de ces fichiers de style, V 5.01. Si vous avez
une ancienne version installée, veuillez la mettre a jour. Par souci de compatibilité,
I'ancien format (version 4) a été conservé sous le nom de article (A&A V4). Voyez les
commentaires dans IyXDir/layouts/aapaper.layout.

6.2.2 Pour commencer
Il est recommandé de commencer a partir du modele distribué avec IyX. Si vous
n’utilisez pas de modele, jetez un ceil aux réglages suivants :

— Choisissez article (A&A) dans le champ Classe de Document du dialogue Docu-
ment > Parameétres. (D’accord, c’est évident.)

— Ne changez pas 'option Mise en page : laissez-la sur Défaut. La mise en page
est prise en charge par les macros, vous n’avez rien a changer.
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6.2.3 Le bloc d’en-téte

La premiere chose a entrer est 'information d’en-téte. Elle consiste en sept entrées,
dont certaines sont facultatives. Ce sont

— Titre (Title) : (nécessaire)

— SousTitre (Subtitle) : (facultatif)

— Auteur (Author) : (nécessaire)

— Adresse (Address) : (nécessaire)

— Tirés_A_Part (Tiré a part): (facultatif) Si plus d’un auteur : qui contacter pour
demander des tirés a part.

— Mail : (facultatif) Adresse mail pour les contacts.
— Date : (nécessaire) Format suggéré Received: <date>; Accepted <date>

Il n’y a pas besoin de taper la commande \maketitle, LyX le fait tout seul quand
I’en-téte est fini. Bien que l'ordre des entrées d’en-téte n’ait pas d’importance il est
conseillé de conserver la séquence ci-dessus, juste pour avoir un meilleur aspect visuel
et correspondre au format du document réel.

Si vous voulez placer des notes de bas de page dans le bloc d’en-téte, par exemple
pour entrer votre adresse actuelle, utilisez les notes de bas de page standard avec
Insertion > Note en Bas de Page. LyX utilisera automagiquement \thanks{} dans ce
cas.

Via Edition>Style de texte, vous trouverez deux marqueurs utiles pour le titrage:

— Institution pour indiquer les couples auteur/institution. Les institutions sont
numérotées séquentiellement comme elles apparaissent dans le champ Address,
vous devez donc mettre un marqueur pour chaque auteur.

— Email pour indiquer une adresse électronique.

En plus de ces points, les macros utilisent une commande TEX supplémentaire qui
n’a pas d’équivalent dans [yX :

— \and pour séparer les noms quand il y a plusieurs auteurs et plusieurs instituts.

La commande appropriée doit étre tapée dans [y X en mode TEX. Voir les exemples.

6.2.4 L’abstract

L’abstract devrait suivre immédiatement le bloc d’en-téte. Avec la version 5
I’abstract est devenu une commande, et il est maintenant limité a un seul paragraphe.
En plus, il doit contenir une entrée avec les mots-clés. La seule chose spéciale a en
dire est qu’il doit contenir une entrée avec les mots-clés. Ce se fait via le style de
paragraphe Keywords. Référez-vous au fichier d’exemple.
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6.2.5 Environnements supportés

Le format paper (A&A) supporte les environnements suivants pour structurer votre
texte :

— Standard

— Section

— SousSection

— SousSousSection

— ListePuces

— Enumération

— Description

— Légende

— Abstract

— Remerciement

— Bibliographie

— BTEX

6.2.6 Commandes non encore supportées par LyX

Quelques commandes ne sont pas encore supportées par le format paper (A&A) de
LyX. Quelques-unes ont déja été mentionnées. Par souci d’exhaustivité, elles sont
toutes listées ici :

— \and

— \authorrunning
— \object{}

— \titlerunning{}

Si vous voulez utiliser I'une de ces commandes, vous devez les taper vous-mémes.
N’oubliez pas de les signaler comme code BETEX !

6.2.7 Figures et tableaux flottants

LyX fournit le support pour les environnements de flottants figure, figure*; table et
table*, nous n’en dirons donc pas beaucoup plus. Référez-vous au Guide de [’Utilisateur.
Rappelez-vous juste que les tableaux devront étre alignés a gauche. Pour cela, sélec-
tionnez le tableau et changez I’alignement dans Format > Paragraphe.

Il y a une seule chose spéciale : les figures avec la légende a coté. Pour créer une
telle figure, vous devez faire ceci :

1. Créez une grande figure flottante : faites Insertion Flottants> Figure, puis un
clic droit sur la figure et cochez Plusieurs colonnes.
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Entrez votre 1égende.
Tapez Entrée pour déplacer le curseur au dessus de la figure.

Insérez votre figure.

ATl B

Positionnez le curseur derriére la figure et insérez un ressort horizontal : Inser-
tion> Formats > Ressort Horizontal.

6. Passez en mode BKTEX : M-c t.
7. Entrez \parbox[b]{55mm}{. Ne fermez pas ’accolade !

8. Positionnez le curseur derriere le texte de la légende, passez en mode KTEX et
insérez l’accolade fermante : M-c t }.

La encore, voyez les figures dans le papier exemple.

6.2.8 Format de revue

Pour la soumission, la communication doit étre mise en forme dans un format
spécial a double interligne. Pour ce faire, vous devez donner a la classe de docu-
ment 'option referee. Il faut la mettre dans le champ Réglable, dans Document >
Parameétres rubrique Classe de documentr> Options de classe. Entrez-y juste le mot
referee.

6.2.9 Le fichier d’exemple

Le répertoire d’exemples contient un papier exemple écrit avec Iy X. C’est I'exemple
venant du paquetage de macros d’origine, traduit pour LyX. Utilisez-le comme source
d’inspiration, et comparez le code BTEX d’origine avec la fagon de 1’écrire avec LyX.

6.3 BTEX AMS
par DAVID JOHNSON; mise a jour par RICHARD HECK

Les formats IXTEX AMS ont été écrits pour se conformer au style suggéré pour les
articles mathématiques a soumettre aux publications de I’American Mathematical So-
ciety. Les formats ne sont pas définis pour une revue particuliere, mais peuvent facile-
ment y étre adaptés. Il faut vous référer a la documentation de ’AMS pour obtenir
des instructions spécifiques & chaque revue (habituellement il suffira de changer
une ligne dans la sortie TEX). Cette documentation est disponible sur le réseau
a http://www.ams.org ou par ftp a ftp://ftp.ams.org/pub/tex/amslatex/. Ces
formats sont appropriés, et utiles, pour tout écrit mathématique.

Il y a actuellement 2 formats IXTEX AMS distincts :

1. amsart : le format standard d’article AMS.

2. amsbook :1Le format standard de livre AMS (en réalité de monographie).
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Les formats eux-mémes ne contiennent qu'un minimum nécessaire pour 1'utilisation
des classes AMS. Ils n’inclent aps en particulier d’environnments de “théoremes”
pour les théoremes, les lemmes, et similaires. Ceux-ci sont fournis par le module
THEOREMES (AMS), chargé implicitement lorsqu'une classe AMS est sélection-
née (il peut ére utilisé avec d’autres classes et peut étre enlevé, si vious souhaitez
utiliser autre chose). Les environnements contenus dans Théorémes (extensions
AMS), moins fréquemment utilisés, doivent étre chargés manuellement.

Implicitement, les théoremes et environnements similaires sont numérotés conséc-
utivement tout au long du document, mais ceci peut étre modifié en chargeant le
module Théorémes (numérotation par section) ou bien, si vous utilisez la classe
book (AMS), le module Théorémes (numérotation par chapitre). Ceux-ci vont
numéroter les environnements comme n.m., ou le premier nombre réfere la section
(ou le chapitre) et le second réfere le numéro d’ordre courant dans la section (ou le
chapitre). De nombreux environnements peuvent aussi rester non numérotés, ceux-ci
sont marqués par un astérisque. Si par hasard vous désirez que tous les environ-
nements soient non numérotés, utilisez le module Théorémes (non numérotés).

Notez que ces modules ne doivent pas étre nécessairement utilisés avec les classes
AMS. Il est parfaitement possible d’utiliser les modules Théorémes (AMS) et les
autres modules mentionnés ci-dessus avec d’autres classes, comme article, report,
book (KOMA-script), etc.

6.3.1 Ce qu’offrent ces formats

La liste des environnements offerts par ces formats est longue. Avec IXTEX AMS il
v a la possibilité de définir une variété illimitée d’environnements de type “théoreme”.
Cependant, ’AMS recommande les environnements disponibles dans LyX. Voici la
liste des environnements ainsi que les environnements standard, comme SECTION,
BIBLIOGRAPHIE, TITRE, AUTEUR et DATE proposés par article (AMS) and book
(AMS):

Adresse Ce devrait étre I'adresse permanente de I'auteur.

Adresse__Actuelle Ce devrait étre I'adresse temporaire de 'auteur au moment de la
soumission, si elle est différente de 1’Adresse ci-dessus.

Email L’adresse e-mail de 'auteur.
URL L’adresse de la page personnelle de 'auteur, s’il le souhaite.

Mots-clés Mots-clés ou descripteurs, utilisés pour identifier les sujets discutés dans
I’article.

Classe_Sujet Ceci fait référence a la Classification des Sujets de I’AMS, publiée et
décrite dans Mathematical Reviews. FElle est aussi disponible en ligne sur les
sites de I’AMS cités plus haut.

Remerciements
Dédicace
Traducteur
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Les environnements suivants sont fournis aussi bien par le module Théorémes que
par le module Théorémes (AMS), en version numérotée ou non numérotée pour ce
dernier. Ces environnements sont fournis dans la seule version non numérotée par le
module Théorémes (non numérotés):

Theorem 1. Typiquement utilisé pour les résultats les plus importants.

Corollary. Corollaire Utilisé pour des assertions qui découlent assez directement
d’assertions précédentes. Peuvent étre également des résultats importants.

Lemma 2. Ce sont des résultats moins forts, nécessaires a la preuve d’autres asser-
tions.

Proposition 3. e sont des résultats moins importants qui apportent quelque chose a
la théorie générale dont il est question.

Conjecture 4. Ce sont des assertions fournies sans justification, dont 'auteur ne
connait pas de preuve, mais qui semblent vraies (du moins aur yeuzr de 'auteur).

Definition. Devinez a quoi ¢a sert. La police, a la fois a ’écran et a 'impression,
est différente dans cet environnement.

Example. Utilisé pour illustrer des résultats prouvés.
Problem 5. On ne sait pas a quoi sert celui-ci, vous devriez chercher.
Exercise. Ecrire une description de celui-ci.

Remarque (Remark) Cet environnement est également un nouveau type de théoréme.
Le mot “Remark” apparait en italique, et le reste comme du texte simple.

Claim. Souvent utilisé dans le cours d’une preuve d’un résultat plus vaste.

Case 1. En général, ils servent a diviser de longues preuves en examinant des cas
distincts.

Case 2. Le schéma de numérotation des cas leur est spécifique : il n’appartient pas
a la méme séquence que les autres assertions.

Proof. A la fin de cet environnement est inséré un symbole CQFD (d’habitude un
carré, mais ¢a peut varier avec les différents styles). Si vous désirez avoir d’autres
environnements insérés dans celui-ci, et avoir le symbole CQFD tout a la fin, il faut
augmenter la profondeur de ceux-ci (voir la section Emboiter les environnements dans
le Guide de l'utilisateur). O

Et ces environnements sont fournis par le module Théorémes (extensions AMS):
Criterion. Une condition requise.

Algorithm. Une procédure générale a utiliser.
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Axiom. C’est une propriété ou assertion considérée comme vraie dans la théorie
dont il est question.

Condition. Utilisé parfois pour expliciter une condition admise dans le contexte de
la discussion.

Note. Note Typographie similaire a Remarque.
Notation. Comme son nom l'indique
Acknowledgement. Idem

Conclusion. Utilisé parfois a la fin d’une argumentation
Fact 6. Utilisable comme Proposition, a une échelle peut-étre réduite
En plus, ces environnements se servent automatiquement des paquetages de polices

AMS-ETEX et AMS. 11 faut qu’ils soient disponibles sur votre systeme pour pouvoir
utiliser ces environnements.

6.4 Broadway

par GARST REESE

6.4.1 Introduction

Broadway est destiné a ’écriture de pieces de théatre. Le format est plus décoratif
que Hollywood, et beaucoup moins standardisé. Ce format devrait convenir a des
ateliers.

6.4.2 Probléemes particuliers

Les mémes que dans Hollywood.

6.4.3 Fonctions particuliéres

Entrez les noms des personnages comme étiquettes puis faites des références croisées
sur ces étiquettes pour insérer le nom. La fenétre de référence croisée montrera
I’ensemble des personnages.

6.4.4 Taille de papier et marges

USLetter, gauche 1,6 in, droite 0,75 in, haut 0,5 in, bas 0,75 in.
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6.5 Dinbrief

6.4.5 Environnements

Les environnements suivants sont disponibles. Vous pouvez utiliser broadway .bind
pour accéder aux touches de raccourci indiquées a droite.

Standard
Vous ne devriez pas avoir a 'utiliser, mais il est la pour tout ce qui n’a pas sa
place ailleurs.

Narrativeby M-z n
Utilisé pour décrire le décor et I'action. La premiére occurrence des noms des

personnages en MAJUSCULES.
ACT (Acte) M-z a

Automatiquement numéroté. A 1’écran sera en chiffres arabes, mais imprimé
en chiffres romains.

ACT* (Acte*) M-z S at
Sous-titre pour ACT. C’est juste du texte centré.
SCENE M-z S-S

Pas automatiquement numéroté. Vous donnez le numéro. C’est parce que je
n’ai pas trouvé comment faire.

AT RISE (Lever de Rideau) M-z S-R
Un cas particulier de Narrative pour décrire le décor et 'action quand le rideau
se leve.

Speaker M-z s
Le nom du personnage, centré en MAJUSCULES.
Parenthetical (Didascalies) M-z p

Instructions au personnage. Les () sont insérées automatiquement, mais seule
la ( sera affichée dans LyX. Les deux seront imprimées. Cet environnement
n’est utilisé qu’a l'intérieur de Dialogue.

Dialogue M-z d
Ce que dit le personnage.

CURTAIN (Rideau) M-z S-C
Le rideau tombe.

Titre M-z S-T
Auteur M-z S-A
Right_Address M-z r

Salut tout le monde.

6.5

Dinbrief

La classe de document dinbrief peut servir a taper des lettres selon les conventions
allemandes. Un fichier modeéle est inclus dans . . ./lyx/share/templates pour vous
servir de point de départ.
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6.6 Elsevier Journals

Voir le fichier modele elsarticle.lyx. Il contient toutes les informations néces-
saires.

6.7 Diapos Foils (alias Foil TEX)

par ALLAN RAE

6.7.1 Introduction

Cette section décrit comment utiliser [xX pour préparer des transparents pour
rétroprojecteurs. Il y a deux classes de document qui le permettent : la classe par
défaut slides et la classe FoilteX. Cette section décrit la classe FoilteX

Redisons-le donc bien clairement :

Cette section concerne la classe “FoilTeX” uniquement.

Si vous voulez une documentation sur “slides (default)”, voyez la section 6.8. Si
votre machine n’a pas la classe foils installée FoilTeX, il vous faudra siirement utiliser
la classe slides par défaut, qui n’est pas aussi bonne.

La classe foils est congue pour étre utilisée avec la version 2.1 du fichier de classe
KTEX foils.cls. Celui-ci fait maintenant partie intégrante de I¥TEX 2¢.

6.7.2 Pour commencer

Bien entendu, pour utiliser cette classe de document, il vous faut sélectionner
FoilTeX dans le champ Classe de la fenétre Document> Parameétres> Classe de docu-
ment. Il y a quelques autres réglages qui ont une signification spéciale avec cette
classe :

— Ne changez pas les options Pagination et Colonnes dans la fenétre Document >
Parameétres. Elles sont ignorées par la classe foils.

— La taille par défaut est de 20 pt, les autres choix étant respectivement 17 pt,
25 pt et 30 pt.

— La police par défaut est Sans empattement mais toutes les équations mathéma-
tiques restent formatées dans la police habituelle Romain.

— Foil TEX accepte les formats de papier A4 et Letter, ainsi qu'un format particulier
pour travailler avec des diapos 35mm. Les tailles A5, B5, legal ou executive ne
sont pas supportées.

— Ne vous occupez pas de Placement des flottants : 1'option est de toute facon
ignorée. Tous les flottants apparaitront la ou ils sont définis dans le texte.
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6.7 Diapos Foils (alias Foil TEX)

— Les réglages Mise en page se comportent un peu différemment avec cette classe.
Foil TEX propose en effet des possibilités plus étendues pour les en-tétes et

pieds de
section 6

page, comme l'insertion d'un logo défini par l'utilisateur. Voyez la
.7.4.6 pour de plus amples détails. La page de titre est traitée dif-

féremment de toutes les autres pages du document et n’est jamais numérotée.
L’éventuel logo y est toujours centré au bas de la page. Les différentes mises
en page possibles sont les suivantes :

vide

ordinaire

Les diapos ne présenteront ni numéro de page, ni en-téte ou
pied de page (sauf évidemment les notes de bas de page).

Les diapos auront un numéro de page centré en bas de la page.
Ni en-téte, ni pied de page (a part les notes).

foilheadings Le numéro apparait en bas a droite. Les en-tétes et pieds de

page seront présents. C’est le choix par défaut.

sophistiqué Vous donne acces au paquetage fancyheadings, et ce méme si son

utilisation est déconseillée par 'auteur de Foil TEX car certaines
incompatibilités apparaissent.

6.7.2.1 Options supplémentaires

Les options

suivantes peuvent étre activées dans le champ Options de la fenétre

Document > Parameétres > Classe de document.

35mmsSlide

headrule

footrule

dvips

landscape

legno

fleqn

Regle le format de page a 7,33 pouces sur 11 pouces, ce qui donne le
méme rapport largeur/hauteur qu’une diapo 35 mm, facilitant ainsi le
travail avec ce support.

Trace une ligne horizontale le long de la page, au-dessous de I’en-téte,
sur toutes les pages sauf celle de titre.

Trace une ligne horizontale le long de la page, au-dessus du pied de
page, sur toutes les pages sauf celle de titre.

Cette option indique a Foil TEX d’utiliser le pilote dvips pour effectuer
les rotations des pages en format paysage. (Elle est automatiquement
activée a la création d’un nouveau document foils).

Change simplement la taille des pages au format paysage, mais sans
effectuer de rotation. Si vous utilisez cette option, vous aurez besoin
d’un programme externe pour effectuer une rotation de chaque page,
ou bien il vous faudra alimenter votre imprimante directement en for-
mat paysage. Remarquez que cette option renverse les roles respectifs
des environnements En-téte_Diapo et En-téte_Diapo_Tourné (ne vous
inquiétez pas, ils sont décrits plus loin).

Numéros des équations a gauche.

Equations alignées a gauche.
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6.7.3 Environnements supportés

La plupart des environnements courants sont supportés par la classe foils. Il y a
des environnements supplémentaires fournis par Foil TEX ainsi que deux apportés par
LyX. Les environnements suivants sont partagés avec d’autres classes :

— Standard — Citation

— ListePuces — Titre

— Enumeration — Auteur

— Description — Date

— Liste — Abstract

— LyX-Code — Bibliographie

— Vers — Adresse

— Cite — Adresse_A_Droite

En gros, il s’agit de tous les environnements, mis a part ceux de section. En effet,
dans un diaporama, les sections sont en fait les diapos elles-mémes. Foil TEX propose
des commandes pour commencer de nouvelles diapos :

— En-Téte_Diapo (Foilhead)
— En-Téte_Diapo_Tourné (RotateFoilhead)
LyX a aussi des versions légerement modifiées de ces deux environnements :
— En-téte_Diapo_Court (ShortFoilhead)
— En-téte_Diapo_Court_Tourné (ShortRotateFoilhead)

Les différences seront expliquées dans une autre section.
De plus, les diapos sont souvent utilisées pour exposer des idées, ou de nouveaux
théoremes. De ce fait, Foil TEX fournit aussi un ensemble d’outils pour les présenter :

— Théoreme — Théoréme*

— Lemme C Lemme*

— Corollaire -
" — Corollaire

— Proposition

— Définition Proposition

— Preuve — Définition*

Les versions sans étoile sont numérotées, tandis que celles avec étoile ne le sont
pas. Il y a enfin des environnements de liste ajoutés par LyX :

— ListeCochés (TickList)
— ListeCroix (CrossList)
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Foil TEXoffre aussi de nombreuses possibilités pour les en-tétes et pieds de pages, qu’il
vaut mieux définir dans le préambule, bien que vous puissiez le faire a tout moment
dans le document. Si vous souhaitez changer ces réglages en cours de document, il
est préférable de le faire au tout début d’une diapo, donc juste apres I’En-téte_Diapo.

Pour ces réglages, vous disposez des environnements suivants [MARTIN VERMEER]

— Mon_Logo (My_ Logo) — En-téte_Droite (Right Header)
— Restriction — En-téte_Gauche (Left_ Header)
— Pied_Droite (Right_ Footer)

Certaines commandes de Foil TEX ne sont pas directement supportées par LyX, mais
vous pourrez tout de méme les utiliser, comme 'explique la section 6.7.5.

6.7.4 Création de diapos

Cette section est une rapide introduction aux différents environnements qui per-
mettent de construire un ensemble de diapos. Si vous voulez un exemple, ouvrez
Foils.lyx qui se trouve dans le répertoire des exemples.

6.7.4.1 Donner un titre de page

A la différence des autres classes qui proposent les environnements Titre, Auteur et
Abstract, la classe foils crée le titre sur une page a part. Si vous laissez I’environnement
Date vide, XTEX lui substituera la date du jour (et ce, a chaque fois que vous générerez
le rendu).

6.7.4.2 Débuter une nouvelle diapo

Comme il est dit plus haut, il existe quatre maniéres de commencer une nouvelle
diapo. Pour les formats portrait, utilisez En-téte_Diapo ou En-téte_Diapo_Court.
La différence entre ces deux environnements est la quantité d’espace entre le titre
(I’En-téte_Diapo) et le corps de la diapo.

Les diapos en position paysage seront créées via les environnements En-téte_Diapo_ Tourné
et En-téte_Diapo_Court_Tourné. A nouveau, la seule différence est espace entre le
titre et le corps. Les deux versions courtes ont 0,5 pouce de séparation en moins.

Il vous faut dvips pour générer des sorties PostScript de diapos en format paysage,
sans quoi la rotation de ces diapos ne sera pas exécutée. Il vous sera possible d’obtenir
des diapos en format paysage sans dvips, mais il vous faudra introduire les feuilles
en position couchée dans I'imprimante ;-)

6.7.4.3 Théoremes, lemmes, preuves et tutti quanti

Deux de ces environnements ne peuvent se suivre directement. Ils doivent étre
séparés par quelque chose. Si vous utilisez une rupture normale de paragraphe, vous
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allez juste allonger I’environnement précédent comme si vous aviez fusionné les deux
environnements. Plutot que de faire cela, vous devez insérer un “séparateur”. Voyez
la section intitulée Emboitements séparés dans le Guide de ['utilisateur.

6.7.4.4 Listes

Vous pouvez profiter de tous les types de listes que 'on trouve dans les autres
classes plus deux nouvelles. Je ne décrirai ici que ces dernieres. Si vous voulez plus
d’informations sur les autres environnements de liste, voyez le Guide de [’Utilisateur.
Si vous voulez utiliser les listes a puce, lisez aussi le paragraphe sur le choix des puces,
a la section 3.5.

Les deux nouveaux environnements de liste, ListeCochés et ListeCroix, ont pour but
de faciliter 'utilisation de listes “A faire / A éviter” ou “Oui / Non”, bref, qui utilisent
comme puces des coches ou des croix. Ces listes sont en fait des versions spécialisées de
I’environnement Itemize. Elles nécessitent cependant que vous disposiez du paquetage
psnfss.

6.7.4.5 Figures et tableaux

Foil TEX redéfinit la notion de figures et tables flottantes afin qu’elles apparaissent
exactement 1a ou elles sont dans le texte plutot qu’en haut des pages ou en une
quelconque autre position prédéfinie. En fait, si vous changez les réglages de posi-
tionnement des flottants, ces modifications ne seront pas prises en compte.

6.7.4.6 En-tétes et pieds de pages

Les deux commandes Mon_Logo et Restriction servent a définir le texte en pied
de page a gauche. La premiere vous permet d’insérer un logo sur vos diapos. Vous
aurez par défaut comme logo “-Typeset by Foil TEX-". La seconde sert a classifier des
documents en fonction du type de public, par exemple “Confidentiel”. Par défaut
elle ne contient rien.

Vous pouvez remplir les autres coins de la page avec Pied_Droite (qui par défaut
contient le numéro de page), En-téte_Droite et En-téte_ Gauche.

6.7.5 Fonctions de Foil TEX non-supportées

Toutes les commandes décrites ci-dessous doivent étre entrées dans un environ-
nement ATEX, ou en mode TEX dans un autre environnement.

6.7.5.1 Longueurs

Toutes les longueurs sont ajustées en utilisant la commande \setlength{nom longeur}-
{nouvelle_longeur} ou nom__longeur sera remplacé par le nom de la variable de
longueur que vous voulez modifier, et nouvelle longeur par la valeur de la variable.
Toutes les variables de longueur doivent étre indiquées dans des unités comme le
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pouce (in), le millimetre (mm) ou le point (pt), ou bien dans une unité dépendant du

document ou de la police employée, comme \textwidth.
Il est possible de changer ’espacement entre 1’en-téte et le corps d’une diapo en

ajustant la longueur spécifiée par \foilheadskip. Par exemple, pour rendre tous les

titres plus proches des corps de 0,5 pouce, mettez dans le préambule \setlength{\foilheadskip}{-0.5:
L’espacement autour des flottants peut étre modifié via ces variables :

\abovefloatskip Séparation entre le texte et le haut du flottant ;
\abovecaptionskip  Séparation entre le flottant et sa légende ;
\belowcaptionskip  Séparation entre la légende et le texte qui la suit ;

\captionwidth Vous pouvez rendre les légendes plus étroites que le texte
alentour en réglant cette valeur. Le mieux est stirement de
la définir en fonction de \textwidth.

Il y a aussi plusieurs variables de longueur relatives a la page de titre. Elles vous
seront utiles dans le cas d’un titre long, ou de plusieurs auteurs :

\abovetitleskip Séparation entre les en-tétes et le titre (environnement Titre)

I

\titleauthorskip entre les environnements Titre et Auteur ;
\authorauthorskip entre différentes lignes de ’environnement Auteur ;
\authordateskip entre 'auteur et la date ;

\dateabstractskip entre la date et le résumé (Abstract).

La derniere des commandes d’ajustement de longueur agit sur tous les environnements
de liste. Si vous placez \zerolistvertdimens dans un environnement de liste, tout
I’espacement vertical entre les éléments de la liste est supprimé. Remarquez qu’il
s’agit d'une commande et non d’une variable, donc on n’utilise pas ici \setlength.

6.7.5.2 En-tétes et pieds de page

Les commandes \LogoOn et \LogoOff permettent de préciser dans une page don-
née si le logo de Mon_Logo apparaitra ou non. Si vous mettez \LogoOff dans le
préambule, aucune des diapos n’aura de logo. Si c¢’est uniquement sur une diapo
particuliere que vous ne voulez pas de logo, mettez \LogoOff juste apres le début de
cette diapo et \LogoOn juste apres le début de la suivante.

Si vous voulez utiliser le style d’en-tétes sophistiqué dans la fenétre Document>
Paramétres > Format de la page, il vous faudra stirement ajouter \let\headwidth\textwidth
a votre préambule. Ainsi, en format paysage, les en-tétes et les pieds de page seront
positionnés correctement une fois les pages retournées. C’est obligatoire a cause
d’incompatibilités entre le paquetage fancyheadings et la classe foils.

6.8 Diapos Slides (alias SIiTEX)

par JOHN WEISS.
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6.8.1 Introduction

Cette section décrit comment utiliser Iy X pour préparer des transparents pour
rétroprojecteurs. Il y a deux classes de document qui le permettent : la classe par
défaut slides et la classe FoilteX*. Cette section décrit la premiere.

Je le redis, clairement et distinctement, qu’il n’y ait pas de malentendu :

Cette section décrit uniquement la classe “slides (default)”.

Si vous cherchez une documentation sur “slides (Foil TEX)”, voyez la section 6.7. La
classe foils (pour Foil TEX, vous I'aurez compris) est en fait un peu meilleure que la
classe par défaut slides®, dont parle cette section.

Cette classe est I’évolution en IXTEX 22 du vieux package SLITEX. Toutes les distri-
butions de KTEX 2 comprennent cette classe (qu’a partir de maintenant j’appellerais
simplement “slides”), donc vous devez logiquement I’avoir. Comme je 'ai déja dit, il
existe d’autres classes qui produisent aussi des transparents pour rétroprojecteurs et
font du meilleur boulot, comme foils. Cependant, il y a des choses que slides fait et
que les autres ne font pas, comme générer des sur-couches. Continuez la lecture pour
en savoir plus !

6.8.2 Pour commencer

Avant tout, pour utiliser cette classe de document, vous devez sélectionner “slides (de-
fault)” comme Classe dans la fenétre Document> Paramétres. Il y a quelques particu-
larités qu’il faut connaitre a propos de cette classe :

— Ne vous fatiguez pas a changer les options Pagination et Colonnes dans Docu-
ment > Parametres : de toute facon, elles ne sont pas supportées par la classe
slides.

— L’option Mise en page de la fenétre Document > Parametres a un comportement
un peu différent pour cette classe. Voici les choix possibles et leurs effets :

ordinaire Le rendu final contient des numéros de page dans le coin inférieur
droit.

en-tétes Comme ordinaire, mais imprime aussi tous les marqueurs temporels
que vous aurez placés. C’est le choix implicite.

vide Le rendu final ne contient pas de numéros de page, de marqueurs temporels
ni de marqueurs d’alignement.

— La classe slides a une option supplémentaire : clock. Pour l'utiliser, mettez
“clock” dans les Options de la fenétre Document > Parameétres> Classe de docu-
ment.

4. Iy en a d’autres, comme Beamer, mais elle ne sont pas décrites dans ce document (NdT).
5. ... enfin, c’est ce que m’ont dit et répété ses défenseurs. Ne Iayant jamais utilisée, je n’ai
aucune idée de la validité de cette affirmation.
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Utiliser cette option vous permet d’ajouter des marqueurs temporels aux Notes.
Voir la section 6.8.4.3 pour plus de détails.

Vous pouvez aussi utiliser le fichier modele "slides.lyx" pour mettre en place au-
tomatiquement un document de la classe slides (avec Fichier>Nouveau avec modeéle
pour créer votre document). Le fichier modéle contient aussi quelques exemples
d’environnements de paragraphe spéciaux utilisés par cette classe. Je vais main-
tenant décrire ces derniers.

6.8.3 Environnements de paragraphe
6.8.3.1 Environnements supportés

La premiére chose que vous allez remarquer en commencant un nouveau document
slides est la taille et le type de police : il est équivalent a la taille Grand (3) dans
la police Sans empattement. C’est aussi la police qui est utilisée pour le rendu final.
Dites-vous que c’est un “indice visuel” pour vous rappeler que c¢’est une diapositive.
Vos transparents finaux utiliseront une grande police, donc vous aurez moins de
place. Bien siir, la police plus grande a I’écran n’est pas WYSIWYG, mais juste un
aide-mémoire.

La deuxiéme chose qui frappe est le changement du menu des environnements (tout
a gauche de la barre d’outils). La plupart des environnements de paragraphe que vous
avez I’habitude d’y voir sont absents. Il y en a aussi cinq nouveaux. C’est parce que
la classe slides elle-méme ne supporte que certains environnements de paragraphe :

— Standard
— ListePuces
— Enumération
— Description
— Liste

— Citation

— Cite

— Vers

— Légende

— LyX-Code

Tous les autres environnements standard, comme les en-tétes de section, ne servent
pas dans la classe slides.
D’autre part, vous remarquerez de nouveaux environnements :

— Diapo (Slide)
— Surcouche (Overlay)
— Note

— Texte_Invisible (InvisibleText)
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— Texte_Visible (VisibleText)

Ces cing-la présentent des subtilités, dues a une “fonction” de IyX. LyX, voyez-vous,
ne vous autorise pas a inclure un environnement de paragraphe dans un environ-
nement vide. C’est sympa et marrant, mais cela signifie que vous ne pourrez pas
commencer une diapo par autre chose que du texte. Pour contourner cela, j’ai fait
un peu de “magie BTEX".

6.8.3.2 Subtilités des nouveaux environnements

Les cinq nouveaux environnements de paragraphe présentent tous des bizarreries,
dues aux limitations inhérentes a la version actuelle de IyX. Comme je viens de le
dire, [xX interdit les environnements qui commencent par un autre environnement.
Pour contourner ceci, ’environnement Diapo n’en est pas vraiment un, si 'on se fie
a la description du Guide de [’Utilisateur.

Il faut considérer Diapo, Surcouche et Note comme des “pseudo-environnements”.
[ls ressemblent a des en-tétes de section ou a une Légende, mais en fait commencent un
environnement de paragraphe (et terminent le précédent si nécessaire). De la méme
maniere, considérez Texte_ Invisible et Texte_ Visible comme des “pseudo-commandes”.
Ces deux objets réalisent en effet des actions.

Un propriété commune aux cing environnements Diapo, Surcouche, Note, Texte_ Invisible
et Texte_Visible est un marqueur plutot longuet. Le texte suivant ce marqueur —
d’ordinaire le contenu de I’environnement de paragraphe — n’est pas pris en compte
par Diapo, Surcouche, Note, Texte_ Invisible et Texte_Visible. Ly’X l'ignore totalement.
En fait, vous pouvez laisser ces cinq environnements completement vides.

Bien qu’il ne soit pas obligatoire de mettre du texte apres ces marqueurs, vous
pouvez le faire. Ca peut étre une bréeve description du contenu de la Diapo, par
exemple. Dans ce cas, entrez votre description et tapez Entrée comme vous le feriez
normalement.

Si, par contre, vous ne souhaitez pas entrer de texte descriptif, vous allez rencontrer
une autre subtilité de LyX. LyX, comme la nature, a horreur du vide, et ne vous
laissera pas entamer un nouvel environnement de paragraphe si vous n’avez rien mis
dans le précédent. Vous ferez donc ainsi :

— Commencez a entrer le texte qui suivra le nouveau paragraphe Diapo, Surcouche,
Note, Texte_ Invisible ou Texte_ Visible.

— Placez-vous maintenant au début de ce paragraphe.

— Tapez ensuite Entrée.

— Changez enfin ce nouveau paragraphe vide en un Diapo, Surcouche, Note, Texte_ Invisible

ou Texte_Visible.

Espérons qu'une future version de LyX résoudra cette bizarrerie. . .
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6.8.4 Réaliser une présentation grace a Diapo, Surcouche et
Note

6.8.4.1 Utiliser I'’environnement Diapo

Si vous espérez apprendre dans cette section comment faire une présentation orale,
vous serez amerement décu. Naturellement, je vais vous décrire en quoi la classe slides
pourra vous aider a préparer les supports de la présentation. En revanche, le contenu
de celle-ci est entierement de votre ressort. (C’est ¢a aussi, la philosophie IyX !)

Sélectionnez 'environnement Diapo (de la maniere décrite a la section 6.8.3.2)
pour dire a IyX de commencer une nouvelle diapo (eh oui). Le marqueur pour
cet environnement / “pseudo-commande” est une “ligne ASCII” en bleu, suivie de
I'indication “NewSlide:”. Tout texte ou paragraphe qui suivra cette derniere fera
partie de la nouvelle diapo. C’est aussi simple que ca.

Les diapos sont stirement les seules fois dans LyX ou vous aurez a forcer la fin
des pages (vous pouvez toujours le faire dans Edition > Paramétres de Paragraphe). En
fait, vous devrez le faire une fois vous aurez fini d’entrer le contenu d’une diapo. Si
vous avez entré plus de texte qu'un transparent ne peut physiquement en contenir, le
surplus débordera sur une nouvelle diapo. Je vous déconseille de le faire, cependant,
car la diapo “de surplus” ne présentera aucun numéro de page. De plus, elle peut
interférer avec une Surcouche que vous aurez préparé pour accompagner la Diapo trop
remplie.

Les environnements Surcouche et Note fonctionnent comme ’environnement Di-
apo. Tous deux créent une “ligne ASCII” suivie par un marqueur (“NewOverlay:” et
“NewNote:”, respectivement). La couleur n’est plus le bleu, mais un magenta écla-
tant et la “ligne ASCII” se présente différemment, dans son style et sa longueur. Les
trois marqueurs different par leur police.

Comme pour 'environnement Diapo, si le contenu d’une Note ou d’une Surcouche
dépasse la taille physique d’un transparent ou d’une feuille de papier, le surplus
sera disposé sur une nouvelle page. A nouveau, je vous le déconseille, les Notes et
Surcouches n’auraient plus aucune utilité.

6.8.4.2 Utiliser des Surcouches avec des Diapos

L’idée d’une Surcouche est de créer une diapo qui vienne se superposer a une autre.
Vous pouvez vouloir présenter une figure sur la Diapo principale avant d’afficher le
texte qui va avec. Une fagon de faire est de poser une feuille de papier noire sur la
partie de la Diapo que vous souhaitez cacher. Cette méthode, cependant, n’est pas
valable si vous voulez par exemple superposer un graphique a un autre. Vous auriez
alors a vous bagarrer, tout en parlant, avec les deux Diapos pour que les graphiques
se superposent. L’utilisation des Surcouches rend les choses bien plus faciles.

Chaque Surcouche recoit le numéro de page de la Diapo “parent”; agrémenté d’un
"-a" 6  En effet, vous voulez que la Diapo et sa Surcouche paraissent n’en former

6. Des Surcouches multiples auront donc "-b", "-c", etc. accolé au numéro de page.
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plus qu’une ! Vous pouvez considérérer une Surcouche comme “faisant partie” d’une
Diapo. En fait, la classe slides le laisse voir : le marqueur qui débute un environnement
Surcouche est moins long que celui d’'une Diapo. Enfin, sur le document imprimé
apparaitront des marques d’alignement aux quatre coins de la Surcouche et de la
Diapo. Ces marques vous aideront a aligner les deux transparents.

Le principal probleme de la superposition de transparents est d’aligner les contenus
de ces diapos. Quel espace devez-vous laisser pour le graphique sur la deuxieme diapo
? Pire encore : que faire si sur le deuxiéme transparent vous voulez un graphique et
du texte, mais qu'une phrase du premier doit venir s’intercaler entre les deux ? Vous
pourriez essayer d’insérer un espace vertical de la bonne taille entre les deux, mais le
meilleur moyen est d’utiliser les environnements Texte_ Visible et Texte_ Invisible.

Comme leur nom l'indique, Texte_Visible et Texte_Invisible sont deux environ-
nements de paragraphe, qui rendent le texte respectivement visible et invisible. Re-
marquez a la section 6.8.3.2 que vous ne placez rien dans ces environnements. Lorsque
vous créez un Texte_|Invisible, [y/X insere un marqueur centré, bleu clair, indiquant
“ <Invisible Text Follows>". Les paragraphes suivant ce marqueur ne seront pas
affichés sur la diapo (ou la Surcouche), mais 'espace qu’ils auraient occupé sera laissé
vide.

Pour Texte_Visible, I’étiquette centrée sera “ <Visible Text Follows>", en vert. Les
paragraphes qui suivent cette étiquette se comporteront normalement. Remarquez
qu’au début d’une nouvelle Diapo, Note, ou Surcouche, la fonction Texte_ Invisible est
automatiquement désactivée. Il n’est donc pas nécessaire d’utiliser Texte_Visible a la
fin d’'une Diapo.

Maintenant, voyons comment utiliser les commandes Texte_ Visible et Texte_ Invisible
avec les environnements Diapo et Surcouche pour créer des diapos superposées :

1. Créez une Diapo (environnement Diapo) avec tout ce qui devra apparaitre au-
tant sur la Diapo elle-méme que sur les Surcouches.

2. Avant chaque figure ou paragraphe qui ne devra apparaitre que sur la Sur-
couche, insérez un environnement Texte_ Invisible. Si nécessaire, insérez un en-
vironnement Texte_Visible la ou le texte devra de nouveau apparaitre sur la
Diapo principale.

3. Commencez un environnement Surcouche juste apres I'environnement Diapo.
4. Copiez le contenu de I’environnement Diapo dans I’environnement Surcouche.

5. Dans la Surcouche, changez tous les Texte_ Invisible par des Texte_ Visible et vice
versa.

C’est bon, vous avez votre superposition.

Il reste un probléme avec la facon dont j’ai congu la classe slides de [y X : vous ne
pouvez pas rendre invisible du texte au milieu d'un paragraphe, ni rendre visible du
texte au milieu d’un paragraphe invisible. Pour ce faire, vous devrez insérer du code

BTEX 7.

7. Les commandes en question sont :
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6.8.4.3 Utiliser des Notes avec des Diapos

Comme une Surcouche, une Note est toujours associée a une Diapo “parent”. Ici
aussi, la classe slides de IyyX fournit des indices visuels. Le marqueur d’une Note est
magenta éclatant, comme celui d’'une Surcouche ; et en longueur, il est intermédiaire
entre celui d’une Diapo (qui est plus long) et celui d’'une Surcouche (qui est plus court).
De plus, une fois imprimée, une Note aura le numéro de page de sa Diapo “parent”
avec "-1" "-2" "-3" etc. accolé. Vous pouvez avoir plusieures Notes associées a
une seule Diapo, et, comme pour les Diapos et les Surcouches, vous voudrez stirement
couper les longues Notes de maniere a ce qu’elles tiennent sur une seule page.

L’utilité d'une Note est évidente : elle contient toute sortes d’informations que
vous voulez ajouter a propos d'une Diapo. Elle peut aussi servir d’aide-mémoire
pour une Diapo donnée. Dans ce dernier cas, vous serez peut-étre intéressé par les
marqueurs temporels. Actuellement, la classe slides de IyX ne supporte pas d’origine
les marqueurs temporels, qui sont une fonction SLITEX. Il faudra donc passer par le
code KTEX.

Pour utiliser des marqueurs temporels, spécifiez avant tout ’option supplémentaire
“clock” (voir la section 6.8.2). Cette option active les marqueurs temporels qui
apparaitront alors dans le coin inférieur gauche de toutes les Notes que vous générerez.
Pour choisir ce qui apparaitra dans ces indicateurs, utilisez les commandes KTEX
“\settime{}” et “\addtime{}”. Le parametre de chacune de ces commandes est un
temps mesuré en secondes. “\settime{}” sert a indiquer le temps voulu, tandis que
“\addtime{}” est utilisé pour ajouter une certaine durée. En utilisant les Notes et
les marqueurs temporels, vous pouvez vous rappeler combien de temps vous voulez
passer sur chaque Diapo.

Il reste une fonction a décrire. Vous voudrez forcément imprimer toutes vos Dia-
pos et Surcouches sur des transparents et toutes vos Notes sur des feuilles blanches.
Cependant, une Note doit suivre la Diapo a laquelle elle est associée. Comment faire
o

Heureusement il existe deux commandes ETEX qui vous permettent de sélection-
ner ce qu’il faut imprimer. Toutes deux doivent étre placées dans le préambule de
votre document. La commande “\onlyslides{\slides}” n’imprimera que les Dia-
pos et les Surcouches. De méme, la commande “\onlynotes{notes}” n’imprimera
que les Notes. Je vous conseille de mettre les deux commandes en commentaire dans
votre préambule et de “décommenter” celle dont vous avez besoin a I'impression. J’ai
I’habitude de : décommenter "\onlyslides{\slides}", imprimer dans un fichier
dont le nom contient "-slides", la recommenter et décommenter "\onlynotes{\notes}"
et imprimer dans un fichier "*-notes". Je peux ensuite envoyer I’'un ou l'autre fichier
a 'imprimante, en mettant des transparents ou des feuilles blanches selon le cas.

— {\invisible ...}
— {\visible ...}

et devront étre entrées en mode TEX. Le texte dont vous voulez changer la “visibilité” sera
a lintérieur des accolades, derriére la commande \invisible ou \visible. Si vous ne savez pas
comment entrer du TEX sous LyX, voyez la section appropriée dans le Guide de I’Utilisateur.
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Vous pouvez aussi donner d’autres parametres a “\onlyslides{}” et “\onlynotes{}”.
Reportez-vous a un bon livre sur IXTEX pour plus de détails.

6.8.5 Le fichier modele pour la classe slides

J’ai aussi créé un fichier modele, “slides.lyx” avec la classe slides. Pour l'utiliser,
créez votre document avec Fichier > Nouveau avec modele. Votre fichier de présentation
[yX contiendra un exemple du triplet Diapo — Surcouche — Note. De plus, la Diapo
et la Surcouche contiennent un exemple de Texte_Invisible et de Texte_Visible. Enfin,
le préambule contient :

% Uncomment to print out only slides and overlays®
T
%\onlyslides{\slides}

% Uncomment to print out only notes®
h
%\onlynotes{\notes}

Un dernier point : j’ai créé cette classe pour l'utilisation de la classe de I¥TEX 2¢
“émulation de SLITEX”. Ni moi ni le reste de 'Equipe LyX n’impose d’utiliser ou de
ne pas utiliser cette classe. Elle est la si vous en avez besoin. Il y a d’autres classes
de BTEX 2¢ pour créer des présentations, comme la classe Foils (cf. la section 6.7) ou
le paquetage seminar (présent sur certaines distributions TEX). Ce dernier n’est pas
encore supporté par IyX °. Je ne connais rien a ces classes. Essayez-les pour voir
quelles alternatives elles représentent.

6.9 Hollywood (scripts d’Hollywood)

par GARST REESE

6.9.1 Introduction

Maitriser le format d’un script d’Hollywood est un “rite de passage”. Ce format
est destiné a laisser le lecteur se concentrer sur le contenu et a étre facile a lire et
familier pour les acteurs. Chaque page d’un script doit représenter une minute de
film. Il n’y a rien dans le script qui ne soit pas visible ou audible a 1’écran. La police
courier 12 pt doit étre utilisée tout le long. Pas d’italiques.

8. NdT : Décommentez pour n’imprimer que les diapos et les sur-couches
9. NdT : Décommentez pour n’imprimer que les notes
10. Si vous voulez vous y mettre...
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6.9.2 Problemes particuliers

Les lignes de dialogue ne doivent JAMAIS étre coupées au milieu d’une phrase. Si
le texte d'un personnage ! franchit un saut de page, repétez le nom du personnage
suivi de (Cont’d) 2.

6.9.3 Fonctions particulieres

Entrez les noms des personnages comme étiquettes, puis faites des références croisées
sur ces étiquettes pour insérer le nom. La fenétre de référence croisée montrera
I’ensemble des personnages. Vous pouvez utiliser cette méthode également pour in-
sérer le nom d’'un personnage dans les parties narratives.

6.9.4 Taille de papier et marges
USLetter, gauche 1,6 in, droite 0,75 in, haut 0,5 in, bas 0,75 in.

6.9.5 Environnements

Les environnements suivants sont disponibles. Vous pouvez utiliser hollywood.bind
pour accéder aux touches de raccourci indiquées a droite.

— Standard
Quand rien d’autre ne convient. Essayez de I'éviter.

— FADE_IN (Fondu'3): M-z S5-I
Suivi en général de quelque chose comme “sur Sally qui se leve”.

— INT : M-z i

Introduit une nouvelle séquence INTERIEUR. Toujours suivi par JOUR ou
NUIT, ou quelque chose d’approchant pour définir 1’éclairage nécessaire. Toute
cette ligne en MAJUSCULES.

— EXT : M-z e
Introduit une nouvelle séquence EXTERIEUR. Toute cette ligne en MAJUS-
CULES.

— Speaker M-z s

Le personnage qui parle.

— Parenthetical M-z p
Instructions au personnage intervenant. Les () sont insérées automatiquement.

— Dialogue M-z d
Ce qui dit le personnage.

11. NdT : Speaker
12. NdT : (suite)
13. NdT : Incertain.
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— Transition M-z t
Instruction de mouvement de caméra.

— FADE OUT: M-z S-I

— Auteur M-z S-A

— Titre M-z S-T

— Right_Address M-z r

6.9.6 Jargon de script

— (0.S) — off screen (hors écran)
— (V.O) — voice over (voix off)

— b.g. — background (arriere-plan)
— C.U. — close-up (plan rapproché)
— PAN — mouvement de caméra

— INSERT - insérez un plan rapproché

6.10 ijmpc et ijmpd

par PANAYOTIS PAPASOTIRIOU

6.10.1 En résumé

Le paquetage ijmpc est un jeu de macros pour faciliter les soumissions élec-
troniques de manuscrits a 1’ International Journal of Modern Physics C publié par
World Scientific. De la méme maniere ijmpd est destiné a des manuscrits soumis a
I"International Journal of Modern Physics D. Les classes de document s’appellent
respectivement ws-ijmpc.cls et ws-ijmpd.cls. Vous pouvez télécharger ce fichier,
ainsi que des recommandations aux auteurs, sur les sites http://www.worldscinet.
com/ijmpc/mkt/guidelines.shtml et http://www.worldscinet.com/ijmpd/mkt/
guidelines.shtml. Ces deux paquetages sont des versions modifiées du paquetage
standard “article”, et ils sont presques identiques (mais pas tout a fait). LyX sait
gérer la plupart de leurs fonctions. J’ai utilisé Ly X avec succes pour écrire des articles
soumis a ces deux journaux.

6.10.2 Ecrire un papier

Comme d’habitude, la facon la plus simple d’écrire un papier est de commencer par
un modele. Faites Fichier>Nouveau avec Modeéle, et choisissez le modele ijmpc.lyx
ou le modele ijmpd.1lyx. Ca vous donnera un document (presque) vide comprenant
les parties les plus courantes d’'un manuscrit. Vous n’avez qu’a écrire votre texte par
dessus le texte existant (en effacant aussi les crochets <>). Veuillez juste garder ce
qui suit présent a l’esprit.
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6.10 ijmpc et ijmpd

1. Iy X ne vous laissera pas changer la taille de police ni la mise en page du
document, car les deux paquetage ne permettent pas de telles modifications.

2. La langue du document ne doit pas étre modifiée. Avant de visionner votre pa-
pier, assurez-vous que vous n’utilisez pas le paquetage babel. Pour cela, faites
Documentst> Paramétres > Langue et sélectionnez Aucun en tant que Paquetage
linguistique.

3. Le style “Mots clés” doit étre utilisé pour définir les mots clés.

4. Le paquetage ijmpc fournit un style nommé “Code de classification”; qui peut
étre utilisé pour définir des codes de clasification comme les numéros PACS.
Notez que cette fonction n’est pas disponible dans le paquetage ijmpd.

5. Plusieurs nouveaux environnements sont disponibles : “Définition”, “Etape”,
“Exemple”, “Remarque”, “Notation”, “Théoreme”, “Preuve”, “Corollaire”, “Lemme”,
“Proposition”, “Prop”, “Question”, “Affirmation” et “Conjecture”. Leur utili-
sation est plus ou moins évidente. Ly X gere tous ces environnements ; il utilisera
I’étiquette, le style de texte, et le schéma de numérotation qui convient pour

chacun d’eux.

6. Les deux paquetages utilisent des citations de base ; on ne doit pas utiliser
le paquetage natbib. Dans [yX, les citations s’affichent comme d’habitude ;
dans la sortie, les citations apparaissent comme des exposants. Si vous voulez
utiliser une citation en texte normal, vous devez utiliser la commande refcite,
par exemple “See Ref. \refcite{clé}" 4.

7. Il n'y a pas de section “Remerciements” dans les deux paquetages, utilisez

simplement l’environnement “Section*”.

8. Vous pouvez ajouter des annexes au papier, apres les remerciements et avant les
Références. IyX propose un marqueur spécial, via Document > Début annexe(s)
ici qui indique le début des annexes. Dans IyX, le mot “Annexes” apparait
en lettres rouges, comme indication que toutes les sections qui suivent ce point
sont des annexes, elles-mémes encapsulées dans une zone encadrée en rouge.
Pour écrire une annexe, créez simplement une section dans cette zone (le style
“Annexe” fait la méme chose, il avait été créé dans les formats ijmp a une
époque ou la fonctionnalité de création d’annexe était différente; vous pouvez
Iignorer). Une annexe peut contenir des SousSections et SousSousSections.

9. Les paquetages ijmpc et ijmpd utilisent la commande tbl pour les légendes
des tableaux. La conséquence en est qu'un tableau créé avec Iy X est affiché
correctement, mais sans sa légende. Cependant, vous pouvez utiliser un peu
de code TEX pour contourner ce probleme, de facon a ce que les légendes
s’impriment comme prévu. Pour le faire, créez un flottant de tableau comme
d’habitude, effacez la légende, et remplacez la par le code KTEX \tbl{votre
légende de tableau}{ (sic) ; vous devez ensuite mettre le code KTEX } im-
médiatement aprés votre tableau. Etudiez Pexemple de tableau qui est inclus

14. Je ne traduis pas, vu que c’est un journal en anglais (NdT).

65



6 Classes de document spéciales

dans le fichier modele pour voir comme cette astuce est utilisée. Une autre
solution, si vous avez besoin de légendes de tableaux, est de construire tout le
tableau dans un fichier .tex, puis inclure celui-ci dans le document LyX (par
Insertion > Fichier > Sous-document). Vous pouvez trouver des consignes pour la
création d’un tableau flottant dans les fichier ws-1ijmpc.tex et ws-ijmpd. tex,
qui se trouve dans la distribution des paquetages correspondants.

6.10.3 Préparer un papier avant de le soumettre

Avant de soumettre votre papier vous devez exporter le document Iy X en tant que
fichier IXTEX (Fichier > Exporter > IATEX), puis modifier le fichier .tex exporté comme
suit 19

1. Enlevez les lignes de commentaires avant la commande \documentclass.

2. Enlevez tout ce qui se trouve entre les commandes \makeatletter et \makeatother
comprises, sauf les commandes que vous avez vous-méme ajoutées dans le

préambule KTEX.

Vous devez maintenant sauvegarder le fichier .tex ainsi modifié, et lancer KTEX
dessus autant de fois que nécessaire. Vous pouvez alors controler I'aspect du docu-
ment .dvi correspondant.

6.11 iopart

par UWE STOHR

6.11.1 En résumé

Le paquetage iopart fournit une classe de document pour créer un manuscrit
adapté pour une soumission électronique a un des journaux publiés par 'loP (Institute
of Physics). Les instructions aux auteurs pour créer un papier en utilisant la classe
iopart peuvent étre téléchargées en méme temps que le paquetage iopart a partir du
site ftp://ftp.iop.org/pub/journals/latex2e.

6.11.2 Ecrire un papier

La maniere la plus simple pour écrire un papier est de commencer avec le mod-
ele IOP-article.lyz qui est disponible via Fichier>Nouveau avec Modéle. Le modele
explique comment utiliser les environnements spéciaux. Voici les conseils les plus
importants :

15. En fait, vous avez le choix entre IXTEX (standard) et KTEX (pdflatex). Si vous prévoyez
d’utiliser pdflatex pour préparer votre papier, vous devez utiliser I'option pdflatex pour que les
graphiques soient convertis au format PDF, préts a étre utilisés par pdflatex.
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6.12 Kluwer

— Pour pouvoir compiler votre document en PDF, PS ou DVI, vérifiez qu’aucun
paquetage AMS n’est chargé dans Document > Paramétres> Option mode math!

— L’environnement de titre définit le type de document. Vous devez donc utiliser
un des environnements suivants pour le titre :

— Titre pour un papier (Paper)

— Review pour une revue (Review)

— Topical pour une revue thématique (Topical review)
— Commentaire pour un commentaire (Comment)

— Note pour une note

— Paper pour un papier ( comme titre)

— CommPrelim pour une communication préliminaire
— CommRapid pour une communication rapide

— Lettre pour une lettre aux éditeurs (Letter)

— Tous les environnements de titre, sauf Lettre, peuvent avoir un titre court fac-
ultatif.

— Il y a un environnement de titre général Article qui n’est pas géré par IyX. Il
peut étre utilisé en code TEX si votre document ne correspond pas a 1'un des
autres types de titres.

Pour plus d’information comme des astuces pour des mises en formes spéciales pour
les tableaux et les formules, voyez les instructions aux auteurs de 1'IoP.

6.12 Kluwer

par PANAYOTIS PAPASOTIRIOU

6.12.1 En résumé

Le paquetage Kluwer est un jeu de macros produit par les éditions Kluwer Aca-
demic Publishers, qui permet de soumettre sous format électronique des manuscrits
destinés a leurs publications. Les plus connues d’entre elles (au moins dans mon
domaine d’intérét) sont Astrophysics and Space Science et Solar Physics, mais il
y en a beaucoup d’autres (voyez la liste compléte a l'adresse http://www.wkap.
nl/jrnllist.htm/JRNLHOME). On peut télécharger le paquetage Kluwer sur le site
http://www.wkap.nl/kaphtml.htm/STYLEFILES. Ce paquetage contient un guide
de l'utilisateur complet (qui peut également étre téléchargé séparément).

LyX supporte de nombreuses fonctions de ce paquetage mais pas tout. Cepen-
dant, le Texte Rouge nécessaire se résume a quelques commandes “particulieres” du
paquetage (voir 6.12.4). J’ai récemment utilisé [y’ X pour écrire un article soumis a
Astrophysics and Space Science sans aucun probléme.
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6.12.2 Ecrire un papier

La facon la plus simple d’écrire un papier est de partir du fichier modele Kluwer.
Faites Fichier>Nouveau avec Modéle, et choisissez kluwer.lyx. Ca vous donnera un
document (presque) vide qui comprend les champs les plus couramment utilisés dans
un manuscrit avec une courte description de leur emploi. Comme dans la plupart des
modeles, vous n’avez qu’a remplacer le texte existant (y compris les crochets, <>) par
I'information correcte.

6.12.3 Préparer un papier avant de le soumettre

Comme pour le paquetage AASTEX, avant de soumettre votre papier a la publica-

tion, vous devez le “post-traiter” comme suit.

1. Exportez votre papier comme fichier IfTEX. Pour cela, faites Fichier> Exporter>

LaTeX.

. Editez avec un éditeur de texte le fichier .tex obtenu, et faites les changements

suivants
a) enlevez les lignes de commentaire avant la commande \documentclass,

b) enlevez tout ce qui se trouve entre les commandes \makeatletter et

\makeatother comprises, sauf celles que vous avez explicitement incluses
dans le préambule IXTEX.

Enregistrez le fichier .tex obtenu.

. Lancez I¥TEX sur ce fichier .tex autant de fois que nécessaire (d’habitude

jusqu’a trois fois).

. Visualisez le document .dvi obtenu avec, par exemple, xdvi, et vérifiez si tout

va bien (ce qui devrait étre le cas si vous n’avez pas fait d’erreur).

6.12.4 “Particularités” du paquetage Kluwer

Le paquetage Kluwer présente les “particularités” suivantes.

1. 11 est possible d’écrire plusieurs articles dans le méme fichier ITEX 6. Chaque

article doit étre compris dans I’environnement “article”. Malheureusement, cet
environnement ne peut pas étre omis, méme si vous n’écrivez qu'un seul article.
Ainsi, chaque article commence par la commande \begin{article} et, bien
stir, se termine par la commande \end{article}. Bien que cela puisse étre
implémenté dans Ly X, je ne l'ai pas fait car ce n’est pas beau, et peut préter a
confusion pour 'utilisateur novice. Vous devez donc les entrer directement et
les marquer comme code BKTEX (le fameux “Texte Rouge”).

. L’information donnée au début de l'article (c’est-a-dire le titre, le sous-titre,

I’auteur, l'institution, le titre courant, ’auteur courant, I’abstract et les mots-
clés) doit étre comprise dans un environnement appelé “opening”. Ce n’est pas

16. Je ne vois aucune bonne raison de le faire.
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implémenté dans IyX, vous devez donc entrer le titre, le sous-titre, etc. entre
deux lignes de Texte Rouge (\begin{opening} et \end{opening}).

3. D’apres le manuel utilisateur, 1’étiquette de chaque élément de bibliographie
doit étre écrite ainsi : \protect\citeauthoryear{auteur(s)}{année}.

Le modele kluwer.lyx tient compte de toutes ces “particularités”. Si vous com-
mencez un nouveau papier a partir de ce modele vous n’aurez rien besoin de faire de
spécial. Simplement

1. n’effacez pas le code TEX qui se trouve dans le modele, et

2. pour entrer de nouveaux éléments de bibliographie, copiez I'exemple d’élément
fourni et modifiez-le.

6.13 Koma-Script

par BERND RELLERMEYER

6.13.1 En résumé

Les classes de document IxX article (koma-script), report (koma-script), book
(koma-script), et letter (koma-script) correspondent respectivement aux classes TEX
scrartcl.cls, scrreprt.cls, scrbook.cls et scrlettr.cls, de la famille Koma-
Script. Elles forment des alternatives aux classes standard, respectivement article.cls,
report.cls, book.cls et letter.cls et sont plus proches des conventions typographiques
européennes en un certain nombre de points :

— la taille de caractere standard est de 11 pt dans article (koma-script), report
(koma-script), et book (koma-script), et de 12 pt dans letter (koma-script);

— les en-tétes, les marqueurs de I'environnement Description et d’autres éléments
de la classe letter (koma-script) sont en police grasse sans empattement 7. La
numérotation des en-tétes de chapitre est rendue de la méme maniere que celle
des en-tétes de section, c’est-a-dire sans la ligne supplémentaire “Chapitre...”.
En outre, 'apparence des en-tétes peut étre modifiée par un certain nombre
d’options (a entrer dans le champ Options de la fenétre Document > Paramétres>
Classe de document). Une description détaillée de ces options, en allemand, est
disponible dans le scrguide de la documentation Koma-script !®.;

— la principale méthode utilisée dans les classes de cocuments pour modifier le
type sont les options BCOR et DIV ( dans LyX elles doivent étre entrées dans
le champ d’Options du dialogue Document > Paramétres> Classe de document).

17. Il y a une grande différence entre les anciennes polices cm grasses sans empattement et les
nouvelles polices ec, particulierement pour les en-tétes. En comparaison, les polices grasses sans
empattement ec semblent un peu plus fines. Le paquetage IMTEX cmsd.sty de WALTER SCHMIDT
permet de reproduire ’apparence “habituelle”, tout en utilisant les polices ec.

18. La version en anglais est le scrguien.
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Elles permettent une modification plus claire des marges de page que celle du
dialogue Document>Parameétres. Une description détaillée de ces options, en
allemand, est disponible dans le scrguide de la documentation Koma-script;

— les classes de document IXTEX de la famille Koma-Script définissent un cer-
tain nombre de commandes supplémentaires. Celles d’entre elles qui ont une
signification dans LyX sont implémentées par des types de paragraphes y cor-
respondant.

Une description détaillée, en allemand, des classes de document IXTEX de la famille
Koma-Script se trouve dans le scrguide de la documentation Koma-Script'?. Les
sections qui suivent décrivent seulement les aspects de ces classes qui ont un sens
dans LyX.

6.13.2 article (koma-script), report (koma-script), et book
(koma-script)

Les classes de document article (koma-script), report (koma-script) et book (koma-
script) sont implémentées respectivement dans les fichiers de format scrartcl.layout,
scrreprt.layout et scrbook.layout. Ils contiennent tous les types de paragraphe
correspondant aux classes standard respectives article, report, et book mais partielle-
ment modifiés, a 'exception du type Liste, spécifique a IyyX, qui est remplacé par le
nouveau type Marquage (Labeling) qui a les mémes fonctions. En plus du type Mar-
quage, il y d’autres nouveaux types de paragraphe. Ceux-ci cependant n’apparaissent
pas dans la classe letter (koma-script).

— AjoutPartie (AddPart), AjoutChap (Addchap), AjoutSec (Addsec) : sont les
équivalents respectifs de Partie*, Chapter* et Section*, ajoutant de plus une
entrée dans la table des matieres. AjoutPartie et AjoutChap n’existent pas dans
article (koma-script).

— AjoutChap*, AjoutSec* : ont le méme role que, respectivement AjoutChap et
AjoutSec, mais sans indiquer de numéro de chapitre ou de section. AjoutChap*
n’est pas disponible dans article (koma-script)®.

— MiniSec : génere un en-téte écrit avec des caracteres de taille standard, juste
au-dessus du paragraphe suivant et sans modifier la structure du document.

— Légende_Dessus (Captionabove) et Légende_Dessous (Captionbelow) : sont des
légendes spéciales qui respectent les différents réglages d’espacement néces-
saires pour des légendes placées au-dessus ou au-dessous d’'un élément (si vous
suivez strictement les regles typographiques, vous mettez toujours les légen-
des au-dessus des tableaux). Vous pouvez aussi utiliser l'option de classe
tablecaptionsabove, qui transformera Légende en Légende_Dessus pour les

19. Il y en a une traduction en anglais, incompleéte, screnggu.
20. Il y a aussi une commande \addpart* dans book (koma-script) et dans report (koma-script),
mais comme elle fait la méme chose que Partie*, elle n’a pas été implémentée dans LyX.
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tableaux et en Légende_Dessous pour les figures. Il vous faut au minimum
Koma-Script version 2.8q pour avoir cette fonction.

— Dicton (Dictum) : sert a mettre une citation ou un proverbe, par exemple au
début d’un chapitre. Si vous utilisez le parametre optionnel (Insertion > Auteur
du dicton), vous pouvez y mettre 'auteur du dicton. Dicton et auteur sont
séparés par une ligne. Il vous faut au minimum Koma-Script version 2.8q.
Maxime n’est pas présent dans article (koma-script).

Les types qui sont présentés ci-dessous forment en compagnie des types Titre, Auteur
et Date, la zone de titre du document. Ils doivent étre entrés au-dessus du pre-
mier paragraphe “normal”?!. Lorsqu’'un tel type est utilisé plusieurs fois, la derniére
instance annule les précédentes, donc pour chaque type, seule compte la derniére oc-
currence. L’ordre des différents types n’a, lui, aucune importance, tout comme celui
des Titre, Auteur et Date.

— Sujet (Subject) : introduit au-dessus du titre ordinaire (Titre, Auteur, Date) un
paragraphe centré pour indiquer le sujet du document.

— Editeurs (Publishers) : introduit au-dessous du titre ordinaire (Titre, Auteur,
Date) un paragraphe centré indiquant le nom de ’éditeur.

— Dédicace (Dedication) : dans report (koma-script) et book (koma-script), dis-
pose un paragraphe centré, sur une page a part apres la page de titre, pour la
dédicace. Dans article (koma-script), dispose un paragraphe centré, en-dessous
du titre normal (Titre, Auteur, Date, Editeurs) pour la dédicace.

— En-téte_Titre (Titlehead) : produit un paragraphe aligné a gauche au-dessus
du titre normal (Titre, Auteur, Date, Sujet) pour un en-téte de document.

— Verso_Titre_Haut (Uppertitleback) : dans un document report (koma-script)
imprimé recto-verso, dispose un paragraphe aligné a gauche, en haut du verso
de la page de titre. N’a aucun effet dans un document imprimé en recto seul ni
dans article (koma-script).

— Verso_Titre_Bas (Lowertitleback) : dans un document report (koma-script)
imprimé recto-verso, dispose un paragraphe aligné a gauche, en bas du verso
de la page de titre. N’a aucun effet dans un document imprimé en recto seul ni
dans article (koma-script).

— Titre_Suppl. (Extratitle) : introduit une page “moche” qui précede le document
réel, comprenant un paragraphe sans formatage spécial.

Les fichiers de configuration correspondant aux classes article (koma-script), report
(koma-script), et book (koma-script) comprennent le fichier scrmacros.inc. Clest la
que vous définirez vos propres types. Copiez scrmacros.inc dans votre répertoire
personnel de formats, et éditez-le !

21. Les commandes ITEX correspondantes doivent apparaitre avant la commande \maketitle.
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6.13.3 letter (koma-script)

Nota: Cette décrit la classe obsolete KOMA-Script-Letter (v. 1), qui n’est méme plus
incluse dans les publications KOMA récentes. Voyez plutot la section suivante
pour la classe courante KOMA-Script-Letter (v. 2)!

La classe de document letter (koma-script) est implémentée dans le fichier scrlettr.layout.
Elle contient tous les paragraphes de la classe standard [letter correspondante, par-
tiellement modifiés, a l'exception des types LyX-Code, Commentaire et Liste, spéci-
fiques a LyX et qui sont remplacés par le nouveau type Marquage. En plus par
rapport a la classe standard, elle contient les types connus Citation, Cite, et Vers. En

outre, il y a un certain nombre de nouveaux types spécifiques aux lettres.

L’apparence de la lettre produite par cette classe de document peut-étre controlée
par des commandes ITEX que vous pouvez insérer dans le préambule du document 22.
Une description détaillée de ces commandes se trouve en langue allemande dans la
documentation de Koma-Script scrguide. Grace a elles, 'auteur de la lettre peut
créer son propre format.

Les types Lettre et Ouverture définissent le début de la lettre et doivent étre présents
dans toute lettre. Pour les identifier dans X, les lettres L et O apparaissent dans la
marge. Il est possible d’écrire plusieurs lettres en un seul fichier. Un type Ouverture
provoque le passage a une nouvelle lettre au méme destinataire, et le type Lettre
permet de changer de destinataire. Les types Fermeture, PS, CC et P.J. sont des
types de paragraphe ordinaires et peuvent aussi étre utilisés plusieurs fois dans une
méme lettre.

— Lettre (Letter) : introduit un paragraphe pour le destinataire et définit im-
plicitement le début d’une lettre.

— Ouverture (Opening) : introduit un paragraphe pour la formule de politesse
initiale et produit implicitement une nouvelle lettre.

— Fermeture (Closing) : introduit un paragraphe pour la formule de politesse
finale.

— PS : introduit un post-scriptum.
— CC : introduit un paragraphe pour les co-destinataires.
— P.J. (Encl) : introduit un paragraphe pour les piéces jointes.

Les types Nom, Signature, Adresse, Téléphone, Lieu, Adresse_ Retour, Courrier_Spécial,
Emplacement, Titre, et Sujet sont des types qui présentent une invite et qui servent
a entrer des renseignements qui seront utilisés par la classe de document. Nous

22. On obtient un en-téte “ordinaire”, comportant le nom et 1’adresse, avec les commandes IXTEX
suivantes dans le préambule :

\firsthead{\parbox[b]{\textwidth}

{\ignorespaces \fromname\\ \ignorespaces \fromaddress}}
\nexthead{\parbox [b] {\textwidth}

{\ignorespaces \fromname \hfill \ignorespaces \pagename\ \thepagel}}
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72324 (Ces types doivent étre présents avant le type

les appellerons “types a invite
Ouverture correspondant.

Une implantation de ces types dans une logique WYSIWYG n’aurait pas de sens,
car l'aspect réel de la lettre produite ne dépendra pas seulement de 1'utilisation d’un
type donné, mais aussi d’autres facteurs. Par exemple, dans le comportement par dé-
faut, une signature entrée avec le type Signature n’apparaitra dans la lettre que si celle-
ci contient aussi le type Fermeture. La valeur indiquée pour Téléphone n’apparaitra
méme pas dans la lettre. Nous avons déja signalé plus haut la possibilité de décrire
son propre environnement de lettre.

Les types a invite peuvent étre utilisés comme des paragraphes vides. Cela a un
sens par exemple pour le type Signature : si ce type n’est pas présent du tout, c’est
par défaut la valeur spécifiée dans Name qui est prise comme signature, tandis que si
I’on utilise un paragraphe Signature vide, il n’y a réellement pas de signature spécifiée.

Il est possible en utilisant ces types a invite de créer un patron de lettre contenant
des types pré-remplis avec vos coordonnées personnelles (nom, adresse, etc.) et des
types vides pour d’autres données que vous entrerez.

— Nom (Name) : nom de 'expéditeur. Par défaut, apparait comme un paragraphe
centré, en petites majuscules, dans I'en-téte de la lettre.

— Signature : signature de 'expéditeur. Par défaut, apparait en dessous du type
Fermeture. Si le type Signature est absent, c’est la valeur du type Nom qui
apparait.

— Adresse (Address) : adresse de l'expéditeur. Par défaut, apparait dans un
paragraphe centré, dans I'en-téte de la lettre, en dessous du nom de I'expéditeur.

— Téléphone (Telephone) : numéro de téléphone de 'expéditeur. Par défaut,
correspond a la variable \telephonenum de KTEX.

— Lieu (Place) : lieu d’écriture de la lettre.

— Date : date d’écriture de la lettre. Lieu et Date disposent par défaut le lieu et la
date sur une ligne alignée a droite, en dessous du destinataire. Si le paragraphe
Date est vide, ni date, ni lieu n’apparaissent, et ce quelle que soit la valeur de
Lieu. S’il n’y a pas de paragraphe Date, la date du jour est utilisée.

— Adresse_Retour (Backaddress) : adresse pour le retour du courrier. Par défaut,
apparait au-dessus du destinataire, en petits caracteres sans empattement.

— Courrier_Spécial (Specialmail) : informations spéciales sur le courrier. Par dé-
faut, apparait souligné au-dessus du destinataire, en dessous de 'adresse de
retour du courrier.

— Emplacement (Location) : informations supplémentaires. Par défaut, apparait
a droite en dessous du champ du destinataire.

23. NdT : Mais si quelqu’un a une meilleure idée pour traduire “input type”, je ne dis pas non.

24. On pourrait considérer que les types Letter et Opening devraient étre des types a invite.
Cependant, a cause de la signification particuliere de ces types, je les ai implémentés comme des
types de paragraphe ordinaires marqués d’une lettre dans la marge. En plus, cela choquerait mon
sens de la symétrie si les types Opening et Closing avaient une apparence tres différente.
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— Titre : le titre de la lettre. par défaut, apparait en grands caracteres gras sans
empattement, au-dessus du sujet.

— Sujet : le sujet de la lettre. Par défaut, apparalt en caracteres gras au-dessus
du paragraphe Ouverture.

Les types Votre_réf, Votre_courrier, Notre_réf, Client et Facture générent comme dans
les lettres commerciales, au-dessus de la ligne de titre, une ligne qui contient les
champs “Votre réf”, “Votre courrier du”, “Notre réf.”, “Numéro de Client”, “Numéro
de Facture” et “Date”. Pour le champ “Date”, LyX reprend la valeur donnée dans
Date. Si I'un quelconque de ces types “pour lettre commerciale” est utilisé, la valeur
donnée pour Place n’apparaitra pas, seule est définie la variable KTEX \fromplace.
L’affichage normal du lieu et de la date (une ligne alignée a droite sous le champ
du destinataire) est supprimée. Les types sont implémentés comme des types a
invite, avec les invites correspondantes, et doivent étre utilisés avant le type Ouverture
correspondant.

— Votre_réf (Yourref) : Votre référence

— Votre_courrier (Yourmail) : Votre courrier du
— Notre_réf (Myref) : Notre référence

— Client (Customer) : Numéro de client

— Facture (Invoice) : Numéro de facture

6.13.4 La nouvelle classe lettre : letter (koma-script v.2)
par JURGEN SPITZMULLER

Koma-Script version 2.8 a introduit une nouvelle classe de lettres scrlttr2 qui
remplace scrlettr, désormais périmée. Elle a — du coté IXTEX — une interface com-
pletement nouvelle et n’est pas compatible avec I'ancienne classe. LyX supporte les
deux, mais il est recommandé d’utiliser la nouvelle.

Cette classe recouvre les mémes fonctionnalités que letter (koma-script), plus quelques
autres. Les éléments de base sont Adresse (adresse du destinataire, comme Lettre
dans le précédent format), Ouverture et Fermeture. Adresse_Suivante (NextAddress)
démarre une nouvelle lettre (vous pouvez donc écrire plusieurs lettres dans un méme
document). Les nouveaux éléments concernent 1'expéditeur, ce sont : E-Mail, URL,
Fax, Banque et la possibilité de mettre un Logo (par Insertion> Graphique) dans Ien-
téte.

La plus grande amélioration est la possibilité de configurer la mise en page de la
lettre pour s’adapter a presque tous les besoins, soit dans le préambule (Document>
Paramétres...) soit avec un fichier de style spécial (Option de la Classe Lettre,
d’extension .1co), qui sera lu comme une option de classe?. Jetez donc un ceil

25. Le paquetage KOMA est livré avec quelques fichiers .1co par défaut. Il y a par exemple
un fichier DIN.1co qui suit les régles typographiques allemandes, et un KOMAold.lco qui permet
de retrouver la mise en page par défaut de ’ancienne classe scrlettr. Vous pouvez charger cette
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sur le modele koma-letter?2 fourni avec LyX, qui vous donnera des exemples. Vous
trouverez une description détaillée dans la documentation de Koma-Script (scrquide).

6.13.5 Problémes

Avec IyX, la visualisation d’'un document de classe Koma-Script peut poser quelques
problemes :

— le numéro de chapitre pour un type Chapitre apparait sur une ligne a part,
au-dessus de l'en-téte de chapitre, au lieu d’étre sur la méme ligne juste avant.
C’est causé par le comportement interne de LyX face au marqueur de type
Counter__Chapter dans le fichier de format;

— les en-tétes des types AjoutChap et AjoutSec sont uniquement dans la “vraie”
table des matieres IXTEX, et pas dans la table des matieres Iy X (Document >
Plan);

— les paragraphes avec la classe de document letter apparaissent séparés par de
I'interligne supplémentaire, et non par une indentation. C’est le comportement
par défaut, qui se passe de commande IXTEX spécifique. Mais dans la fenétre
Document > Paramétres le bouton a cocher correspondant indique Indentation.
Cocher Interligne insére toujours des commandes IXTEX supplémentaires dans
le document pour causer cet espacement, ce qui ne serait pas le comportement
désiré dans ce cas.

6.14 Article (mwart), book (mwbk) and report
(mwrep)

par TOMASZ LUCZAK

Les classes de document ILyX article (mwart), report (mwrep) et book (mwbk)
correspondent aux classes de document KTEX mwart.cls, mwrep.cls et mwbk.cls
respectivement. Elles remplacent les classes de document standard article.cls,
report.cls et book.cls et sont mieux adaptées en bien des aspects aux conventions
typographiques polonaises.

Les différences principales sont :

— Les titres non numérotés (avec une étoile, comme Section*) sont présents dans
la table des matieres.

— Des styles de mise en page supplémentaires :
uheadings en-tétes sur plusieurs lignes,

myheadings en-tétes personnalisés, définis par les commandes \markright et
\markboth,

derniére avec 'option de classe KOMAold, mise dans le champ Options dans Document > Paramétres>
Classe de document.
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myuheadings en-tétes personnalisés sur plusieurs lignes
outer le numéro de page est placé du coté extérieur de la page
— Options
rmheadings titres avec empattement — par défaut,
sfheadings titres sans empattement,
authortitle sur la page de titre, d’abord 'auteur puis le titre — par défaut,
titleauthor sur la page de titre, d’abord le titre puis 'auteur,

withmarginpar réserver de la place sur la page pour les marges.

6.15 Memoir

Par JURGEN SPITZMULLER

6.15.1 Introduction

Memoir est une classe tres puissante et en constante évolution. Elle a été congue
pour la littérature de fiction comme de non-fiction. Son but est de donner a 1'utilisateur
le maximum de contréle sur la mise en forme de son document. Memoir est basée sur
la classe standard book, mais elle peut aussi émuler la classe article (voir plus loin).

PETER WILSON, le développeur de Memoir est connu comme ’auteur de nombreux
et utiles paquetages dans le monde I¥TEX . La plupart ont été rassemblés avec
Memoir. Il est donc beaucoup plus facile de mettre en forme la table des matieres, les
annexes, les chapitres et autres. LyX, ne gere pas de fagon native la plupart de ces
fonctionnalités. Quelque-unes pourront étre ajoutées dans de prochaines versions 2°,
beaucoup ne le seront probablement jamais, a cause des limitations de la structure de
LyX. Bien siir, vous pouvez quand méme utiliser toutes les fonctions avec 1'aide de
quelques commandes BTREX (en code TEX 27 ). Dans cette section, nous ne listerons
que les fonctions qui sont gérées par LyX de fagon native. Pour une description
détaillée (et pour le reste des fonctions) nous recommandons de jeter un ceil au
manuel détaillé de la classe Memoir 2%, qui est non seulement un manuel de 1'utilisateur
de la classe, mais aussi a la fois une description compléete de la bonne maniere de
typographier et un superbe exemple de bonne typographie en lui-méme.

6.15.2 Fonctions de base et restrictions

A la base, Memoir accepte toutes les fonctions de la classe standard book. Il y a
pourtant quelques différences, comme celles qui suivent :

26. Vous étes invités a faire des suggestions a lyx-devel@lists.lyx.org.
27. Voir la section 2.3 pour plus de détails.
28. Voir CTAN: /macros/latex/memoir/memman.pdf.
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6.15 Memoir

Taille des polices : memoir a une gamme plus large de taille de polices : 9, 10, 11,
12, 14, 17

Style de page : le style de page “sophistiqué” n’est pas géré, a cause d’un conflit
de commandes entre Memoir et le paquetage fancyhdr (ils définissent tous les
deux une commande avec le méme nom, ce qui perturbe KTEX). A la place,
Memoir est fourni avec un paquet de ses propres styles de pages (voir Docu-
ment > Paramétres > Format de la page). Si vous voulez les utiliser pour les pages
de chapitre, vous devez utiiser la commande \chapterstyle dans le corps du
texte ou dans le préambule (par exemple \chapterstyle{companion}).

Sectionnement : les sections (chapitres, sections, sous-sections etc.) ont un parametre
facultatif dans les classes standard. Avec ce dernier, vous pouvez donner une
version alternative du titre pour la table des matiére et les entétes (par exemple,
quand le titre est trop long). Dans IyX, vous pouvez le faire avec Insertion>
Titre court au début de la section/chapitre. Memoir a un deuxiéme parametre
facultatif qui permet de séparer la table des matieres et les entétes. Vous pou-
vez donc définir trois variantes d’un titre : un pour le corps du texte, un pour
la table des matieres et un pour les entétes. LyX rend ceux-ci accessibles via
des variantes particulieres de Titre court dans le menu Insertion.

TdM/LdT/LdF : dans les classes standard (et dans beaucoup d’autres classes), la
table des matieres, la liste des tableaux et la liste des figures commencent
automatiquement une novelle page. Memoir ne suit pas cette regle. Vous devez
insérer un saut de page vous-méme, si vous en voulez un.

Page de titre : pour quelque raison inconnue, Memoir utilise une pagination sur
la page de titre (dans les classes standard, les pages de titres sont “vides”,
c’est-a-dire sans numérotation). Si vous voulez une page de titre vide, tapez
\aliaspagestyle{title}{emptyl} dans le préambule.

Article : avec 'option de classe article (a ajouter dans Document > Paramétres > Classe de doc-
ument > Options de classe > Réglable), vous pouvez imiter le style article. C’est-a-
dire que les compteurs (notes de bas de page, figures, tableaux etc.) ne seront
pas réinitialisés a chaque nouveau chapitre, les chapitres ne commenceront pas
sur une nouvelle page (mais — contrairement a la “vraie” classe article — ils sont

encore autorisés), les parties cependant utilisent leur propre page comme dans
book.

Anciennes commandes de polices : par défaut, Memoir n’autorise pas I'utilisation
des commandes de changement de police supprimées, qui étaient utilisée par
I'ancienne version IXTEX 2.09 (par exemple \rm, \it). Il produit une erreur
et arréte KIEX deés qu’'une commande de ce genre apparait. L’option de classe
oldfontcommands autorise de nouveau ces commandes et set contente d’émettre
un avertissement (qui au moins ne stoppe pas IXTEX). Puisque beaucoup de
paquetages KIEX et en particulier les fichiers de style BibTEX utilisent encore
ces commandes, nous avons décidé d’utiliser cette option par défaut.
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6.15.3 Fonctions supplémentaires

Nous n’allons décrire que les fonctions qui sont gérées par LyX (ce qui ne fait pas
beaucoup pour linstant). veuillez consulter le manuel de Memoir? pour plus de
détails.

Abstract : Vous pouvez vous demander pourquoi un abstract est une fonctionnalité
supplémentaire. Hé bien, c’est une classe book. En principe, les classes book
n’ont pas d’abstract. Memoir, lui, en a une. Vous pouvez |'utiliser quand vous
le voulez et autant des fois que vous le voulez.

Chapterprecis : Vous avez peut-étre déja vu cela dans la littérature : Le contenu
d’un chapitre est brievement décrit sous le titre et aussi dans la table des
matieres (par exemple : Notre héros arrive a Troie ; il perd quelques amis ;
il s’en fait des nouveaur). Chapterprecis fait exactement cela. Cela n’a donc
de sens qu’apres un début de chapitre.

Epigraph : Une épigraphe est un joli slogan ou une devise placée au début d’un
chapitre. L’environnement epigraph fournit un moyen élégant de mettre en
forme une telle devise. Le texte de la devise (texte) et son auteur (facultatif)
ou source sont séparés par une petite ligne. L’auteur (source) peut étre saisi
via Insérer > Source épigraphique.

Poemtitle : Memoir offre de nombreuses possibilités pour mettre en forme de la
poésie (jusqu’a de treés complexes poemes figuratifs). IyX n’en gere que quelques-
uns. L’un d’eux est poemtitle, qui est un titre centré pour les poemes, qui
sera aussi ajouté a la table des matieres (I’environnement standard pour les
poemes est vers. Memoir a plusieurs versions améliorées de vers, mais vous au-
rez besoin d’utiliser du code TEX, puisqu’ils doivent étre emboités a l'intérieur
d’environnements vers ordinaires, ce qui n’est pas possible avec IyX).

Poemtitle* : Comme poemtitle, mais il n’ajoute pas une entrée a la table des matieres.

6.16 Papier

La classe de document paper (publication, “papier”) offre une alternative a la classe
standard article. Elle a les mémes fonctionalités, mais vous pouvez préférer ce for-
mat, avec des sections et en-tétes en police sans empattement, ainsi que d’autres
particularités.

6.17 Publications Springer(svjour)

par MARTIN VERMEER

29. Voir CTAN: /macros/latex/memoir/memman.pdf.
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6.17 Publications Springer(svjour)

6.17.1 Description

Ce sont les fichiers de format pour certains types de journaux édités par Springer
Verlag et dont la liste apparait a http://www.springer.de/author/tex/help-journals.
html, ou vous devrez aussi aller récupérer les fichiers de classe (eh oui, c’est main-
tenant du BETEX 22 !). C’est un systeme modulaire : ce qui est commun a tous les
journaux est implémenté dans svjour.inc, et les fichiers de format particuliers a un
journal (comme, par exemple, svjog.layout pour le Journal of Geodesy) peuvent
I'inclure.

Ca veut dire qu’ajouter le support de n’importe quel autre journal Springer présent
dans cette liste n’est rien d’autre qu’écrire votre propre fichier sv<mon_ journal>.layout
en suivant le schéma donné dans svjog.layout.

Ce n’a raisonnablement bien été testé que pour le Journal of Geodesy. svjour et
svjog sont fournis avec la distribution standard de IyyX. Installez le fichier de classe
correspondant (téléchargé chez Springer) dans un répertoire approprié, reconfigurez
ITEX (en lancant texhash dans le cas de teTEX, en tant que super-utilisateur si
nécessaire — IyX ne s’occupe-t-il pas tout seul de ¢a ?), reconfigurez IyX et ¢a
devrait fonctionner.

6.17.2 Nouveaux styles

Un grand nombre de styles de type théoreme — Affirmation, Conjecture, ... Théoréme.
Note_En_Téte (Headnote), Dédicace (Dedication), SousTitre (Subtitle), Titre_IKTEX_Courant
(Running  BTEX_ Title), Auteur_Courant (Author_Running), Institut (Institute), Mail,
Tirés_A_Part (Tiré a parts), Mots-Clés (Keywords), Remerciements (Acknowledge-
ments), Remerciement (Acknowledgement). Voir la documentation du fichier de classe
de Springer pour les détails.

6.17.3 Publications supportées

— Journal of Geodesy : svjog.layout — MARTIN VERMEER

— Probability Theory and Related Fields : svprobth.layout — JEAN-MARC LAS-
GOUTTES

Ajoutez le votre, ce n’est pas si dur !

6.17.4 Crédits

Ces fichiers sont partiellement basés sur 'ancien ejour2.layout, qui était lui-
meéme basé sur une version bricolée d'un vieux fichier de style KTEX 2.09 de Springer.
Tout ceci, ainsi que le format ejour2, est maintenant dépassé. Jean-Marc Lasgouttes

a été d'un grand secours pour me guider dans le mécanisme des fichiers de format
LyX.
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6.17.5 Bogues

Sans doute. Mais probablement moins que dans ’ancien ejour?2 bricolé.

6.18 RevTgX4

par AMIR KARGER

La classe de texte Revtex 4 marche avec la classe RevTEX 4.0 (version 8 de mai 1999)
de I’American Physical Society.

LyX a une classe de texte Revtex, qui marche avec RevIEX 3.1. Cependant, la
version 3.1 est périmée, car elle fonctionne avec IXTEX 2.09. Ce qui signifie qu’elle
n’interagit pas tres bien avec IyX, qui a besoin de IfTEX 2, méme si on I'a trafiqué
pour qu’elle marche. Comme RevTEX 4.0 a été étudiée pour marcher beaucoup mieux
avec INTEX 2¢, LyX avec la classe de texte Revtex 4 devrait étre assez facile a utiliser.

Cette documentation est censée servir en plus de la documentation de RevITEX
4.0, nous ne décrirons donc aucune des macros spéciales RevTEX, et supposerons que
vous savez ce qu’il faut mettre dans le préambule si besoin.

6.18.1 Installation

Tout ce que vous avez a faire est d’installer RevIEX 4, comme c’est décrit dans le
fichier README du paquetage. Le paquetage est disponible sur le site de RevTEX
4 http://publish.aps.org/revtex4/. Installez-le quelque part ou KTEX puisse
le voir. Testez-le en essayant de ITEXer un court document RevIEX 4 dans un
répertoire au hasard (c’est-a-dire pas dans celui ot vous avez installé le fichier de
classe). Ensuite, si vous reconfigurez IyX, il trouvera le fichier de classe et vous
laissera utiliser la classe de texte Revtex4.

Probablement la facon la plus simple de démarrer est soit d’importer un document
RevTEX 4 avec tex2lyx, soit d’utiliser le modele Revtex 4, qui se trouve dans le
répertoire de modeles.

6.18.2 Dans le préambule

Les parametres optionnels de \documentclass, comme “preprint” et “aps”, vont
dans le champ d’Options de la fenétre Document > Paramétres> Classe de document,
comme d’habitude. Rappelez-vous que dans RevTEX, il faut au moins un parametre
optionnel !

Le reste de ce qui va dans le préambule, comme \draft etc., va comme d’habitude
dans la fenétre Préambule IATEX.
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6.18 RevIgX4

6.18.3 Champs3?

Les champs correspondent basiquement aux commandes dans RevIEX 4.0. Par
exemple, le champ Email correspond a \email{}. Notez que (au moins pour RevIEX
4.0 Beta), les champs Adresse et Affiliation sont exactement équivalents, vous n’avez

donc pas besoin d'utiliser les deux 3.

6.18.4 Notes importantes

Il y a un ou deux aspects spécifiques de RevIEX 4 qui peuvent causer des erreurs
qui sont encore plus troublantes dans [yX.

Dans RevTgX, la commande \thanks va en dehors de la commande \author.
L’équivalent I X en est qu’il y a un champ Remerciements séparé. N’écrivez pas de
notes de bas de page dans le champ Auteur, ou des choses étranges apparaitront.
Voyez la documentation de RevITEX 4 pour plus de détails.

Egalement, les champs Email_Auteur (Author Email), URL_Auteur (Author URL)
et Remerciements (Thanks) doivent étre placés entre le champ Auteur et le champ
Adresse correspondant (ou son équivalent Affiliation). Si vous mettez les Remer-
ciements apres I’Adresse, la compilation ITEX échouera.

30. NdT : Dans la section sur RevIEX, j’ai traduit “layout” par “champ” a de nombreux endroits.
Ce que l'auteur indiquait était peut-étre un environnement, mais ressemble de toute facon a un
champ a remplir. N’ayant pas RevTEX, je ne peux pas aller vérifier.

31. Au cas ou ¢a vous intéresse, les deux sont inclus pour que tex2lyx puisse traduire a la fois
\address et \affiliation.
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7.1 Correcteur TEX

par ASGER ALSTRUP

7.1.1 Introduction

Vous trouverez dans le menu Outils la commande Correction TEX. Cette fonction-
nalité requicre le programme chktex ! et la commande est donc grisée si celui-ci n’est
pas installé. Vous pouvez vous le procurer de CTAN,
https://www.ctan.org/tex-archive /help/Catalogue/entries/chktex.html.

Le paquetage ChkTEX est un programme qui a été écrit par JENS T. BERGER
THIELEMANN qui se plaignait que certaines commandes de I¥TEX n’étaient pas na-
turelles et s’oubliaient facilement. Ce programme parcourt votre fichier KITEX et en
vérifie la bonne écriture. C’est donc ’équivalent de Lint, mais pour ETEX.

La question est donc : mais que vient faire ce logiciel sous [yX alors que LyX
est déja censé produire du IWTEX exempt de fautes ? La réponse est simple : tout
comme Lint ne vérifie pas seulement la syntaze d’un fichier C, mais aussi la bonne
utilisation des types, ChkTEX détecte en plus des erreurs syntaxiques quelques erreurs
typographiques. Entre autres, ChkTEX est a méme de détecter des erreurs courantes
comme 2

— de mauvais points de suspension :
Utiliser ... et non pas ...;

— des espaces a l'intérieur des parentheses :
( mauvais espacement );

— T'utilisation d’espaces normaux dans des abréviations courantes :
Par exemple il y a ici trop d’espaces dans ’abréviation C. N. R. S.;

— Tutilisation d’'un mauvais espacement a la fin d’'une phrase dont la derniere
lettre est une majuscule :
Voici un TEST. Et 'espacement n’est pas bon;

— l’insertion d’une espace avant une étiquette ou un autre objet de ce type :
L’étiquette ou la note doit étre collée au texte, sans quoi elle risque d’apparaitre

1. chktex n’est pas encore disponible avec la distribution MiKTEX.
2. NdT : Certaines de ces régles me sont totalement inconnues. Il est possible qu’elles ne
s’appliquent pas a la langue frangaise. — of
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sur une mauvaise page. . L’étiquette est ici trop séparée;

— T'utilisation d’espaces simples au lieu d’espaces insécables devant des références

Si vous n’avez pas de chance, le saut de ligne aura lieu exactement entre le mot
“section” et le numéro, et ¢a ferait le plus mauvais effet... : voyez la section
7.1.1;

— I'utilisation d’un “x” au lieu du symbole “x” entre deux nombres :
2x2 rend beaucoup moins bien que 2 X 2

et bien plus encore... C’est un outil tres utile pour le “polissage final” du docu-
ment avant son impression, et vous devriez 1'utiliser apres 'inévitable correction de
I'orthographe et avant d’affiner la typographie.

7.1.2 Comment l'utiliser

Si le programme est installé, 'employer est un jeu d’enfant : faites
Outils> Correction TEX. LyX générera alors une version IXTEX de votre document,
lancera ChkTEX pour la corriger, puis insérera des “boites d’erreurs” avec les aver-
tissements de ChkTEX, s’il y en a. Ces avertissements seront placés au plus pres de
I’erreur, et vous pourrez facilement les trouver avec Navigationt Erreur, ou par le rac-
courci clavier C-g (d’apres le fichier de raccourcis implicites cua). Ouvrez les boites
d’erreur en cliquant dessus, ou par le raccourci cua C-i, ou le raccourci emacs C-o.
Lisez I'avertissement, et corrigez l'erreur si ¢’en est bien une. Si vous ne comprenez
pas l'avertissement, ignorez-le. En effet, il y a des différences entre ce qu’il y a a
I’écran et les détails techniques que ChkTEX vérifie, et ¢a peut amener certains de ses
avertissements a paraitre mystérieux ou méme stupides.

Ce document est un excellent terrain d’entrainement, et sa vérification levera stire-
ment quelques avertissements. Les ordinateurs sont idiots: la plupart de ces aver-
tissements seront donc des fausses alertes.

7.1.3 Réglages fins

Vous trouverez parfois que ChkTEX est plus bavard qu’il ne devrait I'étre. Vous
pouvez alors choisir de ne pas l'utiliser, ou alors le configurer a vos propres gofits.

Mais, méme si ChkTEX est vraiment configurable et extensible, vous ne pourrez
pas résoudre tous les problemes de ChkTEX dans LyX de cette maniere. En effet,
LyX géneére un fichier IXTEX un peu particulier pour étre ensuite capable de faire
correspondre les numéros de lignes indiqués par ChkTEX* avec la structure interne
du document. De ce fait, certains avertissements ne sembleront pas apparaitre cor-
rectement. Vous pouvez faire deux choses contre cela :

3. Cette note peut apparaitre sur une mauvaise page, car son appel (le petit numéro dans le
texte) n’est pas collé au mot le précédant.

4. Vous pouvez trouver toutes les indications de chktex en faisant Document Fichier Jour-
nal KTEX apres avoir lancé chktex.
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— Paramétrez I'appel a ChkTEX dans Outils > Préférences > Sorties > IATEX, ou alors
dans le fichier de configuration de U'installation de ChkTEX (souvent, le fichier
chktexrc). Voyez ci-dessous pour savoir quels avertissements peuvent étre
activés ou désactivés a la ligne de commande.

— Exportez votre document en tant que fichier IXTEX normal par Fichier > Exporter >
BTEX et lancer manuellement chktex dessus. S’il est invoqué de cette fagon,
ca peut étre pénible de trouver I’endroit correspondant dans le document IxX,
mais avec un peu de patience, vous devriez y arriver.

Voici maintenant les messages d’avertissement qui peuvent étre activés ou désactivés
dans Préférences. Utilisez —n# pour désactiver un avertissement, et —w# pour l'activer.
Les entrées en italiques sont désactivées par défaut, car le réglage de base est “ chktex
-nl -n3 -n6 -n9 -n22 -n25 -n30 -n38”".

Remarquez que vous ne devriez toucher qu’a ces options d’activation et de désac-
tivation d’avertissements, et pas aux autres. En effet, [yyX utilise les autres options
a sa convenance pour dialoguer avec chktex.

1. Command terminated with space. (La commande se termine par une espace.)

2. Non-breaking space (“~”) should have been used. (Il faut utiliser ici une espace

insécable ("~").)

3. You should enclose the previous parenthesis with “{}”. (Vous devriez entourer les
parenthéses précédentes par "{}" .)

4. Ttalic correction (“\/”) found in non-italic buffer. (Une correction d’italique ("\/")
est dans un groupe qui n’est pas en italique.)

5. Italic correction (“\/”) found more than once. (Il y a plus d’une correction d’italique
(n\/u) )
6. No italic correction (“\/”) found. (Il n’y a pas de correcteur d’italique ("\/" ) .)

7. Accent command “cmd” needs use of “cmd”. (La commande "cmd" requiére 1'utilisation
de "cmd".)

8. Wrong length of dash may have been used. (Il se peut que le tiret ne soit pas de la
bonne longueur.)

9. “%s” expected, found “%s . (Attendait "%s", a trouvé "%4s".)
10. Solo “%s” found. (Un seul "%s" a été trouvé.)

11. You should use “%s” to achieve an ellipsis. (Vous devriez utiliser "%s" pour une
ellipse (points de suspension).)

12. Inter-word spacing (“\ ¢) should perhaps be used. (Une espace d’entre mots ("\”)
devrait peut-étre étre utilisé.)

13. Inter-sentence spacing (“\@”) should perhaps be used. (Une espace d’entre phrases
("\@") devrait peut-étre étre utilisé.)

14. Could not find argument for command. (N’a pas trouvé de parameétre & la com-
mande.)

15. No match found for “%s”. (Aucune occurrence de “ %s” n’a été trouvée.)

85



7 LyX et applications externes

16.

17.

18.

19.

20.
21.

22.
23.
24.

25.

26.

27.
28.

29.
30.
31.
32.
33.
34.
35.
36.

37.

38.

39.
40.

41.
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Math mode still on at end of ITEX file. (Le fichier IATEX se termine dans le mode
Math.)

Number of “char” doesn’t match the number of “char”. (Le numéro de "char" ne
correspond pas a celui de "char".)

You should use either " or " as an alternative to “"”. (Vous devriez utiliser " ou "
plutét que """.)

You should use "?" (ASCII 39) instead of """ (ASCII 180). (Vous devriez utiliser "’"
(ASCII 39) au lieu de """ (ASCII 180).)

User-specified pattern found. (A trouvé un format défini par l'utilisateur.)

This command might not be intended. (Cette commande n’est peut-étre pas volon-
taire.)

Comment displayed. (Un commentaire est affiché.)
Either "\,” or ’\," will look better. ("\,” ou ’\," présentera mieux.)

Delete this space to maintain correct page references. (Enlevez cette espace pour
avoir une pagination correcte.)

You might wish to put this between a pair of “{}”. (Ce serait peut-étre mieuzx entre
deuz accolades "{}".)

You ought to remove spaces in front of punctuation. (Il n’y a pas d’espace devant
cette ponctuation.)

Could not execute IXTEX command. (Ne peut pas exécuter la commande IXTEX.)

Don’t use \/ in front of small punctuation. (N’utilisez pas \/ devant la ponctuation
basse.)

$\times$ may look prettier here. ($\times$ serait mieux ici.)

Multiple spaces detected in output. (La sortie affiche ici plusieurs espaces.)

This text may be ignored. (Ce texte ne sera peut-étre pas pris en compte.)

Use " to begin quotation, not ’. (Utilisez " pour ouvrir une citation et non ’.)

Use ’ to end quotation, not ". (Utilisez ’ pour clore une citation et non ".)

Don’t mix quotes. (Ne mélangez pas les différents types de guillemets.)

You should perhaps use “cmd” instead. (Il vaudrait peut-étre mieux utiliser "cmd".)

You should put a space in front of/after parenthesis. (Il faut des espaces a ’extérieur
des parentheses.)

You should avoid spaces in front of/after parenthesis. (Ne mettez pas d’espaces a
I'intérieur des parenthéses.)

You should not use punctuation in front of/after quotes. (La ponctuation ne doit pas
apparaitre derriére les guillemets.)

Double space found. (Double espace !)

You should put punctuation outside inner/inside display math mode. (La ponctua-
tion devrait se trouver a 'extérieur du mode mathématique.)

You ought to not use primitive TEX in ITEX code. (Vous ne devez pas utiliser de
primitives TEX dans du code IATEX.)



7.2 Controle de version sous LyX

42. You should remove spaces in front of “%s”. (Ne mettez pas d’espaces devant "¥%s".)
43. “%s” is normally not followed by “%c”. ("%s" n’est normalement pas suivi de "%c".)

Nous espérons fournir dans les versions futures de IxyX une interface plus complete
a cet outil (ainsi qu’a son petit cousin lacheck) pour pouvoir en exploiter toute la
puissance. Mais, , il est des maintenant utilisable : lancez-le sur I'un de vos documents
de bonne taille, et voyez le résultat.

7.2 Contréle de version sous LyX

par LARS GULLIK BJ@NNES, mise a jour par PAVEL SANDA

7.2.1 Introduction

[y X accepte la plupart des commandes simples de RCS/CVS/SVN. Si vous devez
utiliser des fonctions plus sophistiquées, il vous faudra cependant encore passer par
un terminal de commande.

Notez également que le support de CVS n’est pas aussi bon que celui de Subversion,
que nous vous conseillons donc. Un bon document de départ pour Subversion est le
Manuel SVN5. Pour RCS, lisez d’abord “rcsintro” (c’est un fichier man : lisez-le
avec man rcsintro). Ce fichier décrit toutes les fonctions de base de RCS. Voyez
particulierement le paragraphe sur le répertoire RCS, et la notion de fichier RCS
maitre (le fichier finissant par ,v).

Avant de vous lancer dans l'utilisation du controle de version sous LyX, vous devrez
connaitre 'utilisation de RCS/CVS/SVN. Le support assuré dans LyX a été réalisé
pour des versions récentes des paquetages GNU RCS ou CVS/SVN il n’est pas garanti
que cela fonctionne avec des versions plus anciennes. En général, les messages de
contrdle ne sont pas affichés apres chaque opération vous pouvez les vérifier dans la
console de lancement de LyX si vous doutez. Les utilisateurs réguliers du controle
de version apprécieront la barre d’outils correspondante, qui peut étre activée via
Affichage > Barre d’outils> Contrdle de version.

Pour créer vos propres commandes externes, consultez vce-command dans le manuel
des Fonctions LyX.

Il est fortement recommandé d’enregistrer les documents en mode non compressé
lors de I"utilisation du contréle de version (décochez Document > Compressé si la case
est cochée): les documents LyX non compressées sont des fichiers textuels qui peuvent
étre fusionnés par le controle de version. Mes documents compressés sont des fichiers
binaires qui ne peuvent pas étre fusionnés.

7.2.2 Les commandes RCS sous LyX

Les sections suivantes décrivent les commandes RCS supportées par LyX. Vous
pouvez les trouver dans Fichier > Contréle de Version. Lyx a été testé avec RCS 5.7/5.8.

5. http://svnbook.red-bean.com/
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7.2.2.1 Initialiser le contrdle de version

Si votre document n’est pas sous le mode “controle de version”, c¢’est le seul choix
qui vous soit proposé. Si vous étes déja sous ce mode, I’élément S’INSCRIRE est grisé
et inaccessible.

Cette commande intialise le controle de version avec RCS. Il vous est alors demandé
de donner une description initiale du document. Le document est alors mis en mode
“lecture seule” et il vous faudra faire Nouvelle Version Modifiable avant de le modifier.
Un document sous controle de version a dans le minibuffer “[RCS: <version><locker>]”
accolé au nom de fichier.

En arriere-plan, la commande RCS qui a été lancée est

ci -q —u -i -t-"<description_initiale>" <nom_fichier>.

Lisez man ci pour comprendre le sens des parametres.

7.2.2.2 Enregistrer les changements

Lorsque vous avez fini de modifier un fichier, vous figez vos modifications® par
F1cHIER > CONTROLE DE VERSION > ENREGISTRER LES CHANGEMENTS.... Il vous
sera alors demandé une description de ceux-ci. Cette information est conservée dans
le fichier d’historique. Le numéro de version est alors incrémenté, vos modifications
sont appliquées au fichier RCS maitre et le document est déverrouillé et remis en
mode “lecture seule”.

— Commande RCS : ci -q -u -m"<description>" <nom_fichier>

7.2.2.3 Nouvelle version modifiable

En utilisant cette commande, vous verrouillez le document de maniere a ce que
vous soyez le seul a pouvoir I’éditer. Vous seul en possédez les droits d’écriture. Vous
continuez donc a éditer le fichier un moment, puis vous figez vos changements. La
ligne d’état est modifiée pour indiquer que le fichier est verrouillé.

— Commande RCS : co -q -1 <nom_fichier>

7.2.2.4 Revenir a la version du dépot

Ceci annule tous les changements réalisés sur le document depuis que le document
a été figé la derniere fois. Une demande de confirmation apparait alors, avant que
tous les changements soient perdus.

— Commande RCS : co -f -u<version> <nom_fichier>

6. NdT : check-in
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7.2.2.5 Copy

This will create a copy of the current document. Since RCS does not support copy
operations natively, the version history is not preserved, and the copy is added as a
new file. It requires a clean document without any changes since the last checkin.
You are asked for a file name and a description of the copy operation. After that the
copy is created, both locally and in the repository. If the parent directories of the
copied and original document differ, all relative paths of included files of the copy are
adjusted (like in Filer-Save As...). Finally, the copy is loaded instead of the original
document.

RCS commands:
Copy "<file-name>" to "<new-file-name>"
ci -q -u -i "<new-file-name>"

7.2.2.6 Annuler le dernier enregistrement

Fait comme si la derniére modification n’avait jamais été faite. Aucune modification
n’apparait sur le document LyX, mais la derniére version est effacée du fichier maitre
RCS.

— Commande RCS : rcs -o<version> <nom_fichier>

7.2.2.7 Visionner historique

Montre 'historique complet du document RCS. La sortie de rlog <nom_fichier>
est ainsi affichée dans une fenétre. Voyez man rlog pour plus d’informations.

7.2.2.8 Informations de révision

Lyx ne connait que le numéro de version RCS, voir 7.2.4.11pour les détails.

7.2.3 CVS commands in LyX

A subset of CVS operations is supported by LyX. You can find the commands in
the File>Version Control submenu. The version control system SVN is more powerful,
so please use it instead of CVS if possible.

7.2.3.1 General CVS usage

If you start from scratch with CVS you have to create your repository and checkout
the working copy with external tools. If you're using a client-server setup you may
need to login before doing the first repository checkout.

If your documents are under revision control and others are using the same reposi-
tory problems arise when different changes to the same document at the same location
happen. Standard CVS repositories don’t operate with a file locking mechanism. This
may be surprising, but conflicts only occur if people disagree on the proper content
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of the same part of a document. So, if co-workers are used to communicate regularly,
these conflicts occur rarely. If they don’t communicate they have a fundamental
problem anyway. Nevertheless some people like to work with so called “reserved
checkouts”. If they do so the working copy of all files is readonly when checked out
first and the user starts editing after using a special command to make the working
copy writable. When the changes are checked in the working copy returns to readonly
state. With IiyX one has to edit the .cvsrc file and add the line cvs -r to work
with reserved checkouts. The benefit is the possibility to see who is using a writable
copy of some document. It’s not guaranteed only one user makes a copy writable.

LyX tries to guess if you're using reserved or non-reserved checkouts. If your
working copy is readonly or it is writable and an additional copy of your document
exists in the CVS/Base sub-directory a reserved otherwise a non-reserved checkout is
assumed. When a reserved checkout is detected you have to use CHECK OUT to make
your working copy writable if it’s readonly. After doing so the CHECK IN operation
is possible and that makes your working copy readonly again after transferring your
changes to the repository.

More information about CVS can be found here http://www.nongnu.org/cvs and
here http://ximbiot.com/cvs.

Read man cvs to understand the sub-commands and the switches mentioned below.

7.2.3.2 Register

If your document is not under revision control, this is the only item shown in the
menu. And if it is under revision control, the Register item is not visible.

This command registers in CVS your document only in the case you have already
the documents directory under CVS control (in particular CVS/Entries file exists).
This means you have to create or checkout the archive by yourself using external
tools. (In case you forget that step LyX registers the document with RCS.)

Then you are asked interactively to supply an initial description of the document.
Don’t forget that registered file is not yet checked in.

CVS command that isrun: cvs -q add -m"<entered message>" "<file-name>"

The term "<file-name>" above and for all other CVS commands is an abbreviation
for “change the current working directory to file location and use the file name without
path component as argument”.

7.2.3.3 Check In Changes

When you are finished editing a file, you commit your changes. When you do this
and you had changed the document, you are asked for a description of the changes.
After that changes are written to the repository. In case you didn’t change the
document and a reserved checkout is detected the reservation made on CHECK OUT
is undone.

CVS command:
cvs —q commit -m"<description>" "<file-name>" or
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cvs —q unedit "<file-name>"

7.2.3.4 Check Out Changes

When you are sharing a repository with others, you may have to incorporate their
changes into your working copy.

CVS command: cvs -q update "<file-name>"

If a readonly checkout is detected the working copy is made writable and reserved.

CVS command: cvs -q edit "<file-name>"

7.2.3.5 Revert To Repository Version

This will discard all changes made to the document since the last check in. You
get a warning before changes are discarded. Firstly the file is deleted, secondly CVS
update command is run.

CVS command: cvs -q update "<file-name>"

If a reserved checkout is detected and the working copy has no changes only the
reservation is undone.

CVS command: cvs -q unedit "<file-name>"

7.2.3.6 Copy

This will create a copy of the current document. Since CVS does not support copy
operations natively, the version history is not preserved, and the copy is added as a
new file. It requires a clean document without any changes since the last checkin.
You are asked for a file name and a description of the copy operation. After that the
copy is created, both locally and in the repository. If the parent directories of the
copied and original document differ, all relative paths of included files of the copy are
adjusted (like in FilerSave As. ..). Finally, the copy is loaded instead of the original
document.

CVS commands:
Copy "<file-name>" to "<new-file-name>"
cvs —q add "<new-file-name>"

7.2.3.7 Rename

This will rename the current document. Since CVS does not support rename
operations natively, the version history is not preserved, the renamed document is
added as a new file, and the original document is deleted. It requires a clean document
without any changes since the last checkin. You are asked for a file name and a
description of the rename operation. After that the document is renamed, both
locally and in the repository. If the parent directories of the new and old file names
differ, all relative paths of included files are adjusted (like in File>Save As. . .). Finally,
the document is reloaded using the new name.
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CVS commands:
Rename "<file-name>" to "<new-file-name>"
cvs —q add "<new-file-name>"
cvs —-q remove "<file-name>"

7.2.3.8 Update of the local directory checkout from repository

Once your documents gets more complex, containing sub-documents and pictures,
including external .tex files and so on using version control becomes more compli-
cated. LyX supports updating the whole tree in which resides the document. This
become especially useful once you cooperate with people which neither have detailed
knowledge about CVS usage nor they have ambition to commit additional material
to the repository. You have to organize the files structure so that all external files are
in the same directory or subdirectories of the document. It’s good practice anyway
to store multipart documents in an extra directory.

The Update local directory from repository command updates the whole di-
rectory. If local changes are detected user is warned before update starts. In case
of merge conflicts both versions of the conflicting document parts are placed in the
final document. You have to review and correct the result of the merge. You'll find
the conflicts enclosed in pairs of <<<<<<< and >>>>>>> separated by =======. The
first part is your version as before the update operation with the document name
prepended. The second one is the repository version with the version number after
the sequence of > signs.

CVS commands:
cd $path; cvs diff "." (Ask if changes are detected.)
cd $path; cvs -q update "."

where $path stands for the path to the document.

7.2.3.9 Show History

This shows the complete history of the CVS document. The output of cvs log
"<file-name>" is shown in a browser.

7.2.3.10 Revision info

Iy X supports CVS version number, author name, date and time of last commit.
All those are extracted from cvs log -r <file-name>. See 7.2.4.11 for details.

7.2.4 SVN commands in LyX

SVN is now partially supported by [y X. You can find the commands in the File>
Version Control submenu. Please note that if you use password protected access to
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repository via ssh, you will be asked in terminal window. IyX was tested against
SVN 1.5, 1.6, 1.7 and 1.87

7.2.4.1 Register

If your document is not under revision control, this is the only item shown in the
menu. And if it is under revision control, the Register item is not visible.

This command registers in SVN your document ONLY in case you have already
the documents directory under SVN control (in particular .svn/entries file exists).
This means you have to checkout the archive by yourself.

Then you are asked interactively to supply an initial description of the document.
Don’t forget that registered file is not yet commited.

SVN command that is run: svn add -q "<file-name>"

Read man svn to understand the switches.

7.2.4.2 Check In Changes

When you are finished editing a file, you commit your changes. When you do this,
you are asked for a description of the changes. After that changes are commited.
SVN command:® svn commit -q -m"<description>" <file-name>

7.2.4.3 Check Out For Edit

Updates the changes of this file from the repository. Be sure you understand SVN
merging and conflicts resolving before using this function, because all conflicts has
to be resolved manually by you!

SVN command:? svn update --non-interactive "<file-name>"

7.2.4.4 Revert To Repository Version

This will discard all changes made to the document since the last check in. You
get a warning before changes are discarded.
SVN command: svn revert -q "<file-name>"

7.2.4.5 Copy

This will create a copy of the current document including the version history. It
requires a clean document without any changes since the last checkin. You are asked
for a file name and a description of the copy operation. After that the copy is created,
both locally and in the repository. If the parent directories of the copied and original

7. Most of the commands will work with 1.4 too, see 7.2.4.7. There seems to be currently
unresolved permissions problem under SVN 1.8 with reverting changes when file is locked.

8. In case locking is not enabled. See Section 7.2.4.9.

9. Ditto.
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document differ, all relative paths of included files of the copy are adjusted (like in
Filer-Save As. . .). Finally, the copy is loaded instead of the original document.

SVN commands:
svn copy —q "<file-name>" "<new-file-name>"
svn commit

7.2.4.6 Rename

This will rename the current document including the version history. It requires
a clean document without any changes since the last checkin. You are asked for a
file name and a description of the rename operation. After that the document is
renamed, both locally and in the repository. If the parent directories of the new and
old file names differ, all relative paths of included files are adjusted (like in Filer>Save
As...). Finally, the document is reloaded using the new name.

SVN commands:
svn move —-q "<file-name>" "<new-file-name>"
svn commit

7.2.4.7 Update of the local directory checkout from repository °

All the commands above have one shortcoming — they deal with the current doc-
ument only. Once your document contains pictures, includes external .tex files and
so on administration becomes more complicated. LyX now supports updating the
whole tree in which resides the document *'. This become especially useful once you
cooperate with people which neither know about subversion management nor they
have ambition to commit additional material to the repository.

Update local directory from repository command updates the whole direc-
tory and in case of merge conflicts local version of the files are left, so no unintended
data loss occurs. If local changes are detected user is warned before update starts.

SVN commands:
svn diff $path (Ask if changes are detected.)
svn update --accept mine-full $path

where $path stands for the path to the document.

7.2.4.8 Show History

This shows the complete history of the SVN document. The output of svn log
"<file-name>" is shown in a browser.

10. Note that this command will work only with subversion = 1.5
11. One need to organize the files structure so that all external files are in the same directory or
subdirectories of the document.
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7.2.4.9 File Locking

The file exchange through various revision control systems brings the problem of
merge conflicts in case two different users try to edit the same (parts of) document.
When such a conflict happens it needs manual resolving and one reasonable alterna-
tive is to provide some kind of locking mechanism, which guarantees that only one
user is allowed to edit file at the given time.

SVN has two such mechanisms to provide mutual exclusivity for file access — locks
and automatic setting of write permissions (see sec. 7.2.4.10) based on svn:needs-lock
file svn property '2. If this property is detected for a given document IyX starts to
use SVN locks for document editing automatically and the whole check-in/out mech-
anism switches to the same regimen as for RCS. This in particular means there are
two different modes of file use in IyX:

— Unlocked state. The loaded file is in the read-only mode. For editing on needs
to check-out. Check-out consists of updating from the repository and gaining
write lock. If the lock is not possible to obtain, we remain in unlocked state.

— Locked state. The loaded file is in the ‘normal’ edit mode. No other user is
allowed to edit the file. Check-in consists of commiting changes and releasing
write-lock. If no changes have been made to the document, no commit will be
produced ' and only the write-lock will be released.

SVN commands:

Check-in: svn commit -q -m"<description>" "<file-name>"
svn unlock "<file-name>"

Check-out: svn update "<file-name>"
svn lock "<file-name>"

7.2.4.10 Automatic Locking Property

The above mentioned automatic setting of write permissions of the .lyx file can
be set through File>Version Control>Use Locking Property. This command is active
only when the file is not locked on the svn server (i.e. you need to check-out before
proceeding).

SVN commands:
Set: svn propset svn:needs-lock ON "<file-name>"

Unset: svn propdel svn:needs-lock "<file-name>"

7.2.4.11 Revision Information in Documents

There are more possibilities how to activate revision information in our document.

— Iy X supports directly:

12. http://svnbook.red-bean.com/en/1.2/svn.advanced.locking.html
13. Don’t be puzzled by the fact that you will be asked for commit message anyway.
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— tree revision information (vcs-tree-revision). The result is the output
of the svnversion command, the following table gives you an idea, how
to read the results.

’ Output \ Meaning ‘
4123:4168 mixed revision working copy
4168M modified working copy
41238 switched working copy
4123P partial working copy, from a sparse checkout

4123:4168MS | mixed revision, modified, switched working copy

— file revision information. The result comes from parsing the output of
svn info --xml file.lyx. Supported flags are:

— version number of the last commit (vcs-revision)
— author of the last commit (ves-author)
— date of the last commit (vcs-date)

— time of the last commit (ves-time)

You can obtain this info via InsetInfo (e.g. info-insert buffer vcs-date).
The information will be available only when you have the file stored under svn
managment (i.e. the .svn directory is available with your document).

Another—a hacking one—possibility is to use svn keywords **. In short — you
set file keywords property (e.g. svn propset svn:keywords 'Rev’ file.lyx) and then
paste keyword TEX code!® tag in your document (e.g. $Rev$). This way svn
client will automatically substitute revision number (e.g. $Rev: 59 $) after
each update and commit. There are more problems with this approach. Firstly,
the ’$’ character is used in TEX world for math equations, so any occurence of
math formula Rev become Rev : 59 in your LiyX document. Similarly for
other keywords like Id, Date, Author, etc. Secondly svn output is dependent
on your locales, so its very easy that svn would produce some problematic
strings once Date is used. Thirdly you get the whole 'Rev: 59’ string in your
document instead of the plain number. Until subversion implements user’s
custom keywords it will be hard to use this approach reliably or let IyX to
support it directly.

7.2.5 SVN and Windows Environment

My inclination is to say that if the user cannot figure out the command

line operations on their own fairly quickly, they would be well advised to
use TortoiseSVN. —P. A. Rubin

14. http://svnbook.red-bean.com/en/1.4/svn.advanced.props.special. keywords.html
15. This is an easy way how to ensure that LyX won’t break the line in the middle of keyword

tag.
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7.2.5.1 Preparation

In addition to installing Iy’X, and having access to a Subversion repository, the user
will need to install the Subversion client program. A Windows installer for the client
program is available from CollabNet. The user may also want to install TortoiseSVN,
which integrates Subversion operations into the context (rightclick) menu of Windows
Explorer. Operations done outside Iy X will typically be more convenient using the
Explorer context menu. Note that TortoiseSVN is not a replacement for the client
program, which is what IyX itself will use.

7.2.5.2 Bringing a document under Subversion control

Before a LyX document can be brought under version control in Subversion, its
parent directory needs to be under version control. If the document is being added
to a project already in the repository, this is accomplished by checking the project
out to the directory where the new document will be placed. If the project itself is
not yet under version control (for instance, if this document starts a new project),
the directory must be imported into the repository. This is done outside IyX. Both
import and checkout are easily accomplished from the Explorer context menu using
TortoiseSVN, or alternatively can be done using the command line client at a DOS
prompt. The procedure for importing the project using TortoiseSVN is described
below, assuming an existing repository and a new project being started in C:\new
project. For information on using the Subversion client program, run svn --help
in a DOS shell.

1. Locate C:\new project in Windows Explorer, right click it, and select Tor-
toiseSVN > Repo-browser. If necessary, adjust the URL for the repository, then
click OK.

2. Right click the level of the repository under which you want to place the new
project folder (typically the top level) and click Create folder Supply a name
for the project folder and click OK. Add a message for the log file if desired,
then click OK again. The new project folder should appear in the repository.
Finally, click OK again to exit the repository browser.

3. Once again right click C:\new project, this time selecting SVN Checkout. ..
Select the URL of the project folder you just created in the repository, and
set the checkout directory to C:\new project. Click OK. You will be warned
about a non-empty folder; click OK to proceed. You should now have a .svn
directory under C:\new project.

4. Create or open your document in IyX and click File>Version Control > Register.
Add a log message and click OK to commit the document to version control.

From this point onward, you should have full functionality in the File > Version Control
menu. You also have the option of checking the document in and out, viewing
its history, etc. using the TortoiseSVN context menu in Windows Explorer or the
Subversion client program from a command prompt.
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7.2.5.3 SSH tunnel used with SVN under Windows

Compared with Linux setting up an svn client to communicate over ssh under
Windows is a rather troublesome task. We will at least offer some hints how to setup
the client side but prior knowledge about ssh and the Windows command line is
needed, also be prepared for a great deal of frustration. ..

1. Get an svn client for windows, as described in the previous sections. When it
is a fresh install run some svn command (e.g. svn --version) to create config
files, which you will need to change later on.

2. Choose an ssh client for Windows. There are several possibilities, we will use
the one from Putty tools !¢, You will need to set the connection up so that the
client doesn’t ask for any password from you. To keep things easy we will use
only keys without any additional password protection etc.

a) Generate keys by puttygen. Save your private .ppk key file and put the
public one on the server side. If the SVN server runs on Linux, note
that the format of the public key is not compatible with Linux openssh
and you will need to direcly copy-paste the key from the “Public key for
pasting into OpenSSH authorized_keys file:” edit field into the server’s
~/.ssh/authorized_keys / authorized_keys2 file.

b) Get the Putty’s plink. In the SVN config file!?, section [tunnels|, setup
ssh command, e.g. ssh=c:/path/plink.exe -i c:/path/private_key.ppk.'®

3. Checkout the SVN archive, e. g.
svn co svnt+ssh://user@server/repository_path.

7.2.5.4 End-of-Line Conversions

When the collaborators are mixing Linux and Windows environments, LyX will
use different line endings inside the .lyx files. This is not a problem as far as [yX
functionality is concerned, but the commit diffs will be huge and merge-conflicts
prone. Fortunately SVN itself knows ! how to deal with CR/LF problems when
switching .lyx files to the native mode. %’

7.2.6 GIT commands in LyX

A minimal subset of GIT commands is now supported by IxX. You can find the
commands in the Filer>Version Control submenu. Please note that if you use password

16. http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html

17. Exact path depends on Windows version, usually somewhere around c:\Documents and
Settings\user\Application Data\Subversion\config / AppData\Roaming\Subversion.

18. It will usually take a lot of time to get exact command right and it depends on many things.
For example do not have some remote server saved as a default session in Putty etc. If things fail,
try to connect via plink without SVN first.

19. http://svnbook.red-bean.com/en/1.4/svn.advanced.props.file-portability.html

20. For the lazy guys: svn propset svn:eol-style native FILE_NAME
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protected access to repository via ssh, you will be asked in terminal window. IyX
was tested against GIT 1.7.2

One big difference of GIT and the other supported version control systems is the
distributed nature of GIT: With traditional version control systems there is one cen-
tral server which hosts the repository. Users commit their changes to the server, and
get updates made by other users from it. With GIT, users commit to a local reposi-
tory. The local repository can be synchronized with one or more remote repositories
using the pull and push GIT commands. LyX does not interact in any way with
remote GIT repositories. It works exclusively with the local repository in a very sim-
ilar way as with a central CVS or SVN repository. If you use remote GIT repositories
you need to do the pull and push operations with your favourite GIT client.

7.2.6.1 Register

If your document is not under revision control, this is the only item shown in the
menu. And if it is under revision control, the Register item is not visible.

This command registers in GIT your document ONLY in case you have already the
documents directory under GIT control (in particular .git/index file exists). This
means you have to checkout the archive by yourself.

Then you are asked interactively to supply an initial description of the document.
Don’t forget that registered file is not yet committed.

GIT command that is run: git add "<file-name>"

Read man git to understand the switches.

7.2.6.2 Check In Changes

When you are finished editing a file, you commit your changes. When you do this,
you are asked for a description of the changes. After that changes are committed.
GIT command: git commit -q -m"<description>" <file-name>

7.2.6.3 Revert To Repository Version

This will discard all changes made to the document since the last check in. You
get a warning before changes are discarded.
GIT command: git checkout -q "<file-name>"

7.2.6.4 Rename

This will rename the current document including the version history. It requires
a clean document without any changes since the last checkin. You are asked for a
file name and a description of the rename operation. After that the document is
renamed, both locally and in the repository. If the parent directories of the new and

21. Windows users please note that you need to ensure that git is on the path. This can be set
from within IyX at Tools> Preferences > Paths> PATH prefix.
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old file names differ, all relative paths of included files are adjusted (like in Filer>Save
As...). Finally, the document is reloaded using the new name.

GIT commands:
git mv "<file-name>" "<new-file-name>"
git commit

7.2.6.5 Show History

This shows the complete history of the GIT document. The output of git log
"<file-name>" is shown in a browser.

7.2.6.6 Version Info

[yX supports GIT hash number of the last commit to the file, author name, date
and time of last commit. All those are extracted from git log -n 1 --pretty=format:%H%n%an:
Tree version information is obtained via git describe --abbrev --dirty --long.
See 7.2.4.11 for other details.

7.2.7 Further tuning

With the recent addition of the vc-command function LyX power users are allowed
to create their own commands for revision control.

As an example you can see how two TortoiseSVN commands could be integrated
directly:

Commit: vc-command DR "." "TortoiseProc /command:commit /path:$$p"

Revert: vc-command DR "." "TortoiseProc /command:revert /path:$$p"

7.2.8 Version control and Document comparison

One of the typical uses of version control is to inspect the changes between revisions,
usually by creating diff dumps. While this is useful for plain text files, it is much
less useful in the case of [yX files, which have more a complicated structure. Hence
we provide binding to the Document comparison feature. There are two ways of
calling this feature — either by direct call of vc-compare LyX function (for details

see IyX functions manual) or by the toolbar icon ®or the menu item No menu entry
for action vc-compare, respectively. Omne can either compare two chosen revisions
of the document or he can simply compare the current version of edited text with
older revisions (where 0’ revisions back means comparison of the edited file with last
commited revision).

This feature is supported for SVN and RCS though due to the more complicated
versioning scheme of RCS there is a constraint — when addressing the revisions in
dialog, numbers always point to the last number in RCS revision number, i.e. '35’
in ’1.2.35. We don’t currently support GIT addressing of revisions, one can just
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compare edited document with its revision X steps backs, where X is addressed as
HEAD~X.

7.3 Programmation littéraire

Mise a jour par KAYVAN SYLVAN (kayvan@sylvan.com), document d’origine écrit
par EDMAR WIENSKOSKI JR. (edmar-w-jr@technologist.com)

7.3.1 Introduction

Le but principal de cette documentation est de montrer comment utiliser LyX pour
la programmation littéraire. Nous supposerons que vous étes familiers de cette tech-
nique de programmation, et savez donc ce que « tangling » et « weaving » signifient 22.
Si ce n’est pas le cas, veuillez lire les pages web dont les adresses sont indiquées un
peu plus loin. Vous y trouverez une bonne documentation, allant de I’histoire du
développement aux derniers trucs et astuces.

Nous supposerons aussi que vous étes assez familiarisés avec LyX pour pouvoir
changer vos préférences, et le fichier de ressources X. Si ce n’est pas le cas, voyez le
reste de la documentation de Iy X qui couvre ces domaines.

7.3.2 La programmation littéraire

Extrait de la FAQ de la Programmation Littéraire :

La programmation littéraire est la combinaison de la documentation et
des sources en une forme lisible par un étre humain. En fait, la program-
mation littéraire doit étre agréable a lire, et méme aguicheuse! (Désolé,
Bob, je n’ai pas pu résister...) En général, la programmation littéraire
combine la source et la documentation dans un seul et unique fichier.
Des outils de programmation littéraire permettent ensuite de produire
séparément le fichier source et la documentation. Le style WEB de pro-
grammation littéraire fut créé par D.E. Knuth lors du développement de
son logiciel de typographie, TEX.

Un autre extrait :

En quot la programmation littéraire différe-t-elle du commentaire ?
Il y a trois signes distinctifs qui sont, dans 'ordre d’importance :

— un ordre d’élaboration flexible
— le support automatique pour la visualisation

— une documentation mise en forme, notamment les diagrammes et les
mathématiques

Maintenant que j’ai éveillé votre curiosité, voyons les références :

22. NdT : Respectivement la génération du code et de la documentation. — ar
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7.3.2.1 Références

La FAQ complete de la Programmation Littéraire se trouve a :

FAQ de la Programmation Littéraire http://www.xmarks.com/site/shelob.
ce.ttu.edu/daves/lpfaq/faq.html

La FAQ dénombre 23 (vingt-trois!) outils différents pour la programmation littéraire.
Certains sont spécialisés pour certains langages de programmation, d’autre ont une
portée plus générale. J'ai sélectionné NoWeb pour mon usage personnel pour plusieurs
raisons :

— 1II sait générer la documentation aussi bien en KTEX qu’en HTML.

— Il a une architecture ouverte, c¢’est-a-dire qu’il est facile d’y ajouter de nouveaux
filtres 2 et de réaliser des opérations spéciales au besoin.

— Un grand nombre de filtres est déja disponible (dont celui pour le HTML).
— Il est libre.
La page web de Noweb se trouve a :
Page d’accueil de Noweb https://www.cs.tufts.edu/~nr/noweb/

A partir de la, vous trouverez de nombreux liens intéressants et mémes quelques
exemples de programmation littéraire.

7.3.3 LyX et la Programmation Littéraire avec Noweb

LyX supporte la Programmation Littéraire par l'intermédiaire du mécanisme de
gestion des convertisseurs. Ce support est « indépendant de Noweb », c¢’est-a-dire que
vous pourrez utiliser cette nouvelle fonction de [y X avec un autre outil de program-
mation littéraire de votre choix, en changeant juste vos préférences LyX.

7.3.3.1 Génération des documents et du code (weaving and tangling)

Using the noweb module If you have installed Noweb and LyX successfully, when-
ever you open a new document, after you have chosen its document class, use the
Document > Settings menu to add the “noweb” module. If Noweb is correctly in-
stalled, when you click on the “Modules” link, you will see the “noweb” module in
the available list and you can add it to your document.

Ajout de code IxX vous permet d’entrer du code par 'intermédiaire d'un insert
paramétrable nommé CHUNK. Noweb délimite les chunks ainsi :

23. Filters are programs that read a given data stream and output a manipulated data stream.
That way, a WEB file (consisting of literate code) can be turned into a file consisting only of C
program code or BTEX code.
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<<Mon code>>=
code
encore du code
toujours du code
(¢

Le probléeme est que tout ce qui est compris entre le << et I'arobase @ doit étre pris
tel quel, c’est-a-dire que [y X ne doit faire aucune interprétation de ce qui a été écrit.
C’est aussi géré par le environnement CHUNK, qui fonctionne comme un insert des
texte normal mais qui présente une totale liberté en ce qui concerne 1’espacement.

Il est a noter que vous pouvez aussi utiliser la construction « %def » de Noweb
dans vos chunks pour ajouter des éléments de référence croisée :

<<Mon scrap>>=

def une_fonction(param):
"C’est la documentation de cette fonction."
print "Mes paramétres : ", param

@ Jdef une fonction

Pour avoir un exemple de cette construction et des références croisées engendrées,
regardez le programme littéraire python dans LIBDIR /examples/listerrors.lyx
qui devrait clarifier tout ca.

Génération de la documentation Arrivé ici, vous avez déja un nouveau fichier
avec sa propre classe de document, et vous avec tapé un peu de code et de texte
dedans. Bien; et maintenant, comment je 'imprime ? La réponse est simple : vous
faites Affichager>DVI, etc. comme vous le feriez pour un document quelconque. Il n’y
a aucune procédure particuliere.

Pour vous aider a vous y retrouver, je vais vous expliquer ce qui se passe a 'intérieur
de LyX :

1. Quand vous choisissez Affichage>Mise a Jour>DVI, un fichier EXTEX est généré.

Si le document est d’un type littéraire, le fichier généré sera nommé avec I'ex-
tension définie par le format « littéraire » (défini dans la fenétre de Préférences),
sinon le fichier aura ’extension habituelle .tex.

2. Remarquez que la seule différence est cette extension : IyX n’a rien de particu-
lier a faire. Tant que vous avez utilisé I'insert CHUNK en entrant le texte, tout
se passera sans probléme.

3. Si le document est d’une classe littéraire, IxX utilisera ensuite le convertisseur
interne IyX vers Noweb, suivi par le convertisseur Noweb vers IKTRX 24 pour
générer le fichier WTEX

Sinon, il saute simplement cette étape.

24. Les convertisseurs sont définis dans la fenétre Outilst> Préférences> Gestion de fichiers, dans
l’onglet Convertisseurs.
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4. Enfin, ITEX est invoqué et le processus continue comme s’il s’agissait d’un
document quelconque.

Vous étes donc indépendant d'un « outil littéraire » donné, car vous pouvez changer
les commandes correspondant aux différents convertisseurs.

Génération du code Quand on demande de Compiler dans les menus, ou quand on
appuie sur le bouton correspondant de la barre d’outils, un fichier KTEX est généré
comme dans I'étape 1 ci-dessus. LiyX invoque ensuite le convertisseur NoWweb->Program.
Celui-ci (comme tout convertisseur) est invoqué en deux parties :

1. Le programme de conversion proprement dit. Ce programme procede a la conver-
sion d'un format a un autre (ici, du format NoWeb au pseudo-format Program).

2. Le filtre de messages d’erreur. C’est un programme dont le seul role est de ré-
écrire les messages d’erreur dans un format compréhensible par LyX. Ca permet
a LyX de placer des boites d’erreur au bon endroit dans le tampon du fichier.

La premiere partie, déterminée par le champ Convertisseur, doit contenir
« build-script $$i » Ca signifie que IyX va appeler build-script (un pro-
gramme ou un script) avec le nom du fichier Noweb (en général un fichier dans
le répertoire temporaire de IyX).

Voici une implémentation de build-script que vous pouvez mettre dans un ré-
pertoire de votre chemin d’acces par défaut :

#1/bin/sh

#

notangle -Rbuild-script $1 | env NOWEB_SOURCE=%$1 NOWEB_OUTPUT_DIR=%2
sh

The next part of the converter setting is the
“Flags” which is to be set to

parselog=$$s/scripts/listerrors

This will run any errors that are generated by the “build-script” process through the
“listerrors” program.

The build will normally take place in [yX’s temporary directory, so the files pro-
duced by the conversion will be in that directory. IyX will copy out what it regards
as the ‘main’ file, but the Noweb->Program conversion may produce several files, and
so most of these would then be deleted when IyX was closed. This is why we pass in
the NOWEB OUTPUT DIR environment variable so that the build-script chunk
can place the generated files in that location.

Instructions de compilation dans le document La derniere partie de I'interface

entre LyX et noweb est le chunk « build-script ». En général, les instructions de

compilation de votre programme doivent étre regroupées dans un chunk a part. Le

build-script vu plus haut est spécifique a noweb et utilise la commande notangle

pour rechercher ce chunk (appelé « build-script ») et passer son contenu dans sh.
Typiquement, un tel chunk ressemble a ceci :
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<<build-script>>=

#!/bin/sh

if [ -z "${NOWEB_SOURCE}" ]

then

NOWEB_SOURCE=myfile.nw

fi

[... code to extract files ... use NOWEB_OUTPUT DIR here ...]
[... code to compile files ...]

Q

Voyez dans LIBDIR /examples/listerrors.lyx ou dans

LIBDIR /examples/Literate.lyx qui implémentent deux versions du programme
listerrors pour avoir des exemples de comment tout cela va ensemble. Vous pouvez
encore consulter LIBDIR /examples/noweb2lyx.1lyx. Il est intéressant de constater
que ces trois fichiers démontrent 'indépendance de Iy X relativement au langage de
programmation littéraire adopté car ils sont écrits respectivement en Python, C et
Perl.

7.3.3.2 Configurer LyX

Vous pouvez configurer ce qui concerne la Programmation Littéraire dans 'onglet
Convertisseurs de la fenétre Outils > Préférences. Les parties importantes sont :

le format « littéraire » Choisi dans 'onglet Formats, ol vous mettez ce qui est spé-
cifique a Noweb. Le Nom d'interface est « NoWeb », I’Extension est « nw ». LyX
créera donc un fichier d’extension .nw lors de la premiere étape du processus
de conversion.

le format Programme C’est un format fictif dont le seul but est d’étre le point d’ar-
rivée d’une conversion (ce qui permet ainsi de mettre en place un convertisseur
pointant vers lui).

NoWeb->ETEX Ce convertisseur assure la génération de la documentation (« wea-
ving »). Pour Noweb, il faut mettre « noweave -delay -index $$i > $$o »

NoWeb->Program Celui-ci assure la génération du code (« tangling »). Comme vu
plus haut, il faut mettre « build-script $$i », avec comme Autres Options
« originaldir,parselog=listerrors ».

7.3.3.3 Fonctions pour le déboguage

Une nouvelle fonction est aussi implémentée dans le serveur LyX, la fonction « ser-
veur va a la bonne ligne » que l'on utilisera avec ddd/gdb ou un autre débogueur.

Lorsque vous déboguez du code avec ddd/gdb, il est possible d’appeler un éditeur
de texte a la position actuelle d’exécution, avec un seul appui clavier. La configuration
par défaut de ddd est Shift-Ctrl-V. Il se trouve que vous pouvez choisir I’éditeur appelé
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par ddd dans la fenétre Outils> Préférences> Gestion des fichiers> Formats de fichier en
changeant 'entrée Editeur.
J’ai trouvé avantageux d’utiliser yX avec ddd en réglant Editeur sur :

echo "LYXCMD:monitor:server-goto-file-row:@FILE@ QLINEQ@" >~/.lyxpipe.in

Ainsi, quand vous utilisez ddd et que vous vous apercevez qu’il faut modifier le code,
vous pressez juste Shift-Ctrl-V (dans la fenétre ddd), et ddd renvoie cette information
a LyX via le serveur IiyX. La fenétre LyyX montrera le fichier en question, avec le
curseur pile poil la ot se trouvait ddd. Plus besoin de jouer aux devinettes ou de faire
défiler tout le document pour savoir ou se situait le probleme!

Notez cependant qu’il vous faut activer cette fonction du serveur IyX, inactive par
défaut. La section 5.2 explique comment procéder.

7.3.3.4 Ajouts a la barre d’outils

Il y a six nouveaux boutons qui peuvent étre ajoutés a la barre d’outils de LyX.
Quatre de ces boutons sont des raccourcis vers les styles Standard, Section, IATEX et
LyX-Code, pour l'insert paramétrable Chunk. Le dernier bouton est un raccourci vers
la commande « Compiler ».

[yX a tout une série de boutons qui peuvent étre intégrés dans la barre d’outils.
Personnellement, j’ai combiné les six raccourcis ci-dessus avec deux autres : un pour
Document>Mise a Jourr>DVI et un autre pour Documentr>DVI. Voila comment cela
se présente :

Toolbar
Layouts
Icon "layout Standard"
Icon "layout Section"
Icon "layout EX"
Icon "layout LyX-Code"
Icon "flex.insert Chunk"
Separator
Icon "buffer-view"
Icon "buffer-typeset"
Icon "build-program"
Separator

End
7.3.3.5 Couleurs personnalisées

Un certain nombre de couleurs de LyX peuvent étre personnalisées dans la fenétre
Préférences. Une des choses qui ennuient nombre d’entre nous est la couleur du code
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KETEX. La couleur par défaut est le rouge, or les chunks utilisent la police TEX, et
comme il y a beaucoup de chunks dans un document de programmation littéraire,
vous en aurez slirement marre de tout voir en rouge. Vous pouvez la changer dans
I’onglet Apparencer> Couleurs.

Le probleme suivant est la présence visible des caracteres « nouvelle ligne » sur
I’écran. Vous pouvez aussi choisir la couleur de ces caracteres particuliers et donc les
faire se confondre avec le fond. Je vous conseille de choisir une couleur qui est proche
de celle du fond, mais pas la méme : vous pourrez toujours les voir, mais ils ne vous
dérangeront plus.

7.3.4 LyX and knitr/Sweave

Support for knitr and Sweave is documented in the knitr.lyx example file and in
the Sweave manual (menu Help > Specific Manuals).
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Vous pouvez faire avec LyX tout ce que vous pouvez faire avec IXTEX. Cependant,
LyX ne peut inclure directement toutes les fonctionnalités de ETEX, mais vous pouvez
toujours utiliser le code TEX ; Ce chapitre vous montre quelques points particuliers
qui peuvent vous intéresser. Pour d’autre fonctionnalités spécifiques concernant les
figures, les tableaux, les flottants, les boites et les notes, voyez le manuel des Objets
INSETES.

8.1 Multi-colonnes

Cette fonctionnalité est indépendante de 'option Document sur deux colonnes du
menu Document>Paramétres dans la rubrique Format du texte. Si vous désirez une
présentation sur deux colonnes dans tout le document, vous devez utiliser 1'option
Document sur deux colonnes. Pour tous les aures cas, utisez la fonctionnalité décrite
ici.

Pour activer les colonnes multiples dans votre document, vous devez charger le
module Multi-colonnes (menu Document > Paramétrest>Modules) et vous devez avoir
installé le paquetage IXTEX multicol.

Dans chaque colonne, vous pouvez insérer ce que vous voulez, avec une limitation :
pour les flottants, vous devez utiliser ’option Plusieurs colonnes. Les notes de bas de
page provenant de colonnes multiples seront placées sur toute la largeur de la page
et non pas sous chaque colonne.

8.1.1 Les bases

Si vous souhaitez présenter un texte sur deux colonnes, insérez un insert multi-
colonnes via Insertion > Inserts personnalisables > Multi-colonnes la oti les colonnes doivent
débuter. Saisissez tout le texte qui doit étre affiché sur deux colonnes dans cet insert.

Voici un exemple :

The Adventure of the Empty House
by Sir Arthur Conan Doyle

It was in the spring of the year 1894 that
all London was interested, and the fashion-
able world dismayed, by the murder of the
Honourable Ronald Adair under most un-
usual and inexplicable circumstances. The

public has already learned those particulars
of the crime which came out in the police in-
vestigation, but a good deal was suppressed
upon that occasion, since the case for the
prosecution was so overwhelmingly strong
that it was not necessary to bring forward
all the facts. Only now, at the end of nearly
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ten years, am I allowed to supply those miss-
ing links which make up the whole of that
remarkable chain. The crime was of inter-
est in itself, but that interest was as noth-
ing to me compared to the inconceivable se-
quel, which afforded me the greatest shock
and surprise of any event in my adventur-
ous life. Even now, after this long inter-
val, I find myself thrilling as I think of it,
and feeling once more that sudden flood of
joy, amazement, and incredulity which ut-

terly submerged my mind. Let me say to
that public, which has shown some interest
in those glimpses which I have occasionally
given them of the thoughts and actions of a
very remarkable man, that they are not to
blame me if I have not shared my knowledge
with them, for I should have considered it
my first duty to do so, had I not been barred
by a positive prohibition from his own lips,
which was only withdrawn upon the third of
last month.

Pour avoir 3 colonnes ou plus, positionnez le curseur dans I'insert multi-colonnes et
utilisez le menu Insertion > Nombre de colonnes. Le nombre de colonnes est saisi dans

cet insert (pour 3 colonnes, saisir « 3 »).
Voici un exemple avec 3 colonnes :

It can be imagined that
my close intimacy with Sher-
lock Holmes had interested me
deeply in crime, and that after
his disappearance I never failed
to read with care the various
problems which came before the
public. And I even attempted,
more than once, for my own
private satisfaction, to employ
his methods in their solution,
though with indifferent success.
There was none, however, which
appealed to me like this tragedy

of Ronald Adair. As I read the
evidence at the inquest, which
led up to a verdict of will-
ful murder against some person
or persons unknown, I realized
more clearly than I had ever
done the loss which the commu-
nity had sustained by the death
of Sherlock Holmes. There were
points about this strange busi-
ness which would, I was sure,
have specially appealed to him,
and the efforts of the police

would have been supplemented,

or more probably anticipated,
by the trained observation and
the alert mind of the first crimi-
nal agent in Europe. All day, as
I drove upon my round, I turned
over the case in my mind and
found no explanation which ap-
peared to me to be adequate.
At the risk of telling a twice-
told tale, I will recapitulate the
facts as they were known to the
public at the conclusion of the

inquest.

Vous pouvez avoir jusqu’a 10 colonnes si vous le désirez, mais ¢a risque de ne pas

étre agréable a la lecture. ..
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8.1.2 Des colonnes dans des colonnes

Vous pouvez également créer des colonnes dans des colonnes :

The Honourable Ronald Adair was the second
son of the Earl of Maynooth, at that time gov-
ernor of one of the Australian colonies. Adair’s
mother had returned from Australia to undergo
the operation for cataract, and she, her son
Ronald, and her daughter Hilda were living to-
gether at 427 Park Lane.

The youth moved
in the best society —
had,

known, no enemies and

so far as was

no particular vices. He
had been engaged to
Miss Edith Woodley,
of Carstairs, but the
engagement had been
broken off by mutual
consent some months
before, and there was
no sign that it had left
any very profound feel-
ing behind it. For the

rest {sic} the man’s life
moved in a narrow and
conventional circle, for
his habits were quiet
and his nature unemo-
tional. Yet it was upon
this easy-going young
aristocrat that death
came, in most strange
and unexpected form,
between the hours of
ten and eleven-twenty
on the night of March
30, 1894.

8.1.3 Exemples plus compliqués

Ronald Adair was fond of cards — playing con-
tinually, but never for such stakes as would hurt
him. He was a member of the Baldwin, the
Cavendish, and the Bagatelle card clubs. It was
shown that, after dinner on the day of his death,
he had played a rubber of whist at the latter club.
He had also played there in the afternoon. The
evidence of those who had played with him — Mr.
Murray, Sir John Hardy, and Colonel Moran —
showed that the game was whist, and that there
was a fairly equal fall of the cards. Adair might
have lost five pounds, but not more. His fortune
was a considerable one, and such a loss could
not in any way affect him. He had played nearly
every day at one club or other, but he was a cau-
tious player, and usually rose a winner. It came
out in evidence that, in partnership with Colonel
Moran, he had actually won as much as four hun-
dred and twenty pounds in a sitting, some weeks
before, from Godfrey Milner and Lord Balmoral.
So much for his recent history as it came out at
the inquest.

Les exemples proposés dans cette section illustrent quelques fonctionnalités plus
particulieres de I'insertion de colonnes multiples.
Pour découvrir d’autres fonctionnalités, référez-vous a le documentation du paque-

tage multicol.

8.1.3.1 Préface

Pour ajouter un texte en préface pour plusieurs colonnes, positionnez le curseur
dans 'insert multi-colonnes et appelez le menu Insertion > Préface. Saisissez votre texte
de préface dans cet insert.
Voici un exemple avec un texte en préface :

And the story continues and continues and continues and continues. . .

On the evening of the crime, he returned from the club exactly at ten. His mother and
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sister were out spending the evening with
a relation. The servant deposed that she
heard him enter the front room on the sec-
ond floor, generally used as his sitting-room.
She had lit a fire there, and as it smoked
she had opened the window. No sound was
heard from the room until eleven-twenty, the
hour of the return of Lady Maynooth and

her daughter. Desiring to say good-night,

she attempted to enter her son’s room. The
door was locked on the inside, and no an-
swer could be got to their cries and knock-
ing. Help was obtained, and the door forced.
The unfortunate young man was found lying
near the table. His head had been horribly
mutilated by an expanding revolver bullet,
but no weapon of any sort was to be found
in the room.

Vous pouvez également utiliser une en-téte de section en tant que préface si vous
insérez une commande de section en code TEX : par exemple, la commande

\subsection{subsection title}

crée une sous-section. Et dans I'exemple suivant, la préface est une sous-sous-

section :

8.1.3.2 This is a subsubsection heading as a preface

A minute examination of the circum-
stances served only to make the case more
complex. In the first place, no reason could
be given why the young man should have fas-
tened the door upon the inside. There was
the possibility that the murderer had done
this, and had afterwards escaped by the win-
dow. The drop was at least twenty feet, how-
ever, and a bed of crocuses in full bloom lay
beneath. Neither the flowers nor the earth
showed any sign of having been disturbed,
nor were there any marks upon the narrow

strip of grass which separated the house from
the road. Apparently, therefore, it was the
young man himself who had fastened the
door. But how did he come by his death?
No one could have climbed up to the window
without leaving traces. Suppose a man had
fired through the window, he would indeed
be a remarkable shot who could with a re-
volver inflict so deadly a wound. Again, Park
Lane is a frequented thoroughfare; there is
a cab stand within a hundred yards of the
house. No one had heard a shot.

S’il reste un espacement vertical inférieur a 6 lignes de texte avant le début de

la zone multi-colonnes, un saut de page sera inséré automatiquement. Vous voudrez
peut-étre changer ce réglage en fonction de du nombre de lignes du texte en préface :
ceci peut se faire en positionnant le curseur dans I'insert multi-colonnes apres la pré-
face (si elle existe) et en appelant le menu Insertion > Espacement avant saut de page.
Saisissez alors ’espacement désiré, e.g. « bem »”.

Dans I’'exemple qui suit, 'espacement est réglé a 7 lignes de texte en saisissant « 7\ba-
selineskip » (ou la commande \baselineskip doit atre insérée en code TEX) :
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On the evening of the crime, he returned
from the club exactly at ten. His mother and
sister were out spending the evening with
a relation. The servant deposed that she
heard him enter the front room on the sec-
ond floor, generally used as his sitting-room.
She had lit a fire there, and as it smoked
she had opened the window. No sound was
heard from the room until eleven-twenty, the

hour of the return of Lady Maynooth and

8.1.3.3 Espacements environnants

8.1 Multi-colonnes

her daughter. Desiring to say good-night,
she attempted to enter her son’s room. The
door was locked on the inside, and no an-
swer could be got to their cries and knock-
ing. Help was obtained, and the door forced.
The unfortunate young man was found lying
near the table. His head had been horribly
mutilated by an expanding revolver bullet,
but no weapon of any sort was to be found
in the room.

L’espacement avant et aprés un bloc de colonnes multiples peut étre réglé via la
longueur \multicolsep. Par exemple la commande en code TEX

\setlength{\multicolsep}{3cm}

regle la valeur a 3cm. La modification doit étre faite avant le début de I'insert multi-

colonnes. La valeur prédéfinie est 13pt.
Ici \multicolsep est réglé a 2.5cm :

All day I turned these facts over in my
mind, endeavouring to hit upon some the-
ory which could reconcile them all, and to
find that line of least resistance which my
poor friend had declared to be the starting-
point of every investigation. I confess that I
made little progress. In the evening I strolled
across the Park, and found myself about six
o’clock at the Oxford Street end of Park
Lane. A group of loafers upon the pave-
ments, all staring up at a particular window,
directed me to the house which I had come to

see. A tall, thin man with coloured glasses,
whom I strongly suspected of being a plain-
clothes detective, was pointing out some the-
ory of his own, while the others crowded
round to listen to what he said. I got as near
him as I could, but his observations seemed
to me to be absurd, so I withdrew again in
some disgust. As I did so I struck against an
elderly, deformed man, who had been behind
me, and I knocked down several books which
he was carrying.

Nota : les valeurs réglées via \setlength seront utilisées pour tous les environne-
ments multi-colonnes suivants jusqu’a la prochaine modification de la valeur.
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8.1.3.4 Sauts de colonne

Un saut de colonne peut étre forcé en insérant la commande \columnbreak{} en
code TEX la ou la colonne doit étre interrompue. Notez bien que des zones vides
seront créées la plupart du temps lorsque cette commande est utilisée.

Voici un exemple :

“You’re surprised to see me, sir,” said he,
in a strange, croaking voice.

I acknowledged that I was.

“Well, I've a conscience, sir, and when I
chanced to see you go into this house, as I
came hobbling after you, I thought to myself,
I’ll just step in and see that kind gentleman,
and tell him that if I was a bit gruff in my
manner there was not any harm meant, and
that I am much obliged to him for picking
up my books.”

“You make too much of a trifle,” said
I. “May I ask how you knew who I was?”
APRES CETTE PHRASE UN SAUT DE
COLONNE EST IMPOSE.

8.1.3.5 Séparation entre colonnes

“Well, sir, if it isn’t too great a liberty,
I am a neighbour of yours, for you’ll find
my little bookshop at the corner of Church
Street, and very happy to see you, I am
sure. Maybe you collect yourself, sir. Here’s
BriTisH BIRDS, and CATULLUS, and THE
HoLy WAR — a bargain, every one of them.
With five volumes you could just fill that gap
on that second shelf. It looks untidy, does it
not, sir?”

La largeur des colonnes est calculée automatiquement, mais vous pouvez modifier
I'espacement entre colonnes. Ceci est possible grace a la longueur \columnsep. Sa
valeur implicite est 10pt. Voici un exemple dans lequel 'espacement est fixé a 3cm :

My observations of No. 427 Park
Lane did little to clear up the prob-
lem in which I was interested. The
house was separated from the street
by a low wall and railing, the whole
not more than five feet high. It was
perfectly easy, therefore, for anyone
to get into the garden, but the win-
dow was entirely inaccessible, since
there was no water pipe or anything
which could help the most active
man to climb it. More puzzled than
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ever, I retraced my steps to Kens-
ington. I had not been in my study
five minutes when the maid entered
to say that a person desired to see
me. To my astonishment it was none
other than my strange old book col-
lector, his sharp, wizened face peer-
ing out from a frame of white hair,
and his precious volumes, a dozen of
them at least, wedged under his right
arm.



8.1.3.6 Filets verticaux

8.1 Multi-colonnes

Entre les colonnes est placé un filet de largeur \columnseprule. Si cette largeur est
fixée & Opt (c’est la valeur implicite), le filet n’apparait pas. Dans I'exemple suivant,

le filet a une largeur de 2pt :

“You’re surprised to see me, sir,” said he,
in a strange, croaking voice.

I acknowledged that I was.

“Well, I've a conscience, sir, and when I
chanced to see you go into this house, as I
came hobbling after you, I thought to myself,
I’ll just step in and see that kind gentleman,
and tell him that if I was a bit gruff in my
manner there was not any harm meant, and
that I am much obliged to him for picking
up my books.”

“You make too much of a trifle,” said I.
“May I ask how you knew who I was?”

“Well, sir, if it isn’t too great a liberty,
I am a neighbour of yours, for you’ll find
my little bookshop at the corner of Church
Street, and very happy to see you, I am
sure. Maybe you collect yourself, sir. Here’s
BriTisH BIRDs, and CATULLUS, and THE
HorLy WAR — a bargain, every one of them.
With five volumes you could just fill that gap
on that second shelf. It looks untidy, does it
not, sir?”

Le filet peut étre mis en couleur en redéfinissant la commande \columnseprulecolor.

Ceci est fait en insérant la commande

\renewcommand{\ columnseprulecolor}{\color{red}}

en code TEX, avant 'insert multi-colonnes. Remplacez dans cette commande red par la
couleur de votre choix. Vous pouvez utiliser les couleurs prédéfinies ou celles que vous
avez définies vous-méme, voyez le Manuel des objets insérés, section Tableauz colorés
pour les détails sur la définition des couleurs. Pour revenir a la couleur implicite,

insérez la commande

\renewcommand{\ columnseprulecolor } {\ normalcolor}

Dans I'exemple qui suit, sont définis un filet magenta et une séparation de colonnes

de lem :

“You’re surprised to see me, sir,” said
he, in a strange, croaking voice.

I acknowledged that I was.

“Well, I’ve a conscience, sir, and when
I chanced to see you go into this house,
as I came hobbling after you, I thought to
myself, I’ll just step in and see that kind
gentleman, and tell him that if I was a bit
gruff in my manner there was not any harm
meant, and that I am much obliged to him
for picking up my books.”

“You make too much of a trifle,” said I.

“May I ask how you knew who I was?”

“Well, sir, if it isn’t too great a lib-
erty, I am a neighbour of yours, for you’ll
find my little bookshop at the corner of
Church Street, and very happy to see you,
I am sure. Maybe you collect yourself,
sir. Here’s BRITISH BIRDS, and CATUL-
LUS, and THE HoLY WAR — a bargain, ev-
ery one of them. With five volumes you
could just fill that gap on that second shelf.
It looks untidy, does it not, sir?”
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8.2 Paragraphes de forme inhabituelle

KETEX, a l'instar des autres générateurs de texte, utilise implicitement des paragraphes
rectangulaires. Pour des cas particuliers comme des affiches, des cartes d’invitation ou
des poémes, vous pouvez modifier la forme des paragraphes a volonté. Ceci est possible
grace au paquetage IXTEX shapepar qui est chargé en utilisant dans les parametres du
document le module Formes de paragraphe paramétrables.

8.2.1 Formes prédéfinies

shapepar fournit les formes suivantes :

Nom Description Annotation

. . . . Pas de mise a 1’échelle
Disque avec un trou circulaire (a

CDlabel la. taille d'un CD/DVD) possible. Attentlion., 9uant1te
de texte limitée
Circle Disque Fraglle,/ le calcul peut
échouer
Diamond Rhombmdej (symbolisant un )
« diamant »)
Heart Forme en cceur -
Hexagon Hexagone -
Nut Ecrou (hexggone. avec un trou i
circulaire)
Square Carré -
Star Etoile & 5 branches -
Candle Chandelle allumée -
Drop Goutte de pluie normale/inversée Fraglle,/ le calcul peut
down/up échouer
TEX Le logo TEX -
Triangle Triangles avec des orientations
up/down/ différentes i
left /right

Pour utiliser une forme pour votre paragraphe, sélectionnez simplement la forme
souhaitée dans le menu déroulant des styles.
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Voici un exemple de paragraphe en forme d’écrou :

Lorem ipsum dolor sit
amet, consetetur sadipscing
elitr, sed diam nonumy eirmod
tempor invidunt ut labore et dolore

magna aliquyam erat, sed diam
voluptua. At vero eos et ac-
cusam et ju- sto duo do-
lores et ea re- bum. Stet cli-
ta kasd guber- gren, no sea ta-
kimata sanc- tus est Lorem
ipsum  dolor sit amet. Lo-
rem ipsum dolor sit amet, conse-

tetur sadipscing elitr, sed diam nonu-
my eirmod tempor invidunt ut la-
bore et dolore magna aliquyam
erat, sed diam voluptua.

Nota: les paragraphes mis en forme via shapepar ne peuvent pas franchir une limite
de page.

shapepar prend soin de préserver la forme, quelle que soit la quantité de texte du
paragraphe. De ce fait la taille du paragraphe change avec cette quantité. Ceci peut
conduite a des paragraphes qui empietent dans les marges. Pour illustrer cette mise
a ’échelle, voici le méme paragraphe avec deux fois plus de texte :
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Lorem ipsum dolor sit amet, consete-
tur sadipscing elitr, sed diam nonumy eir-
mod tempor invidunt ut labore et dolore ma-
gna aliquyam erat, sed diam voluptua. At vero
eos et accusam et justo duo dolores et ea rebum.
Stet clita kasd gubergren, no sea takimata sanctus est

Lorem ipsum dolor sit amet. Lorem ipsum
dolor sit amet, con- setetur  sadipscing
elitr, sed diam no- numy eirmod tem-
por invidunt ut la- bore et dolore ma-
gna aliquyam erat, sed diam voluptua.
Lorem ipsum dolor sit amet, consete-
tur sadipscing eli- tr, sed diam nonu-
my eirmod tempor invidunt ut labo-
re et dolore magna aliquyam erat, sed
diam voluptua. At vero eos et accusam

et justo duo dolores et ea rebum. Stet clita kasd guber-
gren, no sea takimata sanctus est Lorem ipsum dolor
sit amet. Lorem ipsum dolor sit amet, consete-
tur sadipscing elitr, sed diam nonumy eirmod
tempor invidunt ut labore et dolore ma-
gna aliquyam erat, sed diam voluptua.

La forme CDlabel est une exception : elle ne peut pas étre mise a 1’échelle puisqu’elle

doit correspondre a une étiquette de CD/DVD. De ce fait, la quantité de texte que
I’on peut mettre en forme est limitée.
Les formes drop et circle sont fragiles, ce qui veut dire que le calcul de la taille
peut échouer, en fonction de la quantité de texte. Vous aurez alors une erreur XTEX
« Arithmetic overflow ». Dans ce cas, essayez d’ajouter ou d’enlever du texte; si rien
ne fonctionne, vous devez utiliser une autre forme. ..

Pour les formes pointues, vous verrez peut-étre un échec de I'algorithme de césure
de IXTEX dans les coins. Il est alors souvent nécessaire d’ajouter des points de césure
explicites (Ctrl+-) dans les parties de texte correspondantes.

Les paragraphes mis en forme par shapepar sont toujours ou bien centrés ou bien
alignées au fer a gauche. Le menu de dialogue des paragraphes ne peut donc pas
étre utilisé pour aligner ce type de paragraphe. Une solution consiste a mettre le
paragraphe en forme dans une minipage ou une parbox et a aligner la boite. Le
probleme est alors de trouver la bonne largeur pour la boite, parce que si elle est
trop large et que vous la centrez, le paragraphe n’est pas centré parce qu’il est au
fer a gauche dans la boite. Vous devrez alors jouer un peu avec la largeur de la boite
jusqu’a satisfaction. Voici deux paragraphes en forme de coeur, le premier est non
aligné, le second est aligné a droite :
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Lorem ipsum
dolor sit amet, consetetur sa-
dipscing elitr, sed diam nonumy eir-
mod tempor invidunt ut labore et do-
lore magna aliquyam erat, sed diam
voluptua. At vero eos et accusam
et justo duo dolores et ea rebum.
Stet clita kasd gubergren, no
sea takimata sanctus est
Lorem ipsum dolor
sit  amet.

Q

Lorem ipsum
dolor sit amet, consetetur sa-
dipscing elitr, sed diam nonumy eir-
mod tempor invidunt ut labore et do-
lore magna aliquyam erat, sed diam
voluptua. At vero eos et accusam
et justo duo dolores et ea rebum.
Stet clita kasd gubergren, no
sea takimata sanctus est
Lorem ipsum dolor
sit  amet.

Q©

8.2.2 Formes personnalisées

Vous pouvez définir vos propres formes. Le faire a la main demande beaucoup de
travail parce qu’il faut spécifier chaque coordonnée, mais il est possible de confier le
travail a 'ordinateur :

1. Installer le programme Jpgfdraw.

2. Dans Jpgfdraw , aller au menu TeX/LaTeX > Settings>Set Normal Size et sélec-
tionner la taille de police utilisée dans le document. Par exemple, le présent
document utilise un police 12pt.

3. Tracer une forme.

4. Utiliser le menu TeX/LaTeX>Shapepar pour exporter la forme en coordonnées.
Dans le menu de dialogue qui s’ouvre, utiliser soit le squelette, soit le chemin
proprement dit!.

Les coordonnées ont copiées dans un fichier TEX. Pour I'utiliser avec le document :

1. Pour plus d’information voir http://www.dickimaw-books.com/apps/jpgfdraw /manual /shapepar.html
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1. Placer le curseur avant le premier caractere du paragraphe concerné (ou dans

un nouveau paragraphe vide).

2. Ouvrir dans LyX le menu Insertion > Fichier > Sous-document, sélectionner le fi-

chier exporté par Jpgfdraw et utiliser Inclus (include).

Nota : le changement de forme ne s’applique qu’au paragraphe concerné; tout
redevient normal pour le paragraphe suivant. De ce fait la définition de forme doit
étre répétée pour chaque paragraphe dont on veut imposer la forme personnalisée.

Voici un exemple :

Lorem ipsum dolor sit amet, consetetur sadip-
scing elitr, sed diam no- numy eirmod tem-
por invidunt ut labo- re et dolore ma-
gna aliquyam erat, sed diam volup-
tua. At vero eos et accusam et ju-
sto duo dolores et ea rebum. Stet
clita kasd guber- gren, no sea ta-
kimata sanctus est Lorem ipsum
dolor sit amet. Lo- rem ipsum do-
lor sit amet, con- setetur  sadip-
scing elitr, sed diam nonumy eirmod
tempor invidunt ut labore et dolore
magna aliquyam erat, sed diam voluptua.

Une astuce : pour tracer des formes vraiment complexes avec Jpgfdraw , vous
pouvez tracer la forme a l'aide d'un logiciel de votre choix et importer 'image cor-
respondante dans Jpgfdraw. Il vous suffit ensuite de tracer une ligne ou un spline le

long du squelette de I'image.

Le module Formes de paragraphe paramétrables fournit également les deux styles
shapepar et Shapepar , qui peuvent étre utilisés pour définir de nouvelles formes co-
ordonnée par coordonnée?. Pour en savoir plus quant a l'utilisation de ces styles
et a d’autres possibilités de personnalisation, voir la documentation du paquetage

shapepar.

2. Ces commandes sont utilisées de maniere interne pour toutes le formes décrites ici,
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